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REVISIONS 
 Revision History of Operation Manual  

 
Date Page Rev Description Signed 

Oct. 30, 2009  0.05 Initial version - 

Dec. 28, 2009 

P9, 11, 17, 18, 22, 
23, 26, 37, 40, 43, 
45, 46, 49, 50, 57-
59, 62, 67, 71, 73, 

81 

0.06 Correcting errors  

 P20  Adding the “Welcome” screen  
 P25, 27  Adding “Decimal point is displayed”  

May 10, 2010 P1, 5 0.07 Correcting errors  
Mar. 8, 2011 P7, 10 1.00 Adding Korean as a supported language  

 P36, 43, 46, 96  Adding a description on “Information”  
 P46, 54  Adding the “Parameter” tab  

 P77  Correcting a description on setting parameters of the 
protection function  

 P84  Adding “Auto servo on”  
 P102-108, 134  Adding an item for “Setup Wizard”  
 P109-123, 135  Adding an item for “Fit Gain”  
 P125  Adding “Cannot start PANATERM”  
 P126  Adding “The explanation of parameter is unkind”  

May 31, 2011 P1, 7, 8 1.01 Adding Windows 7  
 P7  Adding information on the MINAS-A5N series  
 P7, 10, 125  Adding a description on Windows 64-bit version  

Aug. 9, 2011 P132 1.02 Adding “Operation doesn’t reach at the speed”  
Sep. 6, 2011 P7 1.03 Adding information on the MINAS-A5E series  

 P26, 28, 128  Changing “Decimal point is displayed” to “Display - Set value 
description”  

June 19, 2012 
P6-8, 12, 

17-18, 22-30, 138-
140, 142, 148,  

1.04 Adding descriptions on the RS232 communication  

 P7  Adding information on the MINAS - A5NL series  
Apr. 26, 2013 P7 1.05 Adding information on the MINAS-A5II series  

 P16  Adding “Fit gain measure result file (filename.fit5)” to the list 
of file extensions  

 P27, 124, 158, 
161, 165, 168  Changing “Fit gain screen” → “Fit gain screen (Standard)”  

 
P138-154, 158, 
161, 164, 165, 

167, 169 
 Adding descriptions on the “Fit gain screen (2 degrees of 

freedom control)”  

July 7, 2014 P1, 8-9, 12, 14, 
172 1.06 

Stopping the support for Windows XP due to the end of 
Microsoft support for Windows XP, and starting the support for 
Windows 8. 

 

 P7, 24, 26  Adding information on the MINAS-A5B, MINAS-A5ND1, and 
MINAS-A5L04 (LA4) series  

 P30, 33-38  Adding the function of series definition settings to simplify the 
support for special products  

 P15, 28-29,  
162-169, 185  Adding the object editor function  

 P174, 178-181  Adding a description on troubleshooting  

June 1, 2015 P7, 8, 20, 24, 33, 
36, 37 1.09 Expansion of the scope of model codes supporting MINAS-

A5B series  

Oct. 28, 2015 P1, 10, 11, 19 1.11 Changing “PANATERM Ver.5.0” to “PANATERM Ver.6.0”  
 P7, 8, 26, 27  Adding information on the  MINAS-A5BL series  

 
P7, 8, 24, 26, 34, 

38, 64, 73, 81, 
101, 151, 184 

 Adding information on the MINAS-A6 series  

 
P15, 26, 27, 29, 

30, 171-184, 188, 
190, 198-202 

 
Adding a description on added functions, which are the 
battery refresh, the block operation editor, and the block 
operation monitor 

 

Note) The page number (Page) is the current page number at the time of revision. 
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Dec. 11, 2015 P7, 8 2.00 Updating the dates for series  
Dec. 25, 2015 P7, 8, 27, 28 2.01 Adding information on the MINAS-A6N series  
Jan. 8, 2016 P7, 8 2.02 Updating the information on the MINAS-A5B series  
Oct. 12, 2016 P1, 9, 10 2.03 Adding a description on the support for Windows 10  

 P8  Expansion of the scope of model codes supporting MINAS-
A6N series  

 P8, 25, 27, 28, 35, 
38, 39  Adding information on the MINAS-A6L series  

 P16  Adding file extensions for the waveform graphic expanded 
function  

 P30, 31  Adding descriptions on the added functions and deterioration 
diagnosis information  

June 2, 2017 

P4-9, 13, 16, 19, 
22, 23, 27, 33, 35-
42, 101, 108, 134, 

143, 158, 212, 
213, 215,  

3.00 Adding a description on Wireless LAN  

 P7, 27, 29, 30, 46, 
47, 177, 178  Adding information on the MINAS-A6B, and MINAS-A6NL 

series  

 
P30-34, 205-211, 

216-218,  
220-231 

 A description is added on the additional function, RTEX 
communication setting screen.  

 

P72, 101, 126, 
131, 134, 136, 
143, 158, 176, 
184, 187, 195, 

198, 205 

 Adding a note on the function that cannot be performed 
during RS232 communication  

 
P85, 86, 92, 93, 
98, 99, 216, 218, 

221 
 Adding a description on the support of longer sampling cycles 

of waveform graphics  

 P128, 129, 224  Adding a description on the RTEX communication error 
counter monitoring function  

 P198-204,  
227-231  Adding chapters for the screen operation of the deterioration 

diagnosis function and trouble shooting  

 P232  Adding a description on the post-sale service  
July 3, 2017 P7 3.01 Updating the month and year in the note  

 P39-40  Correct errors related to the wireless LAN / Driver information 
set-up  

Nov. 17, 2017 P7 3.02 Updating the information on the MINAS-A6B series  
May. 17, 2018 P7, 30-31 3.03 Adding information on the MINAS-A6 (V-frame) series  

 P22-25  Adding a description on the Nickname setting screen  
 P216  Adding a description on troubleshooting  

July. 31, 2018 P6-7, 30-31 3.04 Adding information on the MINAS-A5MN and MINAS-A6BL 
series.  

 

P31, 33-37, 
215-216, 221, 

223, 226, 
230-237 

 A description is added on the additional function, Magnetic 
pole position estimation results copying screen.  

 P31, 161-164, 
168, 233  Adding descriptions on the Fit gain screen (2 degrees of 

freedom control)  

Oct. 26, 2018 P31, 161 3.05 Adding descriptions on the Fit gain screen (2 degrees of 
freedom control)  

 P146  Adding descriptions on the Fit gain screen (Standard)  

Mar. 15, 2019 
P3, 26, 34, 39, 64-

65, 225,  
229-230, 236 

3.06 Correcting errors  

 P7  Updating the month and year in the note  
Note) The page number (Page) is the current page number at the time of revision. 
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May 15, 2019 P5, 19, 42 3.07 Added the United States, Taiwan, and Korea as regions that 
can support wireless LAN.  

 P7  Updating the month and year in the note  

 P36  

Correction 
Removed the block operation monitor described in the 
function that cannot be opened simultaneously during 
degradation diagnosis. 

 

 P238  Update Contact point for repairs information  
Jan. 10, 2020 P7 3.08 Updating the month and year in the note  

 P8  Correcting errors  

Mar. 11, 2020 P5, 19, 42, 43 3.09 Correct errors related to the wireless LAN / Driver information 
set-up  

 P7  Updating the month and year in the note  

 P41, 44  Updating the image of the wireless LAN / Driver information 
set-up screen  

Nov. 12, 2020 P1, 8-9 3.10 Stopping the support for Windows Vista, Windows 7 due to 
the end of Microsoft support for Windows Vista, Windows 7.  

 P2  Added mark description  
 P3  Added a note depending on the state of the PC  
 P7  Updating the month and year in the note  
 P8, 19, 42  Added a note about WPA  

 

P8, 18, 25-31, 36, 
38, 65, 67, 71, 74, 
78, 82-83, 85, 89-

90, 92, 96-99, 
105, 109, 113, 

115-116, 123, 132, 
135, 142, 149, 
159, 194, 200, 
208, 228, 234 

 Correcting errors  

 P9  Update the contents of <Notes>  

 

P10, 14, 16,  
20-22, 25-28, 31, 
34, 36-38,43, 45, 

47-49, 51-53,  
56-61, 68-70,  

73-83, 88, 92-93, 
95-96, 98,  

100-101, 103-104, 
111-112, 114, 116-

122, 124-127, 
129-131, 134-135, 
137-144, 147-148, 
150-152, 155-160, 

162-181, 185, 
189, 191, 195, 

197 

 Fixed to the description of Windows 10  

 P11  Rename shortcut  
 P12  Added notes about installing Visual Studio 2013  

 P12, 218  Added notes about installing Microsoft Access Database 
Engine  

 P15  Add description of object comparison file  
 P17  Removed description of USB multi-axis connection  
 P29-30  Updated list of useable function  

 P30, 119, 229  Added content related to analysis after frequency 
characteristic measurement  

 P72  Added a note about control mode  
 P76  Added notes about Real time Auto Tuning Custom Setting  
 P92-94, 176-177  Change the numbering of image areas  

Note) The page number (Page) is the current page number at the time of revision. 
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Nov. 12, 2020 P116-117  Added description about operation button  
 P146, 161  Added the cautionary note about fit gain function  
 P182  Added comparison button  
 P184  Added parameter column, description of [ESC] key  
 P186  Added description of comparison function  
 P219, 221  Added items for troubleshooting  
 P226  Added annotation of M frame driver  

Mar. 10, 2021 P4-6 3.11 Added Software License Agreement  
 P12  Change the way of uninstall  

 P46  Added a note on the wireless LAN / Driver information set-up 
screen  

 P69  Added a note on the monitor screen  
May. 20, 2021 P10 3.12 Change needed system construction  
Jan. 6, 2022 P7 3.13 Changed the notes about wireless LAN dongle  
Apr. 28, 2022 - 3.14 Changed company name  

 P14, 211, 214  Changing “.NET Framework 3.5 SP1” to “.NET Framework 
4.8”  

 P9, 30  Adding information on the MINAS-A6L (V-frame) series  

 

P3, 7-10, 17, 19, 
22, 23, 27, 33, 35-
37, 96, 103, 130, 

139, 154, 212, 
214 

 Deleting a description on Wireless LAN  

Sep. 16, 2022 P9, 30 3.15 Adding information on the MINAS-A6ST series  

 P10-11  
Stopping the support for Windows 8.1 due to the end of 
Microsoft support for Windows 8.1, and starting the support 
for Windows 11. 

 

 
P29-P30, 32-34, 
195-202, 224, 
226, 236-241 

 Added Block operation Editor v2  

 P175  Added Set Home to Object Editor  
Apr. 1, 2023 P14, 222, 226 3.16 Added how to install .NET Framework 4.8  

 P9, 30  Adding information on the MINAS-A6BU series  
 P197-206  Changed due to improvements in “Block operation Editor v2”  

 P27  Changed due to improvements in “Select connection with 
drivers”  

Apr. 27, 2023 P9, 30 3.17 Adding information on the MINAS-A6BN series  

Jun. 30, 2023 P9, 17, 29-31, 34, 
223-242, 265 

3.18 Added Gantry  

Jan. 24, 2024 P223-245, P268 3.19 Added Twisted table compensation - Absolute precision 
improving  

Apr. 1, 2024 P4-6 3.20 Change Software License Agreement   
Jul. 17, 2024 P9, 30 3.21 Adding information on the MINAS-A6SC series  
Oct. 1, 2024 P9, 30 3.22 Adding information on the MINAS-A6BC series  

 P9  Correcting errors  
Jan. 6, 2025 P10, 33 3.23 Adding information on the MINAS-A6BL0C0 series  

 P10, 33  Adding information on the MINAS-A6BN0C0 series  
 P11  Change needed system construction  

 P15, 261  
Deleting a note about Microsoft Visual C++ 2013 
Redistributable(x86) and the Microsoft Access Database 
Engine 

 

 
P18, 30-33, 

35-38, 251-260, 
283 

 Added Linear motor initial adjustment  

 P282  Added items for troubleshooting  
Note) The page number (Page) is the current page number at the time of revision. 
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Feb. 28, 2025 P60 3.24 Added a note on the monitor screen  
 P144, 159  Changed the notes about fit gain screen  
 P272  Added items for troubleshooting  

Mar. 31, 2025 P31-33 3.25 Change the function of the linear motor initial adjustment to 
available.  

     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     

Note) The page number (Page) is the current page number at the time of revision. 
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Safety Precaution 
 
Please keep without fail 
Instructions to be observed to avoid personal injury and property 
damage are given in the following way. 
Please keep it without fail 
 
The degree of injury and damage caused by failure in 
observing the instructions or improper usage is 
indicated in the following format. 
 

 
 
 
The following pictorial display explains the types of 
content to be protected. 
 
 

Caution Indicates a potentially hazardous 
situation which may result in injury 
or only property damage.  ! 

 
This indication shows “prohibition”. 

 
This indication shows “imposition” to be done.  ! 
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The communication cable 
should not be connected or 
cut during the driver power 
supply turned on. 

 
 
 
 
It may cause injury, 
breakdown or 
damage.  

 ! Caution 
The communication cable 
should not be cut under the 
condition of this software 
turned on. Also, don’t put 
your PC to sleep, hibernate, 
or screen saver. 

 
 
It may cause injury, 
breakdown or 
damage. 

On modifying parameters of 
the driver, please do it after 
reading the manual of the 
driver or technical reference 
carefully.  
 
 
 

It may cause injury, 
breakdown or 
damage. 

 ! 

Trial Run, Z phase search, 
and frequency characteristics 
measurement accompanies 
motor operation. Please 
execute it after securing 
surrounding safety without 
fail.   
 

It may cause injury, 
breakdown or 
damage. 

 ! 
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Software License Agreement 
[The original text of this Agreement is written in Japanese, and this 
translation does not have any effect, whether de jure or de facto.] 
 
 
 

Software License Agreement 
 

Panasonic Industry Co., Ltd., acting through its Industrial Device Business 
Division (hereinafter referred to as “us”, “our(s)” or "we") grants the Software 
license on condition that you have accepted this license agreement. Please 
be sure to read the Software license agreement (hereinafter referred to as 
this "Agreement") before using the Software, and do not use the Software 
without first accepting this Agreement. 

On starting to use the Software, you will be deemed to have accepted all 
the terms of this Agreement. Please do not use the Software unless you 
accept this Agreement.  

The Software may incorporate several open-source software programs in 
addition to proprietary computer programs in our possession or licensed to us. 
If open-source software programs are incorporated, please see the license 
statements included in the Software installation package for those programs. 
If there is any conflict between the license statements in the open-source 
software program licenses and those in this Agreement, the wording of the 
open-source software program licenses will prevail. 
 
Article 1. License 

We grant you a non-exclusive license to use the Software for the 
purpose of using our products identified in the Software manual 
(hereinafter referred to as the "Products") in accordance with the terms of 
this Agreement. You may not use the Software for the purpose of using 
third-party products that are not ours. 

 
Article 2. Prohibitions 

The following acts are prohibited with regard to the Software. 
(1) Altering, reverse-engineering, decompiling, or disassembling the 

Software, or any other act of a similar nature. 
(2) Use of the Software other than by the methods prescribed in the 

manual provided by us or our website, or any other methods 
designated by us. 

(3) Use of the Software for any purposes other than those prescribed 
in the manual provided by us or our website, or any other 
purposes designated by us. 

(4) Distribution, renting out, leasing, loaning, or the assigning of the 
Software to any third party. 

However, subject to the assignee's agreement to be bound by all the 
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conditions of this Agreement, you may assign the Software license 
under this Agreement together with the Products. In this case, you will 
deliver all the copies of the Software and its annexed documentation to 
the assignee, and you may not retain any copies of the Software, 
including backup copies. 

 
Article 3. Disclaimer 

We do not warrant the Software's merchantability, fitness for any 
particular purpose, or non-infringement of third-party intellectual property 
rights, and do not make any other warranties with regard to the Software. 

2. We accept no responsibility for damage of any kind (including direct, 
indirect, incidental, consequential, and special damage) that results from 
the use of the Software, loss of its use, or any bugs, security holes, 
malfunctions or other glitches, or otherwise resulting from use of the 
Software. 

 
 

Article 4. Effective term 
This Agreement comes into effect when you accept it and start to use the 
Software. 

2. If you are in breach of any of the provisions of this Agreement, we may 
immediately terminate this Agreement. 

3.Within four weeks after this Agreement is terminated, you will return to us, 
or erase or destroy all of the Software and its copies at your expense. 

 
Article 5. Compliance with export laws 

You must comply with the export control laws, regulations, etc., of all 
countries that have jurisdiction over the parties hereto (including the 
Foreign Exchange and Foreign Trade Act of Japan, and export control 
regulations based on United Nations Security Council resolutions). If 
qualifications or appropriate approval by governmental agencies are 
required, it is prohibited to export the Software directly or indirectly to any 
countries without such approval. It is also prohibited to use or sell the 
Software directly or indirectly for military purposes. 

 
Article 6. Ownership of copyright, etc. 

Except for open-source software programs, all copyrights and other 
intellectual property rights to the Software are vested in us or our 
licensors. 

 
Article 7. Upgrading 

It is within our discretion whether or not to offer Software upgrades or 
updates at any point in the future. If an upgrade or update is offered, a 
fee may be charged. 
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2. If a Software upgrade or update is offered, whether on a chargeable or 
non-chargeable basis, this Agreement will apply as part of the Software 
unless otherwise specified by us when the offer is made. 

 
Article 8. Limitation of liability 

In no event will our liability associated with this Agreement or the 
Software exceed 10,000 yen. 

 
Article 9. Modifications 

We may modify this Agreement at any time at our discretion if 
(1) the modifications to this Agreement are in conformity with your 

interest in general; or 
(2) the modifications to this Agreement are not incompatible with the 

purpose of this Agreement, and are rational in light of the need for 
and reasonableness of the modifications, and other circumstances 
related to the modifications. 

2. If we modify this Agreement pursuant to the preceding paragraph, we will 
announce our plan to modify this Agreement, the content of the modified 
version of this Agreement, and the date on which the modifications will 
come into effect on our website no later than two weeks before the 
effective date of the modified version of this Agreement. However, we 
may effect modifications without notice to you if they are of a minor 
nature or are not detrimental to you. This Agreement will be modified on 
the date that the modifications come into effect. 

 
Article 10. Governing law and jurisdiction 

This Agreement is governed by the laws of Japan. 
2. If any dispute arises in connection with this Agreement, the Osaka 

District Court will have exclusive jurisdiction over such dispute. 
 

 
 
[1st Apr. 2024] Version     
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1. Initially 
 

Notes for safety issues 
This software runs on “Windows”, and performs communications 
between personal computers and MINAS series driver. 
MINAS series have functions to perform communications with 
commercially available personal computers with USB cables. 
Moreover in a part of series has the function to perform RS232 
communication with RS232 cable. And can set parameters of the 
drivers, or can monitor control situations using a PC screen and 
mouse. When using the device, also read the operation manuals 
and technical publications on the driver main unit. 
Microsoft and Windows are registered trademark of Microsoft Corporation in 
the United States and other countries. 
Other company’s names, product’s names and so on are each company’s 
registered marks. 
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2. System Construction 
 

Confirming applicable drivers 
This software is for our AC servo driver MINAS series. It is not 
available for other products. Applicable driver’s model names and 
series are as below. 
Series Model name USB RS232 
MINAS - A5 series M * DH * * * * *   

M * DH * * * * * E   
MINAS - A5B series M * DH * * * * * B01 

M * DH * * * * * B03 
M * DH * * * * * B21 
M * DH * * * * * BA1 
M * DH * * * * * BA3 
M * DH * * * * * BD1 

  

MINAS - A5BL series M * DH * * * * * B91 
M * DH * * * * * BL1   

MINAS - A5II series M * DK * * * * *   
M * DK * * * * * E   

MINAS - A5L series M * DH * * * * * L01 
M * DH * * * * * LA1   

MINAS - A5L04(LA4) 
series 

M * DH * * * * * L04   
M * DH * * * * * LA4   

MINAS - A5MN series MMDHT * * * * ND1 
MMDHT * * * * N21   

MINAS - A5N series M * DH * * * * * N01 
M * DH * * * * * NA1   

MINAS - A5ND1 
series 

M * DHT * * * * ND1 
M * DHT * * * * N21   

MINAS - A5NL series M * DH * * * * * N91 
M * DH * * * * * NL1   

(Continued on next page) 
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Series Model name USB RS232 
MINAS - A6 series M * DL * * * SF 

M * DL * * * SG   

M * DL * * * SE   
MINAS - A6L series M * DL * * * SM   

M * DL * * * SL   
MINAS-A6 (V-frame) 
series 

MVDL * * * SF 
MVDL * * * SG   

MINAS-A6L (V-frame) 
series MVDL * * * SM   

MINAS-A6SC series M * DL * * * SC   

MINAS - A6ST series M * DL * * * ST   

MINAS - A6N series M * DL * * * NF 
M * DL * * * NE   

MINAS - A6NL series M * DL * * * NM 
M * DL * * * NL   

(Continued on next page) 
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Series Model name USB RS232 
MINAS - A6B series M * DL * * * BF 

M * DL * * * BE   

MINAS - A6BC series M * DL * * * BC   
MINAS - A6BL series M * DL * * * BM 

M * DL * * * BL   

MINAS - A6BL0C0 
series 

M * DL * * * BM0C0 
M * DL * * * BL0C0   

MINAS - A6BN series M * DL * * * BN   
MINAS - A6BN0C0 
series M * DL * * * BN0C0   

MINAS - A6BU series M * DL * * * BU   
Models of drivers can be identified with the character of * in the 
model name above. 
(The characters of * are defined model by model.)  
 
Notes 1)  That is information on the day of Mar. 2025. Please check with the 

shop you buy from if this software is applied to the drive you use. 
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Needed system construction 

To use this software, equipment which satisfy the conditions 
below are needed. Please refer to the operation manual attached to 
the each equipment, and then construct the system. The software 
may not be operated with a different environment from 
recommended one. 

Personal Computer (PC) 
Operation system Windows 10(32bit version, 64bit version)  

Windows 11(64bit version) 
Japanese, English(US), Chinese(Simply), 
Korean version of the OS above 

CPU Follow operating system 
recommendations 

Memory Follow operating system 
recommendations 

Hard disk 1GB or more 
Communication USB port 

COM port (Communication speed 
2400bps - 115,200bps) 

Note) A COM port is required when using RS232 
communication. Communication speed 
recommends not less than 9600 bps. 

Display 
Resolution 1024×768 PIXEL or more 
Color number 24bit color (True Color) or more 

 
<Notes> 
● Windows is needed to be prepared by customers. 
● To use different OS from ones above, customers need to check 

operations. 
● PANATERM should be used in condition that initial setting of Windows is 

renewed into the newest one.  
● Using with other applications, operation of PANATERM may become 

unstable. Please use PANATERM solely. 
● All users can operate the servo driver with PANATERM. To prevent 

dangerous operations, do not leave the PC with PANATERM installed in a 
state where it can be operated by a third party. 
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<Notes> 
· Not guaranteed with other OS. 
· Please check the operation by customers when used with different 

system environment from ones above.  
· This product is performing checking of operations by Windows 10 and 

Windows 11. The operation may be different on other versions. 
· This product is not applied to indication on multiple displays. 
· In case two or more PANATERM are running, all operations cannot be 

guaranteed. 
· Illustrations/screens may be different from actual cases.  
· In conjunction with that Microsoft has ended all support for Windows XP 

(United States time) April 8, 2014, we end support for PANATERM in 
Windows XP. 

· In conjunction with that Microsoft has ended all support for Windows Vista 
(United States time) April 11, 2017, we end support for PANATERM in 
Windows Vista. 

· In conjunction with that Microsoft has ended all support for Windows 7 
(United States time) Jan 14, 2020, we end support for PANATERM in 
Windows 7. 

· In conjunction with that Microsoft has ended all support for Windows 8.1 
(United States time) Jan 10, 2023, we end support for PANATERM in 
Windows 8.1. 
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3. Set up 
 

Installer construction 
PANATERM installer includes the data below.  
Item Folder name after installation 
PANATERM main body PANATERM 
Parameter file conversion software ParameterConverter 
Software for simulation SimMotor 
Disk driver for USB communication USBDriver 

 
<Notes> 
Using PANATERM installer, please install it to the hard disk of the PC. It 
cannot be installed to the network drive. Even with copy or other measure, it 
cannot be installed/setup. 
 
Way of installation 
<Advance preparation> 
1 Turn on the power supply of PC and start Windows. 

(Close down other software running.) 
2 Copy PANATERM installer (setup.exe) into an arbitrary folder. 
3 Disconnect if the driver is connected to the PC with a USB cable. 
4 Uninstall the PANATERM with the way below if PANATERM is 

already installed. 
Select “PANATERM ver.6.0” with “Control panel” > “Programs 
and Features”, and click “Uninstall”. 
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<Start install> 
1 Double - click “setup.exe”. Startup PANATERM Installer. 

Select the language (Japanese, English, Chinese (Simply) and 
Korean). And then, operate following the direction on the screen 

 
 
2 After completing the install, the short cut icons below will be 

made on the desktop. 

 PANATERM ver.6.0 

 ParameterConverter 

 SimMotor 

 
■Notes 
· When an error occurs during setup, an error message will be displayed. 

Please refer to page 261 “Set up”, and remove the cause of the error. 

· Please do not turn off the power supply of the PC or start up other 
software before completion of the install. 

· If Microsoft .NET Framework 4.8 is not installed, install .NET Framework 
4.8 from the Microsoft website. Also, if you are asked to restart your 
computer after installation, please do so. 

· Selection of language on setup is to select language of setup screen. 
The language selection of PANATERM can be changed with “File” > 
“Setting” > “Culture” on the menu bar on the condition that all function 
windows are closed down. 
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<Connection to driver (Device driver setting)> 
1 When you connect using a USB cable, please refer to page 20 

“Connection”, and connect the USB connector on the front of the 
driver and USB connector of the PC. When you connect using a 
RS232 cable, it is not necessary to carry out the following items. 

2 When the driver’s power supply is turned on, pop-up appears on 
the task bar, and installing device driver automatically. 
Notes 1) It is necessary to setup the device driver to each USB connector.  

Please setup device driver for each USB connector of using. 
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4. Basic Operation 
 

Indication of keys 
General Key indications which do not rely on the models of the 
keyboards are used in this manual, the indication may be different. 
Please read the indication based on the table below. 

Indication Context 
[↑][←] 
[↓][→] 

Up down and right and left are indicated. 
With these keys input, selected items are changed. 
Selected item is highlighted. 

Number 
(0  -  9) 

Number keys are indicated. 
Please input the objective number. 

[ESC] 
On keyboards, escape keys are indicated [Esc], [ESC]. 
They are used to turn inputted value back to the original 
one. 

[ENTER] 
Enter keys which is indicated [Enter], [ENTER], [RETURN] 
on keyboards are indicated. Input when each menus are 
selected and executed and at the end of input of values. 

 
Section operation way of menu 
Each item is executed by left - clicking the menu item or the 
operation button required to select. 
Each items can be executed also by highlighting the menu required 
to select with [↑], [→], [↓], [←] keys, and pressing [ENTER] key. 
 
Input of value 
Please input them with number keys on the keyboard. 
Value data of parameter changing and so on is indicated with 
decimal numbers. Please input them with decimal numbers. Binary 
numbers and hexadecimal numbers are not available.  
Value input can be cancelled with [ESC] key. 
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File operations 
The following dialogue of file is displayed when files need to be 
appointing on “Read” or “Save” of parameters and so on. 
 

<Read> 
Use built-in dialogue box in PANATERM for read in parameter file, wave 
form graphic file or frequency character file. 
This dialogue is only the objective file is displayed. 
 

 
 

“All display” : If you checked this, files are displayed that you didn’t 
select series too. 

 
Use dialogue box of Windows common dialogue box for read other file.  
 
<Save> 
Use dialogue box of Windows common dialogue box. 
 

 
 

Width can be dragging. 
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<Notes> 
Extensions are added to files dealt with PANATERM to identify the types of 
each files. Please do not change the extensions. PANATERM cannot read 
files if their extensions are changed. 
 
 Parameter file filename.prm5 

Parameter comparison file 
Object comparison file 
Twisted table compensation 

adjustment results file 
Twisted table compensation 

measuring instrument data file 

filename.csv 

Wave form graphic 
 measure condition file 

filename.wgc5 
filename.wgc6 

Wave form graphic 
 measure result file 

filename.wgd5 
filename.wgd6 

Wave form graphic 
 parameter and measure result file 

filename.wgp5 
filename.wgp6 

Frequency character 
 measure condition file 

filename.fcc5 

Frequency character 
 measure result file 

filename.fcd5 

Frequency character parameter and 
measure result file 

filename.fcp5 

Monitor screen log file filename.mon5 

Fit gain 
 measure result file 

filename.fit5 

Object data file filename.obj5 

Block parameter file filename.obj5 

Twisted table compensation file filename.gnt5 

Linear motor initial adjustment 
 results file 

filename.lms 
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Closing down way of each screen 

Each screen are closed down clicking “Exit” with left button of the 
mouse when there is “Exit” button on the tool bar of the each screen. 
Also they can be closed down clicking      right above of the screen. 
 
Tool chip text 

The explanations of the objective items are displayed if the 
mouse button is put on the displayed items. 

 
 



Rev 3.25 
－ 20 － 

5. Start up and Close down 
 

Connection 
Connection of USB cable (Commercialized product) 
Please confirm that all power supplies of the driver and PC are 
turned off. Please be sure to insert USB cable. 
Please refer to the driver’s manual or technical reference regarding 
connection and setting measure with the front panel. 
<In case 1 driver is connected> 

Notes 1)  Regarding communication speed, it is applicable to full speed of 12 
Mbps only. Actual communication speed may change largely by 
many causes, connection to USB equipment other than drivers, 
operation load condition of PC side OS, communication error 
caused by communication error by noise or something, driver’s 
response speed, and so on. 

Notes 2)  USB cables are not prepared by our company. Please use 
commercialized USB cables applied to USB2.0 with shield and 
ferrite core for anti - noise. 

Notes 3)  When two or more systems are connected simultaneously in parallel 
the operation of PANATERM cannot be guaranteed. 

USB cable 

PC 

USB connector 
(Mini B type) 

Driver 
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RS232 cable 

Pr5.31 = 0 Pr5.31 = 1 Pr5.31 = 2 Pr5.31 = 31 

RS485 cable RS485 cable 

    

X2 connector 

PC 

RS485 cable 

Driver Driver Driver Driver 

 
Connection of RS232 cable 
Please confirm that all power supplies of the driver and PC are 
turned off. Please be sure to insert RS232 cable. 
In connecting two or more drivers, it connects driver with a PC by 
RS232 communication. It connects by RS485 communication 
between each driver. 
Please refer to the driver’s manual or technical reference regarding 
connection and setting measure with the front panel. 
<In case 1 driver is connected> 

<In case 2 or more drivers are connected> 

Notes 1)  About RS232 cable and RS485 cable, it is not preparing at our 
company. Please prepare the cable. 

Notes 2)  Pr5.31 is set as the axis address (ID). Please set the axis address 
(ID) of the driver linked to a PC as 0. The other drivers set the axis 
address (ID) from 1 to 31. Please do not overlap the axis address 
(ID). 

Notes 3)  When you connect two or more drivers, please set up so that the 
communicate speed of each driver becomes the same. 

Notes 4)  Driver is not connectable with PC by RS485 communication. 

RS232 cable 

PC 

X2 connector 

Driver 
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Start up of PANATERM 
1 Turn on the PC, and start up Windows. 
2 Turn on the driver. 
3 Click the shortcut of “PANATERM ver.6.0” made on the desktop 

on the installation. 
In case of no shortcut on the desktop, select the group of “start” > 
“PANATERM” of Windows, and click “PANATERM ver.6.0” among 
them. 

4 PANATERM main screen is displayed. 
Note) When PANATERM starts up for the first time, the indication below is 

displayed to copy sample data of wave form graphic or something 
saved in PANATERM into “My document”. Choose “Continue”. 

 

 
 
Close down of PANATERM 
1 To close down PANATERM, click “File” > “Exit of PANATERM” on 

the menu of PANATERM screen. 
(Clicking      right end of the title bar on PANATERM screen is 
also same operation as “Exit of PANATERM”) 

2 A message to confirm closing down PANATERM is displayed. 
To close down, click “Yes”, to continue PANATERM operation, 
click “No”. 

 
Note) Please note that if programs are closed down without saving 

information set or data obtained, all information would be lost. 
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6. Screen Operation 
 

Select connection with drivers 
Starting PANATERM displays a dialog box asking if you want to 

start communication with a driver. Different screens are displayed 
depending on whether the communication method used is USB or 
RS232. The dialog box also appears when you click “Connect” from 
the tool bar of the main screen or when you select “File” > “Setting” 
> “Communication with the driver” from the menu bar of the main 
screen. 
 
<When USB communication is used> 
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Selection of the communication with the driver 
□“Communication with the driver” 

Communication with the driver connected by USB is done. The 
list of the drivers and motors model names and serial numbers 
are displayed. Please select the driver connected, among them. 

 
□“Series automatic decision” 

The series automatic decision function of driver is set up. Usually, 
please put in a check and validate it. 

 
□“No communication” 

Without communication with drivers, edition of parameter etc. 
saved in files can be available freely. 

 
“OK”  : Determine the context selected. 
“Cancel”  : Make the selected context invalid. 
“Check”  : Selected driver’s front panel LED blinks. 

(Only “Communication with the driver” is 
selected.) 

“Update”  : A list of the driver connected is updated. 
“Nickname setting”  : Selected driver’s nickname setting is 

changed. 
(Only “Communication with the driver” is 
selected.) 

 
Nickname setting 
When “Nickname setting” is clicked on the Communication with the 
driver screen, Nickname setting screen will be displayed for models 
which support nicknames. An error dialog will be displayed for 
models which do not support nicknames 
< Supporting models > < Non-supporting models > 

Note) Initial indication of Nickname setting screen shows blank if no nickname 
is set up, and the set nickname if a nickname has already been set. 
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Set up the nickname on Nickname setting screen and click “OK” to 
reflect the change in nickname, then terminate the Nickname 
setting screen. 
Click “Cancel” to terminate Nickname setting screen without 
reflecting the nickname change. 
 
Notes 1)  When there are drivers communicating, the drivers are displayed 

“Now Connect”. To continue the communication with the drivers 
communicating, please click “Cancel”. 

Notes 2)  The driver displayed as "Already Used" cannot be selected. The 
driver may be communicating with other applications, or it may be 
operating the front panel. 
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<When RS232 communication is used> 

 
 
Selection of the communication with the driver 
□“Communicate with the driver” 

Communication with the driver connected by RS232 is done. 
□“Communicate with the driver (via RS485)” 

It communicates with the driver connected by RS485 cable via 
the driver of the axial address 0. 

□“No communication” 
Without communication with drivers, edition of parameter etc. 
saved in files can be available freely. 

 
“OK”  : Determine the context selected. 
“Cancel”  : Exits the screen without reflecting the selected 

contents. 
 

□“Series automatic decision” 
The series automatic decision function of driver is set up. Usually, 
please put in a check and validate it. 
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Selection of the communication port 
Select the communication port. 

COM 1 – 16 : The specified port is used. 
Auto-set : Connected port is automatically identified. 

 
Selection of the axis address (ID) 
When connecting to a driver (via RS485) is selected, select the axis 
address (ID) of the driver from a list. 
PANATERM performs a parameter setting and the surveillance of a 
state to the driver of the specified axis address in this. 
 

 
 

“OK”  : Determine the context selected. 
“Cancel”  : Exits the screen without reflecting the selected 

contents. 
 
Axis address (ID) 

“Search”  : The state of the connected driver is searched. 
“Cancel”  : Search of driver is stopped. 

 
Notes 1)  When the actually connected number of driver differs from the 

number of the driver whose check of connection was completed by 
search, there is a possibility that a setup of the axis address (ID) is 
wrong. Please check that the axis address (ID) of the driver linked 
to a PC is 0. Moreover, please check whether the axis address (ID) 
of other driver overlaps in 1 to 31. 

Notes 2)  Search of driver requires the time for about 1 minute. 
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Series setting 
When select the “No communication” or “Series automatic decision” 
invalidity, series setting screen is displayed. Select the series name 
of the driver from the list. 
1 Regarding the combination between the driver’s model and the 

series, please refer to page 8 “Confirming applicable drivers”. 
 

 
 

“OK”  : Determine the context selected. 
“Cancel”  : Exits the screen without reflecting the selected 

contents. 
“Setting”  : Display “Series type setting screen”. Please 

refer to page 42. 
 

Note) Even “Communication with the driver” selected, if drivers model 
cannot be identified automatically, series selection is executed in 
case of derivational model, specified model. 
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2 Select the driver’s model from the list. 
 

 
 

“OK”  : Selected items are determined. 
“Cancel”  : Exits the screen without reflecting the selected 

contents. 
 
3 The main screen is displayed, and you can use all kind of 

function. Select the series corresponding to "Welcome" and 
“Welcome” screen is displayed when automatic display setting of 
“Welcome” is enabled. (This screen is not displayed when using 
RS232 communication.) 
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Main screen 
Once PANATERM start up, the main screen is displayed. Many 

PANATERM functions are used opening each function windows in 
this main screen. Some function windows cannot use being opened 
together. 
You can display only valid function window. 

Series 

M
IN

AS-A5 

M
IN

AS-A5B 

M
IN

AS-A5BL 

M
IN

AS-A5II 

M
IN

AS-A5L 

M
IN

AS-
A5L04(LA4) 

M
IN

AS-A5M
N

 

M
IN

AS-A5N
 

M
IN

AS-A5N
D

1 

M
IN

AS-A5N
L 

 U
sable function w

indow
 

Parameter           
Monitor           
Alarm           
Gain Tuning           
Wave form graphic           
Trial run           

Frequency characteristics    
*1 
  

*1 
 
*1 
    

*1 
Pin assign           
Trouble shooting           
Analogue input adjustment           
Z phase search           
Setup Wizard           
Fit gain (standard)           
Fit gain  
(2 degrees of freedom control)           
Object Editor           
Battery refresh           
Block operation editor           
Block operation monitor           
Block operation editor v2           
Deterioration diagnosis           
RTEX Setup           
Magnetic pole position  
estimation results copying 

          
Twisted table compensation           
Linear motor initial adjustment           
Welcome           

(Continued on next page) 
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Series 

M
IN

AS-A6 

M
IN

AS-A6L 

M
IN

AS-A6(V-fram
e) 

M
IN

AS-A6L(V-fram
e) 

M
IN

AS-A6SC
 

M
IN

AS-A6ST 

 U
sable function w

indow 

Parameter       
Monitor       
Alarm       
Gain Tuning       
Wave form graphic       
Trial run       
Frequency characteristics 

 
*1 
 
*1 
 
*1 
 
*1 
 
*1 
 
*1 

Pin assign       
Trouble shooting       
Analogue input 
adjustment 

      

Z phase search       
Setup Wizard       
Fit gain (standard)       
Fit gain  
(2 degrees of freedom 
control) 

  
*2 
  

*2 
  

Object Editor       
Battery refresh       
Block operation editor       
Block operation monitor       
Block operation editor v2       
Deterioration diagnosis       
RTEX Setup       
Magnetic pole position  
estimation results 
copying 

      

Twisted table 
compensation 

      

Linear motor initial 
adjustment       

Welcome       

 
Some functions are restricted depending on software version of driver. 
For details, refer to technical specification of driver. 
*1 Analysis after frequency characteristic measurement cannot be used. 
*2 Only linear type (LINEAR) is supported. Rotary type (DD) is not supported. 
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Series 

M
IN

AS-A6N
 

M
IN

AS-A6N
L 

 U
sable function w

indow 

Parameter   
Monitor   
Alarm   
Gain Tuning   
Wave form graphic   
Trial run   
Frequency characteristics 

 
*1 
 
*1 

Pin assign   
Trouble shooting   
Analogue input 
adjustment 

  

Z phase search   
Setup Wizard   
Fit gain (standard)   
Fit gain  
(2 degrees of freedom 
control) 

  
*2 

Object Editor   
Battery refresh   
Block operation editor   
Block operation monitor   
Block operation editor v2   
Deterioration diagnosis   
RTEX Setup   
Magnetic pole position  
estimation results 
copying 

  

Twisted table 
compensation 

  

Linear motor initial 
adjustment 

  

Welcome   

 
Some functions are restricted depending on software version of driver. 
For details, refer to technical specification of driver. 
*1 Analysis after frequency characteristic measurement cannot be used. 
*2 Only linear type (LINEAR) is supported. Rotary type (DD) is not supported. 
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Series 

M
IN

AS-A6B 

M
IN

AS-A6BC
 

M
IN

AS-A6BL 

M
IN

AS-A6BL0C
0 

M
IN

AS-A6BN
 

M
IN

AS-A6BN
0C

0 

M
IN

AS-A6BU
 

 U
sable function w

indow 

Parameter        
Monitor        
Alarm        
Gain Tuning        
Wave form graphic        
Trial run        
Frequency characteristics 

 
*1 
 
*1 
 
*1 
 
*1 
 
*1 
 
*1 
 
*1 

Pin assign        
Trouble shooting        
Analogue input 
adjustment 

       

Z phase search        
Setup Wizard        
Fit gain (standard)        
Fit gain  
(2 degrees of freedom 
control) 

   
*2 
 
*2 
 
*2 
 
*2 
 

Object Editor        
Battery refresh        
Block operation editor        
Block operation monitor        
Block operation editor v2        
Deterioration diagnosis        
RTEX Setup        
Magnetic pole position  
estimation results 
copying 

       

Twisted table 
compensation 

       

Linear motor initial 
adjustment 

       

Welcome        

 
Some functions are restricted depending on software version of driver. 
For details, refer to technical specification of driver. 
*1 Analysis after frequency characteristic measurement cannot be used. 
*2 Only linear type (LINEAR) is supported. Rotary type (DD) is not supported. 
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<When USB communication is used> 

 
 
Note) Pin assign setting screen, setup wizard, RTEX setup screen, 

and Twisted table compensation can be operated when all 
other windows are closed. 
Even outside the above function windows, combinations in 
the following cannot use.  
(See the next page’s table.) 
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 Functions that cannot be opened simultaneously 
Parameter Gain tuning, Fit gain (Standard), 

Fit gain (2 degrees of freedom control), 
Object Editor, Block operation Editor, 
Block operation Editor v2, 
Deterioration diagnosis, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Gain tuning Parameter, Fit gain (Standard), 
Fit gain (2 degrees of freedom control), 
Object Editor, Block operation Editor, 
Block operation Editor v2, 
Deterioration diagnosis, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Wave form 
graphic 

Linear motor initial adjustment 

Trial run Fit gain (2 degrees of freedom control), 
Z phase search, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Frequency 
characteristics 

Fit gain (Standard), 
Fit gain (2 degrees of freedom control) 
Linear motor initial adjustment 

Analogue input 
adjustment 

Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Z phase search Fit gain (2 degrees of freedom control), 
Trial run, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Fit gain 
(Standard) 

Parameter, Gain tuning, 
Frequency characteristics, Object Editor, 
Block operation Editor,  
Block operation Editor v2, 
Deterioration diagnosis, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 
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 Functions that cannot be opened simultaneously 
Fit gain  
(2 degrees of 
freedom control) 

Parameter, Gain tuning, Trial run, 
Frequency characteristics, Z phase search, 
Object Editor, Block operation Editor, 
Block operation Editor v2, 
Deterioration diagnosis, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Object Editor Parameter, Gain tuning, Fit gain (Standard),  
Fit gain (2 degrees of freedom control) , 
Block operation Editor, Block operation Monitor, 
Block operation Editor v2, 
Deterioration diagnosis, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Block operation 
Editor 

Parameter, Gain tuning, Fit gain (Standard), 
Fit gain (2 degrees of freedom control), 
Object Editor, Block operation Editor v2, 
Deterioration diagnosis, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Block operation 
Monitor 

Object Editor, Block operation Editor v2 
Linear motor initial adjustment 

Block operation 
Editor v2 

Parameter, Gain tuning, Fit gain (Standard), 
Fit gain (2 degrees of freedom control), 
Object Editor, Deterioration diagnosis, 
RTEX setup, Block operation Editor, 
Block operation Monitor, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 

Deterioration 
diagnosis 

Parameter, Gain tuning, Fit gain (Standard), 
Fit gain (2 degrees of freedom control), 
Object Editor, Block operation Editor, 
Block operation Editor v2, 
Magnetic pole position estimation results copying 
Linear motor initial adjustment 
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 Functions that cannot be opened simultaneously 
Magnetic pole 
position 
estimation 
results copying 

Parameter, Gain tuning, Trial run,  
Fit gain (Standard),  
Fit gain (2 degrees of freedom control), 
Analogue input adjustment, Z phase search, 
Object Editor, Block operation Editor,  
Block operation Editor v2, 
Deterioration diagnosis 
Linear motor initial adjustment 

Linear motor 
initial adjustment 

Parameter, Gain tuning, 
Wave form graphic, Trial run, 
Frequency characteristics, 
Fit gain (standard), 
Fit gain (2 degrees of freedom control), 
Analogue input adjustment, 
Z phase search, Object Editor, 
Block operation editor, 
Block operation monitor, 
Block operation editor v2, 
Deterioration diagnosis, 
Magnetic pole position estimation results copying 
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<When RS232 communication is used> 

 
 
Note) Gain tuning, trial run, trouble shooting, analogue input 

adjustment, Z phase search, setup wizard, fit gain, object 
editor, battery refresh, block operation editor, block operation 
monitor, Block operation Editor v2, deterioration diagnosis, 
RTEX setup, Magnetic pole position estimation results 
copying, Twisted table compensation and Linear motor initial 
adjustment cannot used. 
Frequency characteristics screen and pin assign setting 
screen can be operated when all other windows are closed. 
Since detection of guide wire malfunction is not performed, 
during operation, please do not cut a communication cable or 
do not turn off the power supply of driver. 

 
When connecting each driver with RS485 cable, it is possible to 
change connection driver from "Axis (ID)" of a tool bar. 
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Structure of main screen 

 

 
(1) Title bar 

Model code and setting condition of communication port are 
displayed. 

(2) Menu bar 
The menu of “File”, “Display”, “Window”, “Tool” and “Help” are 
displayed. Click a command name to use a command.  Some 
commands are divided by functions. And they changes by 
opening each function’s. 

 

 
(3) Tool bar 

Each function windows are called. Function windows can be 
called also out of the menu bar of the main screen. 
Without communication with drivers, valid functions are limited. 
 
In subsequent explanation, the functions that can call a function 
window with a tool bar are explained with the case using a tool 
bar for an example.  

(1) Title bar 

(3) Tool bar 
(2) Menu bar 
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Communication set-up at PC screen 
In a communication setup at PC screen, communication between 
driver and PANATERM is set up. 

 
Note) Usually, please use initial setting. This setup becomes only the PC 

side and is not reflected in the driver side. Please be careful. 
 
Open the Communication setup at PC window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “File” > “Setting” > “Communication with the driver” is 

selected on the menu bar on the main screen. 
3 The Communication setup at PC window is opened. 
 

 
 

“OK”  : Selected items are determined. 
“Cancel”  : Exits the screen without reflecting the selected 

contents. 
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Communication method setting 
Connection with driver select from “USB” communication or 
“RS232” communication. 
When starting PANATERM next this setup is effective. 
 
RS232 setting (When “RS232” is selected) 

“RS232 port”  : Initial value of the communication port 
at the time of automatic search is 
selected. 

“Communication speed”  : Initial value of the communication 
speed at the time of automatic search 
is selected. 

 
Notes 1)  Since the connection setup newest by this setup is memorized 

when it is under connection by RS232 communication, it cannot 
select except a setup in use now. 

 
Protocol setting (When “RS232” is selected) 

“Time-out period T1”  : Specify timeout T1 between characters 
in 0.1 seconds. 

“Time-out period T2”  : Specify timeout T1 between protocols 
in seconds. 

“Retry times”  : Specify the number of communication 
retrials. 
Setting range is from 1 to 8 times. 
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Series type setting screen 
In a series type setting screen, you can use the driver of other 
series by adding a series definition to PANATERM. 

 
Note) Please use the default setting normally. 

For more information, please contact a distributor. 
 
Open the Series type setting window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “File” > “Setting” > “Series type setting” of the menu bar on 

the main screen. 
3 The Series type setting window is opened. 
 

 
 
“->” : Move selected series in “Disable Series List” to 

“Enable Series List”. 
“<-” : Move selected series in “Enable Series List” to 

“Disable Series List”. 
“Reference” : You can add a new series to “Enable Series List” 

by referring to series definition file on the PC. 
“Apply” : Apply the changes of the series definition setting. 
“Close” : Close the series type setting window. 
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Enable Series List 

The available series are displayed.  
If you double click a series in this list or select series and click “<-” 
you can move it to “Disabled Series List”. 
 

Disable Series List 
The unavailable series are displayed. 
If you double click a series in this list or select series and click “->” 
you can move it to “Enabled Series List”. 
 

Close the Series type setting window 
Click “Close” button or      button at top right of the screen. 
If you do not run "Apply" after changing the series definition, the 
exit confirmation dialog is displayed. 
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Adding and updating of the series definition by reference 
1. If you click "Reference", the Browse For Folder dialog box is 

displayed, and you can select folder. 
 

 
 
2. Click “OK” after selecting the folder.  

If selected folder has a series definition file then a confirmation 
dialog is displayed.  
Click “Yes” then the series definition file is added. 
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3. If adding a series definition is success, “Enable Series List” will 

be updated. 
 

 
* The background color of the series definition that you added or 

updated will change. 
 
4. Click “Apply”, in order to enable changes of the series definition.  

If you change the series definition, the confirmation dialog will be 
displayed.  
Click “Yes” then apply changes of the series definition. 
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5. Completion of Series definition setting dialog will be displayed. 

 
< When changed >         < When not changed > 

    
 

6. The series that have been added are available for selection in 
the series setting screen. 
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Notes 1) You cannot delete the MINAS-A5 series, which is a standard 

model. However, update by “reference” is possible. 
Notes 2) You cannot delete or update current selected series. 

If you want to delete or update current selected series, please retry 
after switching to the other series. 

Notes 3) The series definition in “Disable Series List” with a yellow 
background color does not exist in the installation folder of 
PANATERM. 
So, if you delete that series, it will not be displayed “Disable Series 
List”. If you do not have a backup, you cannot restore. 

Notes 4) When you update a series definition, some of the previous settings 
are initialized. 
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Parameter screen 
In a parameter screen, parameter check of drivers, modification 
of parameters, saving parameters into files and some other 
operations on parameters are available. 

 
Note) Please modify parameters with enough care after reading the driver's 

instruction manual or technical reference carefully, as some 
parameters give large effect to operations of drivers or motors. 

 
Open the Parameter window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Parameter” of the tool bar on the main screen. 
3 Selection of parameter to be read window is displayed. 
 

 
 
4 Select the origin of parameters, and click. 

□“Read - out from the driver” 
The parameters set in the driver are read communicating the driver 
connected. If this mode is selected, modifications of the parameter 
values are reflected to the driver immediately. 

□“Read from the file” 
Parameter files already edited (.prm5) are read. Parameter modifications 
are not reflected to the driver connected unless “Transmit the parameter 
to the driver” is executed when they are “Read from the file”. 

□“Read the default” 
Default set values saved at the time of installation is read. The parameter 
modifications are not reflected unless “Transmit the parameter to the 
driver” is executed as the case of “Read from the file”. 
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5 Click “OK”. The Parameter window is opened. 
 

 
 
Close the Parameter window 

Click        (Exit) on the tool bar. 
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Structure of Parameter screen 

 

 
 
 
 
(1) Title bar 
The origins of reference of parameters reference are displayed. 
Following buttons are used to operate windows. 

  Display the window in full screen 

  Close the window 

(2) Tool bar 
Saving, reading, some other basic operation commands on 
parameters are listed. 

 (Read) 
Reads parameters from files (.prm5). 
When this button is effective, a parameter file can 
be specified by drag and drop. 

 (Save) Writes parameters to files (.prm5). 

 (Comment) Makes comments attached to parameters files. 

 (Receive) Receives parameters from the driver. 

 (Transmit) Sends parameters to the driver. 

 (Print) Prints parameters. 

(1)Title bar 

(7)Setting out of bounds is 
admitted 

(8)Display - Set value 
description 

(2)Tool bar 

(3)Theme 
selection 

(4)Parameter 
setting field 

(5)Text indication 
box 

(6)Parameter 
attributes 
explanation 
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 (Exit) Closes parameter screen. 

 (EEPROM) Write parameters to EEPROM of the driver. 

 (Screen) Captures the screen and save into a file. 

 (Compare) Compares parameters on editing with other 
parameters. 

 (Initialize) Initialize parameters of the driver. 

 
(Binary/ 
Hexadecimal) 

Enter the number of binary and hexadecimal 
values of the selected setting. 

(3) Theme selection 
If the parameter classification is 
selected from the sub theme, 
related parameters are 
indicated in the parameter 
setting field. 
The Help indicated by double 
clicking the underline of the sub 
theme. 
Please refer to the manual of 
drivers or technical reference 
regarding the details of sub 
theme. 
 
 

(4) Parameter setting field 
Editing and setting of parameters are available. 
“Class” Parameter classifications are indicated. 

“No.” Parameter numbers are indicated. 

“Parameter name” Parameter names are indicated. 

“Setup range” Maximum & minimum value of parameter setting is 
indicated. 

Theme 

Sub-theme 
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“Set value” Parameter value. Its value can be modified. 
Parameters with on the set values are set with the 
combo boxes. After selecting the values from the combo 
boxes, input the [ENTER] key or click (modification 
of set value). 
Parameters without  on the set values, are inputted with 
the number keys directly, or modified clicking  and 
changing the values. To set the values, input the [ENTER] 
key or click (modification of set value). 
If the [ESC] key is inputted, the value is return to the 
original one. 

“Unit” Units of the parameter set values are indicated. 
 
(5) Text indication box 
Explanations regarding selected parameters. 

(6) Parameter attributes explanation 
Explanations regarding of parameter attribute. Back ground colors 
of parameters indicate the attributes. 

(7) Can over value 
Without communication with drivers, if a check mark is inputted on 
“Can over value”, settings out of bounds can be available. Setting 
with combo boxes is not available with check mark on “Can over 
value”. 

(8) Display - Set value description 
The combo box and the decimal point are displayed when checking 
it. You can display more details of the parameters, when check on 
“Display - Set value description”. 
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Comment 

On saving set parameters in a file, comments can be saved 
together. These comments do not effect operations of the driver. 
 
Making Comment 
1 Click       (Comment) on the tool bar, and open the comment 

window. 
 

 
 
2 Click comment box and input comments. 
3 After completing comment input, click “OK”. 
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Comparison 

Parameters being edited can be compared with other parameters. 
 
Comparison of parameters 
1 Click       (Comparison) on the toolbar, and open the parameter 

comparison window. 
 

 
 
2 Select “Read from the file” or “Read from the driver initialization 

area”, and click “OK”. 
In case “Read from the file” is chosen, please select the file 
(.prm5) to be compared. 
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3 Comparison result of parameters is displayed. 
 

 
 
4 Click “Save”, comparison result of parameters can be saved at a 

file. 
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Initialization 

Parameters can be initialized to the default values. The initialized 
parameters are written to also the EEPROM. To save current 
parameters, please save the parameters before initialization. 
 
Initialization of parameters 
1 Click        (Initialization) and open the initialization window. 
 

 
 
2 Select “All parameter initial” or “Select sub theme parameter 

initial”, and click “OK”. 
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3 Set “Change Flag”. 
 

 
 
4 Click “OK” Button. 
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Binary/Hexadecimal 

You can enter binary or hexadecimal values for the selected 
parameter.  
 
Entered in binary/hexadecimal 
1 Click        (Binary/Hexadecimal) and open the 

Binary/Hexadecimal input window. 
 

 
 
2 When you enter hexadecimal numbers, please press the 

[ENTER] key after typing. When you enter binary numbers, 
please press the button for corresponding to each bit.  
* If you enter beyond the parameter ranges is displayed within the limited 

value of the bottom of the decimal. 

3 After completing value input, click “OK”. 
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Notes 1) Please refer to the manual of the driver or technical reference for 

details of each parameter’s function and so on. 
Notes 2) Even if parameters are sent to the driver, parameters are turned to 

the original value before modification if the power supply of the 
driver is turned off without writing to EEPROM of the driver. 
Parameter modifications list are displayed on EEPROM writing. 
Please check the modification carefully. 

Notes 3) Do not turn off the power supply of the PC during writing to 
EEPROM of the driver. Data context cannot be guaranteed if the 
power supply is turned off during writing. 

Notes 4) Some parameters become valid after modifications to the new 
data, writing EEPROM, and power supply reset. (On inputting, that 
issue is displayed. Please refer to the manual of the driver or 
technical reference and confirm on the objective parameters) 

Notes 5) Parameter screen indication may be different from the actual 
parameter value of the driver in case PANATERM function windows 
which change the parameters (ex. Trial Run, Pin Assign, Analog 
Input) is opened. In such case, press the reception button and 
update the parameter of the driver to the latest one. 

Notes 6) The parameter screen cannot open during opening some screens. 
For more information please refer to page 265 “Parameter screen 
behavior”. 
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Monitor screen 
You can display and check the operation conditions of Driver and 
motor, in - out put signal and internal status. And you can record 
the monitoring data in long times and play it back on the screen. 

 
Note) When you use RS232 communication with the communication speed 

of less than 4800 bps, please do not make a monitor cycle into 1 
second. 
When using digital input / output signal monitoring, pin number error 
may appear on screen. 
For details, please contact the consultation desk. 

 
Open the Monitor window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Monitor” of the tool bar on the main screen. 
3 The Monitor window is opened. 
 

 
 
Close the Monitor window 

Click     of upright on the window. 
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Structure of Monitor screen 

 
Indication of signal name is different in the motor model. 

 
 
(1) Title bar 
Control mode is displayed. You can operate window. 

(2) Log function 
You can record log of monitoring contents and play it back. 

 (Display of 
operating 
conditions) 

Display the log operating function. 

 (Setting the 
communicatio
n of Opening 
time) 

Set the communication of opening time 
between Driver and PC. 
You can chose 1s, 5s or 10s. 

 (Start Log file 
output) 

Start Log file output. 

 (Rewind) Rewind log file which is playing it back. 
You can shoes 2 times, 4 times, 8 times or 16 
times. 

/  (Play back) 
/(Pause) 

Select Log file and play back/stop. 
When this button is effective, a log file can be 
specified by drag and drop. 

 (Fast forward) Fast forward Log file. You can choose two 
times, 4 times, 8 times or 16times. 

(1) Title bar 
(2) Log function 

(3) Monitor 
contents 
displayed 
area 7. 6. 

1. 

8. 

4. 
2. 

5. 

3. 

9. 
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/  (Stop)/(Start) Stop/Restart of Monitoring operation. 
When you record Log and restart it, Record and 
restart is finalized. 

 (Information) The relevant page of the operating instructions 
for driver. (Only MINAS-A5 is supported) 

 
(Screen) Captures the screen and save into a file. 

 (Display of 
Time) 

Display the present time. 
When you are play it back, recorded time is 
displayed. 

 (Slider) Display the present time in all log data. 

 
(3) Monitoring Contents display area 
Display monitoring information. 

1. Driver Model name / Driver Serial Number 
Display Driver Model name and Serial Number. 

2. Input signal conditions monitoring 
Display input signal condition. Using tab, you can select 
“Physical Input” and “Logical input”. 
Display Input signal condition to Physical Input - Driver. 
  Red : COM (-) connection 
  Pink : Open 
Logic input - Display signal condition of Driver. 
  Red : Active 
  Pink : Inactive 

3. Output signal condition monitoring 
Display output signal condition. By using Tab, you can switch 
“Physical output” and “Logical output”. 
Physical output 
Display output signal condition from Physical output - Driver. 
  Red : Output Transistor ON 
  Pink : Output Transistor OFF 
Logical output 
Display Signal condition of Logical output - Driver Internal part. 
  Red : Active 
  Pink : Inactive 
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4. Internal State Monitoring 

Display the internal condition of Driver. 
5. Pulse Count Total monitoring 

Display the Pulse count total of Command / Encoder / External 
Scale taken in by driver. 
“Counter RST” is toggle Button, with a timing of counter reset, 
PANATERM is recording 3 pulse count total as offset value 
and then, after that this shows value deducting this offset value. 
If you again click it, Offset value is clear and display the Pulse 
count total itself from original driver. 

6. Analog input Monitoring 
Display the electric voltage value of Analog input. 

7. Alarm / Warning Monitoring 
Display present alarm and warning of driver. 

8. Encoder / External Scale information monitoring 
Display Encoder/External scale information. 
If you click “Mul-turn CLR”, Multi-turn data recorded by 
encoder is clear to 0, and all encoder error shall be cleared. 
Note) Please refer to the remarks when you use multi-turn 

clear. And it is necessary for you to restart when you 
clear the encoder error. 

9. Digital input / output signal monitoring 
Display up to 3 the physical input / output signal’s changed 
number of times. 
As driver is counting changed number of times, you can find 
the shorter changed signal than communication intervals on 
monitor screen. 
Note) Standardly display signal level, display more than 2 

times changed signal on communication interval in the 
red square. 

Note) If the display is not updated in time, it will be displayed at 
a low level. 
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Forced Output Button 
When this button is pushed, and OK button is pushed with Dialogue 
of confirmation, is shifts to the Input / output confirmation mode. In 
the case of standard type, the front panel display is fixed to the 
monitoring display input / output display. 
You can check only in Input / output confirmation mode. If you input 
Physical input, the driver is not operative. And against Physical 
output, with left check box, you can compulsorily turn On/Off the 
output signal. 
Note) If you need the driver of Input / Output confirmation mode to 

be returned to the standard conditions, you shall restart the 
driver. 

 
Notes 1) Using USB communication or RS232 communication as data 

receipt between Driver and PC, there are accidental errors, delay 
of display value on the screen, recoded monitoring value, and time 
on the log file and actual driver value and recoded time. 

Notes 2) There are accidental errors of recoded time between monitoring 
display, recoded log file and many data in a time. If you need more 
detail information, please refer to the wave graphic. 

Notes 3) The (+) and (-) symbols are not displayed even if the polarity is 
present. 

Notes 4) Monitoring function is not precious measurement instrument. 
Monitoring display shall be used as rough estimate. 

Notes 5) The monitor screen cannot open during opening some screens. 
For more information please refer to page 266 “Monitor screen 
behavior”. 

Notes 6) Physical input and physical output signal names are displayed 
according to the current parameter settings. 
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Alarm screen 
In case that driver’s front panel LED is flashing like that Motor is 
not operative etc., you can check the error conditions. 

 
Open the Alarm window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Alarm” of the tool bar on the main screen. 
3 When not communicating with driver, the selection screen of a 

parameter is displayed. Please select the parameter file saved 
when alarm was reported. 

4 The Alarm window is opened. 
 
<When communication with driver> 
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<When not communication with driver> 

 
 
Close the Alarm window 

Click        (Exit) on the tool bar. 
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Structure of Alarm screen 

 
Now Happened Error / Warning display 
This is displayed when communication with driver only. 
 

 
 
Past Error History display 
 

 
 
(1) Title bar 
You can operate this window. 

(1) Title bar 

(5) Warning 
Display area 

(2) Tool bar 

(4) Present Error 
Display area 

(6) Error Record 
Display area 

1. 
2. 

3. 

1. 

2. 

(3) Tab 

1. 
2. 

3. 
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(2) Tool bar 

 
(Alarm clear) You can clear the present error. 

Removing the cause of errors, you click this button, 
present error is clear and it operates correctly. 
However, you cannot delete the error that you 
cannot clear by alarm clear input signal. Please turn 
off the driver and remove the cause of error, please 
turn on the electric power again. 

 
(Record clear) You can delete error record. 

 
(Print) Print out the information about the errors. 

 
(Exit) Close the Alarm window. 

 (Information) The relevant page of the operating instructions for 
driver. (Only MINAS-A5 is supported) 

 
(Screen) Capture the screen and record the screen into the 

file. 

(3) Tab 
Switch the display of “Now Error / Warning” and “Past Error History” 

(4) Now Happened Error display area 
1. Display present all happening error numbers and names. 

Displayed error on the top is an error displayed on the front 
panel. 

2. Display the selected error’s causes and countermeasures. 
3. Display the motor internal conditions on the selected alarm 

happening. 

(5) Warning display area 
1. Display all present happening warning numbers and names. 
2. Display selected warning causes and countermeasures. 

(6) Error record display area 
1. Display error record order, error number and error names. 
2. Display the selected error causes and countermeasures. 
3. Display the motor internal conditions on the selected alarm 

happening. 
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Notes 1) There are some errors, which is tripped, but is not left as error 

record. Please refer to the driver manual or technical reference. 
Notes 2) Error records are saved up to 14 times. If errors happen over 14 

times, oldest record is deleted in order. 
Notes 3) Internal conditions of motor is recorded up to 3 times on alarm 

happening.  When the alarm is generated immediately after turning 
on of the power supply, an internal state of the motor might not be 
able to be acquired standardly. 

Notes 4) The alarm screen cannot open during opening some screens. For 
more information please refer to page 267 “Alarm screen 
behavior”. 

Notes 5) The control mode in the motor internal state at the time of the 
alarm indicates the state in the driver and does not match Pr0.01 of 
the driver. 
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Gain Tuning screen 
You can adjust servo gain parameter with the driver’s auto 
adjustment function. And you can use easy monitoring that 
automatically measures the tuning index. 

 
Note) If you adjust auto adjustment function of the driver please refer to 

application scope and remarks specified in the driver manual or 
technical reference. 
Gain tuning cannot be performed through RS232 communication. 

 
Open the Gain Tuning window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Tuning” of the tool bar on the main screen. 
3 The Gain Tuning window is opened. 
 

 
 
Close the Gain Tuning window 

Click        (Exit) on the tool bar. 
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Structure of Gain Tuning screen 

 

 
 
(1) Title bar 
You can operate this window. 

(2) Tool bar 

 
(Receive) Receives parameters from the driver. 

(Valid only when the Parameters tab is selected) 

 
(Exit) Close the gain tuning window. 

 
(EEPROM) Write parameter value to EEPROM of driver. 

 (Information) The relevant page of the operating instructions for 
driver. (Only MINAS-A5 is supported) 

 
(Screen) Capture the screen and record it to the file. 

(3) Tab 
Switch Gain tuning setting area display to “Real time auto-gain 
tuning”, “Damping control”, ”Control filter & Other”, “Parameter”. 

(4) Gain tuning setting area 
You can perform Real time auto-gain tuning, Adaptive filter, 
Damping control, Control filter and the parameter setting. 

(1) Title bar 

(5) Easy 
monitor 
display 
area 

(4) Gain tuning 
setting area 

(2) Tool bar 
(3) Tab 
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(5) Easy monitor display area 
You can measure the tuning index easily. 
 
Method of performance of real time auto-gain tuning 
1 Select a tab of “Real-time auto-gain tuning”. 
 
<When driver doesn’t have 2 degrees of freedom control (MINAS-A5 etc.)> 

 
 
<When driver has 2 degrees of freedom control (MINAS-A5II etc.)> 
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2 In accordance with the usage of your machine, you can change 

the “Select Mode” and “Rigidity”. 
If you select “6: Customize” in “Select Mode”, you can specify the 
detail function individually. In “Customized Setting”, “Real time 
Auto Tuning Custom Setting” window will open, please set the 
conditions. 

* If you open customized setting window and push OK, at the same time, 
mode selection is changed to “6: Customize”. 

* “Real time Auto Tuning Custom Setting” are not available in 2 degrees of 
freedom control mode. 

 

 
 
3 You can operate the motor using “Trial Run” of PANATERM or 

external command. If motor revolves, presumed value of load 
characteristics is displayed. 

4 Using wave graphic function of PANATERM or easy monitor, you 
can check the result of moving of motor and adjust the “Rigidity” 
setting. “Rigidity” setting can be performed by right side of figures 

 (+) or  (-). 
 
Valid for auto detection 
On the conditions that Gain Tuning screen is open, and the mode 
setting is from 1 to 4, you can use auto suppression of oscillation. 
Checking this check box, the rigidity setting is automatically down 
on motor oscillation happenings, and motor oscillation is 
suppressed. 
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Change of parameter about load characteristics 
If you manually change the parameter of load characteristic, please 
click “Edit” button and change the setting value. After changing, you 
click “Send” button, all parameter shall be transmitted to driver. 
During editing, the block display is not renewed. Please click the 
“Monitor” button to restart monitoring. 
 
Setting method of adaptive filter 
1 Select the tab of “Damping control”. 
 

 
2 For the adaptive filter to be effective, please change “1:1 filter is 

valid” or “2: 2 filters are valid”. If the vibration happens in motor 
speed, other figures except for 5000[Hz] as “Resonance Vibration 
Frequency” are displayed. And 3rd or 4th notch filter is 
automatically set. 

3 If you want to clear the adaptive result, please change the “Filter 
Mode” to “4: Clear result of adaptation”. 

 
* “Resonance Vibration Frequency” display shows the latest 

frequency when the vibration is detected by adaptive operation. 
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Resonance frequency measurement mode 
1 If you measure only the resonance frequency without notch filter 

setting, please change Adaptive filter mode to “3: Resonance 
frequency measurement”. 

2 If the vibration happens in motor speed, the figures except for 
5000[Hz] as “Resonance Vibration Frequency”. 

 
 
3 If you set this frequency with notch filter, after push the “Edit” 

button, please click the “setting” button, check the contents of 
following confirmation screen and click “OK”. 

 

 
 
4 If you clear resonance frequency you set, after push the “Edit” 

button, please click the “Clear” button whose number you want to 
clear. As same confirmation screen is displayed, if ok, please click 
the “OK” button. 

 
Change of parameter about Notch filter etc. 
If you need to manually change the parameter about notch filter etc., 
please click ”Edit” button and change the setting value. After 
changing them, if you click “Send” button and all parameter in this 
block shall be transmitted to the driver. During editing, as the 
display of this block is not renewed, please click “Monitor” button 
again. 
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Setting method of damping control 
1 Select the tab of “Damping control”. 
 

 
2 You can use max 2 sets of filters in damping control at the same 

time. You can set which one is effective according to the 
operation conditions from the 4 sets of “Damping control” setting. 
Note) Please refer to the driver manual or technical reference as 

to this parameter specification. 
3 When you operate the positioning by position control or full 

closed control, trial operation function or external command, if the 
vibration in position deviation at settling time, the other figures 
except for 0.0[Hz] shall be displayed in “Vibration Frequency”. 

4 If you want to suppress this vibration, after push the “Edit” button, 
please click “setting “button next to effective vibration filter 
number in operation. 
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5 As the confirmation screen of vibration frequency setting, if ok, 

please click “OK”. 
 

 
 
6 If you clear vibration frequency you set, after push the “Edit” 

button, please click “Clear” button whose number you want to 
clear. If ok, please click “OK” button. 
 

Change of vibration control parameter 
If you manually change the damping control parameter, please click 
“Edit” button and change the setting value. After change of them, 
you click “Send” button, all parameter in this block shall be 
transmitted to the driver. During editing, as this block display is not 
renewed, please click “Monitor” button again. 
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Setting method of Position command filter 
1 Select the tab of “Command filter & Other”. 
 

 
 
2 If you change the parameter of position command filter, please 

click “Edit” button and change the setting value. 
 

 
 
3 After changing them, when you click “Send” button, all parameter 

in this block shall be transmitted to the driver. During editing, as 
this block display is not renewed, please click “Monitor” button 
again. 
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Manual setting method of the gain tuning parameter 
1 Select the tab of “Real-Time auto-gain tuning”, and select the 

mode of “0: Invalid”. 
 

 
 
2 Select the tab of “Parameter”. 
 

 
 
3 Please select the setting value of parameter you want to edit. 

After changing the setting value of the parameter you want to edit, 
enter the [ENTER] key or click the “Change of the value” button. 
Note) Only the parameter that checks “Extract” is displayed when 

“Only the extraction parameter is displayed” is checked. 
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Measurement the tuning index by easy monitor 
 

 
 
1 Set the easy monitor setting. 

“Mes. mode”     : Set the measurement mode. 
With position instruction: Measure the tuning index from the 

start of position commanded to next start of 
position command or shorter measurement 
time. 

Uniformity time: Measure the tuning index from the each time 
data set by measurement time. 

With speed instruction: Measure the tuning index from the start 
of speed command to next start of speed 
command or shorter measurement time. 

“Mes. count”      : Set the measured number of time. 
“Mes. time[ms]” : Set the maximum measuring time period [ms]. 

2 Click “Measurement start” 
Note) If you click “Measurement start”, the displayed index shall 

be cleared. 
3 The measured results shall be renewed until the trial No. meets 

the measured number of time, or you click “Measurement stop”. 
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【Monitoring Item】 

The tuning indices are as below. 
Stabilization time Times [ms] from the finalization of positioning 

command passing to the range of completion of 
positioning of the position deviation. 
Or times[ms] from the below speed command still 
value to Zero speed range of Motor speed 

INP crack count Count [times] is a number in which two times (the on 
signal that entered range of in-position first and the 
off signal when starting) are pulled from the number 
of times into which INP1 output changes between 
tact. 

Vibration level Conversion value from vibration level to torque 
value[%] 

Effective load 
factor 

Torque command effective value among tact[%] 

Tact Measured time[ms] for one trial 
Instructed time Time[ms] from the trial start to final position 

command or the time by detecting more than speed 
command sill value 

Speed zero cross Count [times] is a number in which two times (the on 
signal that entered range of in-position first and the 
off signal when starting) are pulled from the number 
of times into which ZSP output changes between 
tact. 

Instructed speed 
min 

Command speed minimum value [r/min] during trial 

Instructed speed 
max 

Command speed maximum value [r/min] during trial 

Motor speed min Motor speed minimum value [r/min] during trail 
Motor speed max Motor speed maximum value [r/min] during trail 
Torque instruction 
min 

Torque command minimum value [%] during trial 

Torque instruction  
max 

Torque command maximum value [%] during trial 

Pos. following 
error min 

Positioning deviation minimum value during trial 
[Command unit] 

Pos. following 
error max 

Positioning deviation maximum value during trial 
[Command unit] 
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The following indices are expressed as a model with 2 degrees of 

freedom control (MINAS-A5II, MINAS-A6 etc.). 
Micro vibration 
count 

The number of times that the mark of actual speed 
with a blind sector changed [Times] 

Overshoot The overshoot amount of an instruction position 
deviation [Command unit] 

Command 
movement 

The amount of instruction position change between 
tact [Command unit] 

INP crack count 
of settling 

The number of times of an INP crack after instruction 
ejection [Times] 

 
Notes 1) If you click “Measurement start” or servo on the driver during the 

measurement, Trial No. shall be starting from 1. 
Notes 2) If the measurement time is shorter than the tact, there is possibility 

that the results of settling time etc. are not correctly measured. 
Please assure the enough measurement time. 

Notes 3) If you record the monitoring results, please select the cell of the 
monitoring result you need to record and select “Ctrl+C” and make 
a copy. Please paste and record the table calculation soft or text 
editor. 

Notes 4) If you operate it with quicker tact by the 1s of easy monitor interval, 
trial No. may be skipped value. Please operate it with more than 1 
s of tact command as long as possible. 

Notes 5) Parameter set on this screen is inputted into Driver. As PANATERM 
does not maintain this value, please perform the recording it to 
EEPROM of driver after completion of adjustment. 

Notes 6) The gain tuning screen cannot open during opening some screens. 
For more information please refer to page 267 “Gain tuning screen 
behavior”. 
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Wave form graphic screen 
You can measure the motor operative waveform and display the 
results by the graphic. And these measurement conditions, results 
and parameters can be recorded in the wave form data file. 

 
Open the Wave form graphic window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Wave Graphic” of the tool bar on the main screen. 
3 The Wave form graphic window is opened. 
 
<When sampling cycle expansion is not supported (MINAS-A5 series etc.)> 
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<When sampling cycle expansion is supported (MINAS-A6SF series etc.)> 

 
 
Close the Wave form graphic window 

Click        (Exit) on the tool bar. 
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Structure of Wave form graphic screen 

 

 
 
(1) Title bar 
You can operate title bar window. 

(2) Tool bar 
The operation commands are listed up. 

 (Read) 
Read the file to record the measurement data. 
When this button is effective, a file can be specified 
by drag and drop. 

 (Save) Save the measurement data into the file 

 (Comment) Make the comments to be attached on the wave 
form graphic file. 

 (Print) Print out the results of wave form graphic 
measurement 

 
(Copy to 

reference) 
Make a copy of observed wave form to reference 
wave form 

 
(Delete the 

reference) 
Delete the reference wave form 

 (Close) Close the wave form graphic window 

(1) Title bar 

(4) Waveform 
graphic setting 
area 

(2) Tool bar 

(3) Waveform 
graphic display 
area 
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 (Measurement) 

Start the measurement of wave form graphic. 
Wait until the measurement conditions are met, and 
then execute a series of operations to acquire and 
display the measurement results from the driver. 

 (Stop) Stop the wave form graphic measurement 

 (Screen) Capture the screen and record the file 

 (Trigger set) Set the measurement conditions to driver and start 
measurement 

 
(Trigger 

acquisition) 
Acquire and display the measurement conditions 
set in the driver 

 
(Wave data 

acquisition) 
The measurement results and the measurement 
conditions are acquired and displayed from driver 

(3) Waveform graphic display area 
In accordance with setting contents on (4) Wave form graphic 
operation setting area, the operation wave form of the 
measurement subject is displayed. 

(4) Waveform graphic setting area 
Designate the graphic display conditions and select the tab and set 
each items. 
If you click the upper right  of waveform graphic setting area, 
the wave form graphic setting area shall be hided. If you click , 
wave graphic setting area shall be displayed again. You can record 
these measurement conditions in the file. 
Note) Please refer to the “Record and loading of wave form graphic 

measurement conditions” about the record method. 
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Operation of the wave form graphic display area 
In the wave form graphic display area, you can enlarge or scale 
down the graphic display with following pointed out mouse pointer 
and horizontal / vertical slider bar. 

 
(1) In case you use mouth pointer 
Use the mouse pointer when you enlarge or scale down overall 
wave form. 
 

If you select the tab of “Measurement item” ”Vertical 
axis / Horizontal axis” ”Format”, Mouse pointer is a 
reading glass icon. At that time, following operation is 
effective. 
 
Left click : enlarge the position of mouth pointer 
Right click : scale down the position of mouth pointer 
Drag  : enlarge the selected rectangle scope 
 
When you select tab of “Cursor”, Mouse pointer is Star 
icon. At that time, the following operation is effective. 
 
Left click : designate the position of cursor 1 
Right click : designate the position of cursor 2 
Drag  : enlarge the selected rectangle scope 
 
When mouth pointer is near cursor, it shall be arrow 
icon. At that time, the following operation is effective. 
 
Drag  : move the nearby cursor 
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(2) In case that you use slider bar 
By operation of the slider bar on wave graphic display area right 
edge (vertical axis), you can enlarge, scale down, move only the 
selected operation wave form subjects by tab. 
 
Vertical axis “Pos” Slider bar:  

If you drag the bar upright, operated subject wave form 
display is moving up, if you drag it down, the wave form 
is also moving down. And if you click the bar up and 
down, or if you push the key  [↑] [↓] on the selected 
conditions of slider bar, the wave form is moving by one 
scale on vertical axis 

Vertical axis “Mgnf” Slider bar:  
If you drag the bar up, you can enlarge the operation 
subject vertical axis on the center of the screen. If you 
drag it down, it is to scale down. 

 
If you operate the low edge (horizontal axis) slider bar, you can 
enlarge / scale down / move the time axis of total wave form. 
 
Horizontal axis “Pos” Slider bar:  

If you drag the bar to the right side, the overall wave 
form is moving to the left, the wave form is moving to 
the right. If you click the left right of the bar or push the 
key [←] [→] in the selected slider bar condition, you can 
move the wave form left right by 1/32 on the screen. 

Horizontal axis “Mgnf” Slider bar:  
If you drag the bar to the right, you can enlarge the 
operation subject horizontal axis on the middle of the 
screen. If you drag it to the left, it shall be scaled down. 

 
Notes 1) If you cannot find the wave form, it cannot be displayed so well, 

please push the “Auto range” button of “Vertical axis / Horizontal 
axis” tab and bring back to the overall display. 

Notes 2) When you confirm the detail data of signal size 32 bits, once you 
display the overall wave form and move the part you want to 
watch to the middle of the screen with position slider. 
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Wave form graphic setting area 
 
<Measurement Item Tab> 
Designate the measurement item, trigger conditions, sampling cycle. 
 

 
 

“Collective” 
1. Setting button:  

The measurement condition is set from the wave form 
graphic file registered in button. 

2. Register:  
When you check “Register” and push the button that 
registers, selection of the file window is displayed. Please 
select the file where the measurement condition that you 
want to register is included.  

3. Default:  
The content of each setting button is read from the 
following files. 

Position cont. : Measure the signal related to position control as 
position command speed trigger. 

Settling time : Measure a signal related to the measurement of 
settling time as a trigger of position command passing 
completion. 

Velocity cont. : Measure a signal related to the speed control as a 
trigger of the speed control command. 

All I/O : Measure the analog input and physical input / output 
signal without trigger 

4. 5. 6. 

7. 8. 9. 10. 11. 12. 

1. 

2. 3. 
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“Trigger condition” 

4. Measurement item:  
You can measure the subject that you want to measure in 
your choice. If you double click the measurement items, 
you can open the window of the “Measure Item Select”. 
You can select the signal size up to total 64[BIT].( In 
MINAS-A6 series, you can select the signal size up to total 
128[BIT]. Digital signal can be selected up to 16[BIT]) 
If you select the digital signal on the measurement items, 
analog signal and digital signal shall be displayed on the 
wave form graphic display area. 

 

 
 

5. Trigger Item:  
Perform the setting related to the trigger. 

Trig. Position - Set the trigger happening position during the measured 
period. 

Single trigger - When single trigger is on, the measurement can be 
performed only one time. If it is “Off”, until you click 
“Stop” button, we will continuously perform the 
measurement. 

Trig. Condition - Set the trigger conditions.  
Data average - Set the enable / disable of the data averaging function 

during the measurement. 
* Data average can be set only when sampling cycle expansion is 

supported. 
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6. Sampling: Set the sampling cycle. (When sampling cycle 

expansion is supported, the sampling setting 
method changes from the slider method, enabling 
the setting of a longer sampling cycle.) 

7. Sub: You can set the trigger conditions to 2 kinds (A / B). 
8. Trig. Object:  

Set the trigger subjects. You can select one of the analog 
signal or digital signal. 

9. Filter:  
Set the filter the number of the time for the subjected 
number of the times signal. Depending on the trigger 
subjects, there are the items that you cannot set. If you 
cannot set the filter, “---” is displayed. 

10. Trig. Level:  
Set the level of the trigger. If the trigger subject is analog 
signal, it is displayed by figures. If it is digital signal, it sets 
ON / OFF. 

11. Unit: Display the trigger subjected unit to be selected. 
12. Slope:  

Set the slope to be triggered. You can select it from 
“Leading”, “Trailing”, “Matched”, “Mismatched”, “Greater”, 
“Less”. 

* If you use digital signal for trigger subject, slope setting is “Matched” 
or “Mismatched”. 
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<Vertical axis / Horizontal axis Tab> 
Designate the wave form graphic conditions 
 

 
 

“Operation object” 
You can select the operation subject to be designated position 
and magnification by vertical axis slider bar. You can use 
analogue signal only. 

“Auto range button” 
Adequate value shall be automatically adjusted from all the 
wave form vertical axis position and magnification on the screen 
display. And minimum (display all data) of horizontal 
magnification is set. 

“Initialize vertical axis button” 
All wave form’s vertical magnification is itself and 0 is moving to 
middle of the screen. 

“Prohibit an automatic range check box” 
If you check the mark, Auto range is prohibited at the 
measurement. When measurement conditions are the same, 
the auto range of a horizontal axis is also forbidden. If there is 
no check mark, Auto range shall be performed on the wave 
from each graphic measurement. 
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<Cursor Tab> 
Display cursor and the measured value of cursor 1 and cursor 2. 
 

 
 

“Display cursor” 
When checked, cursor 1 and cursor 2 is displayed. 

"Cursor1" 
The position of cursol1 can be moved. 
You can also specify the position with the left mouse button. 
You can also click the cursor to move it.  

"Cursor2" 
The position of cursol2 can be moved. 
You can also specify the position with the right mouse button. 
You can also click the cursor to move it. 

"Value display" 
The value of the selected measurement item is displayed. 
1. Obsrv/Ref:  

Displays whether the waveform is observation or reference. 
2. Unit:  

The unit of the selected item is displayed. 
3. Cursor 1:  

The value of the selected item at the time of cursor 1 is 
displayed. 

4. Cursor 2:  
The value of the selected item at the time of cursor 2 is 
displayed. 

5. Cursor 1-Cursor 2:  
Displays the difference between the values of cursor 1 and 
cursor 2 of the selected measurement item. 

1. 2. 3. 4. 5. 6. 7. 8. 9. 
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6. Value:  

The effective value of the section from cursor 1 to cursor 2 
of the selected measurement item is displayed. 
If there is no check mark in "Display", the value of all 
sections is displayed. 

7. Max:  
The maximum value of the section from cursor 1 to cursor 
2 of the selected measurement item is displayed. 
If there is no check mark in "Display", the max of all 
sections is displayed. 

8. Min:  
The minimum value of the section from cursor 1 to cursor 2 
of the selected measurement item is displayed. 
If there is no check mark in "Display", the min of all 
sections is displayed. 

9. Error:  
The standard deviation of the section from cursor 1 to 
cursor 2 of the selected measurement item is displayed. 
If there is no check mark in "Display", the error of all 
sections is displayed. 

“Cursor 1 to the trigger position button” 
Cursor 1 sets the trigger position. 
This is displayed when “Display cursor” is checked only. 

“Smoothing” 
The analog signal is smoothing. 
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<Format Tab> 
Set the display format of the measured wave form. 
 

 
 

“Measurement item” 
Selected measurement item is displayed. 
“Obsrv / Ref” 

The type of item is displayed (Observed or Reference). 
“Display” 

Select this item is displayed or is not displayed. 
“Color” 

Set the waveform color of the measurement item. 
Select the color of this item when color cell is double-clicked. 

“Bold” 
Set the thickness of the waveform of the measurement item. 
Select the thickness of this item when color cell is double-
clicked. 

 
Measurement of wave form 
1 Set the wave form graphic setting. 
2 Click        (Measure) of the tool bar. 

When the measurement starts, status of measurement is 
displayed on status bar. 
Notes 1) If “T-set” or “Msr” (Measure) button is once clicked, even if you 

close the  wave form graphic display or exit the PANATERM, the 
driver continues measurement by the trigger condition last set. In 
this case, the measured data which is trigged by the setting is 
acquired by pushed the “W-get” button. But if the driver is yet 
waiting for trigger, displayed communication error dialog box. 

Notes 2) When wave form graphic display is closed, measurement 
condition is saved, and same condition is applied next time. 
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Reference data 
1 After measuring wave form graphic, click        (To Reference) button 

on the tool bar, and observed data is copied to reference data. 
2 Check the “Display” of Reference data from “Format” tab and 

reference data can be displayed on screen. 
Notes 1) The reference data is registered up to 10 sets. If you copy with 

all the reference waveforms filled, reference 10 will be 
overwritten. 

Notes 2) When measurement item is changed, the reference data is 
cleared. 

Notes 3) The time (horizontal) scale of reference data is fixed at the 
condition of measurement. Don’t read the reference data which 
has different time scale from wave file. 
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Save and read the wave graphic data 

 
It is possible to use, and to refer when the parameter setting value 
at the measurement condition, the result of a measurement, and 
that time specified when measuring it is preserved in the file, and 
the measurement is executed again under this condition. 

Wave graphic data file       : ***.wgd5 or ***.wgd6 
Wave graphic condition file     : ***.wgc5 or ***.wgc6 
Wave graphic data and parameter file  : ***.wgp5 or ***.wgp6 

* When sampling cycle expansion is supported, files are saved with 
extensions wgd6, wgc6, and wgp6. 

 
Save to wave graphic data 
1 Click “Save” button from tool bar. 
2 “Save the wave form graphic data” window is displayed. 
 

 
 
3 Select the save item, and click “OK” button. 
4 Comment input window is displayed. 
 

 
 
5 Click “OK” button, and the file dialog is displayed. 
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6 In the file dialog, specify the name of the file that you want to 

save. 
7 Click “Save” button. 
 
Read from wave graphic data 
1 Click “Read” button from tool bar. 
 

 
 
2 Select data file to read. 
3 Click “OK” button. 
4 Window for “Read the wave form graphic data” will appear. 
 

 
 
5 Put checks on the items you would like to read, and click “OK”. 

The saved waveform for measurement result can be read as 
reference, if “Read as a reference wave form” is selected. 
However the measured condition, and parameters cannot be 
read, if this is selected. 

6 Content that was selected will be read. 



Rev 3.25 
－ 99 － 

 
Notes 1) The detail of wave form data is referred the driver operation 

manual or technical reference. 
Notes 2) When sampling cycle is not set minimum value, a part of analog 

signal are smoothing by the driver. 
Notes 3) The aliasing might be caused and an actually different shape of 

waves be seen, when sampling cycle is longer than vibration data. 
Notes 4) The communication error is displayed when the driver power 

supply is off while wave form graphic is measuring. Please close 
wave form graphic display. 

Notes 5) The wave form graphic function is not precious measurement 
instrument. The wave form graphic data shall be used as rough 
estimate. 

Notes 6) “Mes. time” (Measure time) display is the time of receive the wave 
form data from the driver. Note that the time is not the time of 
trigger time. 

Notes 7) The wave form graphic screen cannot open during opening some 
screens. For more information please refer to page 269 “Wave 
form graphic screen behavior”. 

Notes 8) In the case of network type (MINAS-A5N, MINAS-A5NL, etc.), if a 
network is established in the state of trigger standby, the detected 
trigger position may shift. 
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Trial run screen 
Motor can be operated as test only with the Drive, and without 
connecting to the master level equipment. 

 
Note) Parameter settings and Driver’s gain tuning will be needed even at the 

trial run. Please read the operation manual or technical reference to 
understand the manual content prior to this operation. 
Trial run cannot be performed through RS232 communication. 

 
Open the Trial Run window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Trial Run” of the tool bar on the main screen. 
3 The Trial Run window is opened. 
 

 
 
Close the Trial Run window 

Click “Close” button on the window. 
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Structure of Trial Run screen 

 
Operation Area Setting window 
 

 
 
 
Test Operation window (Standard type) 
 

 
 
Test Operation window (Shrink type) 

 

(5) Operation 
button 

(2) Related 
parameter 

(3) Operation 
area setting 
panel  

(4) Motor 
position data 

(1) Title bar 

(7) Test 
operation 
panel  

(6) How to operation area 

(7) Test 
operation 
panel  

(5) Operation 
button 
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(1) Title bar 
Window can be operated. 

(2) Related parameter 
Speed and Acceleration/Deceleration time can be operated at the 
Operation area settings window. Speed, Acceleration/Deceleration 
time, moving length, waiting time properties of JOG/STEP/ZERO 
can be set. 

Notes 1) These parameters will be in PANATERM’s default setting, when 
the Operation Area Setting window is opened. But these will be 
set the value before opening a Trial run, when the Test Operation 
window is opened. 

Notes 2) Change of setting value will be reflected to the drive at the start 
of test operation. 

Notes 3) Protection function setting will return back to the value before 
opening the window, when the Operation Area Setting window or 
the Test operation window is closed. 

(3) Operation area setting panel 
Test operation can be done with the button below 

 
Auto-set 
(Over-speed 
level setup) 

If a check is put in, over-speed level will be 
changed the twice of JOG speed. 

 
Servo On / 
Immediate 
stop 

Turn on the servo feature of motor. 

 
Servo Off Turn off the servo feature of motor. 

Note) Servo feature can be turned off by the 
ESC key when the window is active. 

 
JOG 
 Positive(+) 

JOG operation can be done to the plus 
direction when JOG Positive (+) is pressed, 
and minus direction when the JOG Negative 
(-) is pressed with the speed on setting. 

 

JOG 
 Negative(-) 

(4) Motor position information area 
MAX  : Maximum operation area 
MOTOR : Current position 
MIN  : Minimum operation area 
Note)  Current position of the motor is the value in command unit 

with the position when the Servo On as 0. 
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(5) Operation button 

Close : Close operation area configuration or test 
operation feature. 

Skip : Test operate without operation area being 
configured. 

Go Trial Run : Test operate based on configuration. 
Back : Stop test operation, and return to operation area 

configuration. Test operation window. 

(6) How to operation area 
This area displays the explanation of the operation method. 

(7) Test Operation panel 
Test operation can be done with the button below 

/ 

 

Change to 
shrink type / 
Change to 
standard type 

A test run screen is changed from standard 
type to shrink type. 
Or it is changed from shrink type to 
standard type. 

 
Servo On / 
Immediate stop 

Servo function will be turned on. When 
motor is in “Servo On” condition, this button 
will enable an immediate stop or continuous 
operation. 

 Servo off 
Servo function will be turned off. When 
window is active the Servo function will be 
turned off when ESC key is pressed. 

 
JOG 
 Positive(+) 

When check is not on “JOG Cont”, then 
JOG operation will be active when button is 
pressed, and will be inactive when button is 
not pressed. 
 
If check is on the “JOG Cont” button, then 
JOG operation will continue until operation 
area becomes Max/Min. when button is 
pressed once. 
When “Servo On/Stop” is pressed, then 
motor will immediately stop without time to 
descend the speed. 
When “Pause” is pressed, then motor will 
stop after descending the speed. Time to 
descend the speed until stopping the 
rotation will vary depending on time 

 
JOG 
 Negative(-) 
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needed. 
Note) If you would like to cancel the JOG 

continuous operation, then “Pause” 
the motor, and then press “Servo 
On/Stop” button. 

/
 

PAUSE 
Motor will pause and continue the 
operation. 

 
ZERO 

Motor will Step operate until the 0 position. 

 
STEP 
 Positive(+) 

If check is not in the “STEP Cont” 
checkbox; Step operation will continue 
when for the configured operation distance 
when the button is pressed. 
Motor will immediately stop without speed 
deceleration time, when the “Servo 
On/Stop” button is clicked during rotation. 
Motor will pause after speed deceleration 
when “PAUSE” button is clicked. When 
“PAUSE” button is clicked again, then motor 
will operate towards the targeted position 
set before pausing. 
 
When check is on the “STEP Cont” 
checkbox ; 
When the button is clicked once, then the 
motor will operate the “Step operation” for 
the configured distance to the designated 
direction, and then operate for same 
distance to the opposite direction, which will 
continue this back and forth operation. 
 
When “Servo On/Stop” button is clicked 
during this continuous operation, the motor 
will stop without deceleration time, and 
cancel the continuous operation. 
 
When “PAUSE” button is clicked during the 
same continuous operation, then the motor 
will pause and will continue on with the 
operation when the button is clicked again. 
 
Note) Push “Servo On/Stop” button after 

“PAUSE” button and STEP continuous 
operation can be canceled. 

 
STEP 
 Negative(-) 
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Maneuvering Test operation 
1 Click “Servo Off” on test operation panel at Operation area 

settings window, and then click “Servo ON” (STEP 1) If there are 
alarms or errors occurring at this step, eliminate the cause, clear 
the alarm, and then re - start from step 1. 

2 Configure the parameter on the Parameter area. Then operate 
the motor by the JOG operation button on the test operation 
panel with confirming the motor operation. 
Configure the Max / Min. of motor operation area. (STEP 2) 

3 After completion of motor operation area, click the “Next” button 
to proceed to the test operation window. 

4 Operate the motor using the buttons on the test operation panel 
on the test operation window. 
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Notes 1) If warning or error occurs when the trial run window is open, then 

the communication error will appear on screen. After removing the 
cause, clear the alarm, and then restart the test run. Also, if a 
servo-on signal is input from the outside, a communication error 
will be displayed. 

Notes 2) When open the trial run window, the parameter of protection 
function setting changes into a default value. When close the trial 
run window, it returns to the value before it opens. Therefore, 
please note that the argument value changed on trial run screen 
might be displayed when the parameter is written from other 
screens while the trial running.  
Moreover, the parameter changed on the trial run screen is not 
preserved.  

Notes 3) When “Go Trial Run” button is clicked without the operation area 
configured, and then the error will appear on screen. Please 
configure the operation area going by what specified above. 

Notes 4) Please be noted that the configured operation area will be 
canceled, and there will be no limit to the operation area during the 
test operation. 

Notes 5) Operation area will be cleared when “Servo OFF” is clicked. 
Notes 6) When “Close” button is clicked when the Servo is ON, then the 

Drive Servo will be turned OFF, and test operation will be stopped. 
Notes 7) When “Servo OFF” or “Back” is clicked, then the Drive Servo will 

be turned OFF, and operation area will be cleared. 
Notes 8) The trial run screen cannot open during opening some screens. 

For more information please refer to page 270 “Trial run screen 
behavior”. 

Notes 9) When drive is not in ready status (Alarm or Main power source is 
cut off), front panel is used except for monitor mode, or Servo ON 
is input from outside, then the trial run window will not be able to 
open or error will be on screen during execution. Please re - 
execute after these status is eliminated, and the trial run window is 
closed. 



Rev 3.25 
－ 107 － 

 
Frequency characteristics screen 
Measures the wavelength characteristics including the load, and 
shows the result in bode plot Mechanical resonance point or 
response time can be measured. In addition, the measured result 
can be saved as file. 

 
Note) Please check with the operation manual or the specification document. 

Please execute the measurement in the condition that servo-off can be 
made anytime as a precaution. 
This function should not be used in the case that blistering movement 
of a motor may break the machine. 
Please execute the measurement in the condition of as low gain as 
possible. 
Please note that large setting of offset value may cause exceeding 
movement limitation. 

 
Open the Frequency characteristics window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Frequency Response” of the tool bar on the main 

screen. 
3 The Frequency characteristics window is opened.  

(The figure of the next page) 
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Close the Frequency characteristics window 

Click        (Exit) on the tool bar. 
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Structure of Frequency characteristic screen 

 

 
 
(1) Title bar 
You can operate this window. 

(2) Tool bar 
Operation command such as Frequency characteristics 
measurement is on this bar. 

 
(Read) Read frequency characteristics data. 

When this button is effective, a file can be specified 
by drag and drop. 

 
(Save) Saves the frequency characteristics data. 

 
(Comment) Write comments to the Frequency characteristics file. 

 
(Print) Print Bode plot. 

 
(Copy) Copy measured wavelength to referenced 

wavelength. 

 
(Reference) Turn ON/OFF screen of reference wavelength. 

 
(Exit) Close Frequency characteristics window. 

(1) Title bar 
(2) Tool bar 

(3)Content 
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(Measure) Measure Frequency characteristics. 

 
(Analysis) Analyze frequency characteristics. This cannot be 

used when using RS232 communication. 

 
(Screen) Capture screen and save as file. 

(3) Content area 
Graph option 
Configure items related to graph appearance or operation 
 

Smoothing Configure level of smoothing 

Cursor Switch appearance/disappear of cursor on screen. 
The cursor moves to the position you clicked with 
the mouse. 

Cut off frequency Shows frequency[Hz] which will enable Gain  - 3db. 

Measurement mode Configure measurement mode. 

Speed Close Measure frequency response from Speed input to 
motor speed. 

Torque Normal Measure frequency response from Torque input to 
Motor speed. 

Torque Vertical Measure frequency response from Torque input to 
Motor speed. This function is used in loads that are 
asymmetric such as in vertical angle. 

(In MINAS-A6 series, you can measurement the Position loop operation.) 
 
Vertical axis slider 
Change position, and magnification of vertical axis of bode plot. 
 
Horizontal axis slider 
Change position, and magnification of horizontal axis of bode plot. 
 
Bode plot 
Creates bode plot of measured Frequency characteristics data. 
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Measurement of Frequency characteristics 
1 Click “Measure” on Frequency characteristics window, and then 

measurement window will open. 
 
<When standard type (MINAS-A5 etc.) is connected> 

 
 
 
 
<When network type (MINAS-A5N etc.) is connected> 

 
 
 
 
2 Please confirm the content that is on the (1) notification area. 

(3)Operation 
button 

(1)Notification 
area 

(2)Input field for measurement condition 

(3)Operation 
button 

(1)Notification 
area 

(2)Input field for measurement condition 
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3 Specify (2) Measurement condition. 

“Variation” The amplitude of noise waveform applied to the 
velocity command or the torque command is set 
when measurement of frequency characteristics.  

* When measurement mode is at “Speed Close” sum of 
variation, and offset will be limited to 5,000r/min. When 
the measurement mode is “Torque Normal” or “Torque 
Vertical”, it is limited to a range that does not exceed 
100%. 

* When variation is increased the measurement will 
increase, however torque will be saturation, and torque 
precision will decrease. Please start with small values and 
increase with steps accordingly to the measurement result. 

 
“Offset” The offset of noise waveform applied to the velocity 

command or the torque command is set when 
measurement of frequency characteristics.  

* Sum of variation and offset will be limited to 5,000r/min. 
When measurement mode is in Torque – Speed, then 
setting is not possible. 

* Motor will operate with offset being the average speed 
command during the measurement. Polarity of “+” is CW, 
and “-” is CCW. A good measurement result can be taken 
if the motor is rotating into one direction, while the offset is 
configured over the value of variation. However, please be 
careful when the “Rotation” is narrow, because the 
rotation may exceed the “Rotation”. Rotation of motor can 
be calculated by the below formula. Please confirm that 
the “Rotation” will not be exceeded before starting the 
measurement. 

Rotation [r] = Offset [r/min] x 0.017 x (Sampling rate +1) 

“Sampling rate” Can be configured to values from 0 to 7 
* When sampling rate is large, then the measurement 

precision of low frequency will increase, however the 
measurement time will be longer. If small, then 
measurement precision of high frequency will increase. 
Please start from “0”, and adjust accordingly to the 
measurement result. 

* When sampling rate is over 1, then the aliasing may occur. 
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“Auto servo on” The driver does servo-on by automatic operation 

when measurement of frequency characteristics 
when “Auto servo on” is checked. 

* In the case of standard type, please do not check it when 
servo-on by an external input.  
In the case of network type, please do not check it when 
brake release operation is being performed by host device. 

* In the case of standard type, if close the measurement 
window, clear setting. 

 
4 When the “Servo on” of (3) operation button is invalid, or when 

not displayed, please move on to the next. 
When the “Servo on” is valid, please click on “Servo on”. Caution 
windows will appear. Confirm the window message carefully, and 
click “Execute”. To cancel, click “Cancel”. 

 

 
 

“Execute” of (3) operation button becomes effective after servo-
on. 

 
Please apply brakes by host device after servo-on. 
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5 Click on “Execute” on the (3) operation button, and notification 

window at resonance measure will appear. Confirm the window 
message carefully, and click “Execute”. 

 

 
 
6 Caution windows will appear. 

To turn on the servo by external input, turn on the servo. 
Click “Execute” after servo-on, and the measurement will start. 
To cancel, click “Cancel”. 
 
Note) If you want to cancel while the measurement is in progress, 

click the “Stop” operation button in (3). 
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7 A measurement window closes automatically after the completion 

of measurement. Please click “Servo off”, when you do not close. 
Please apply brakes by host device before servo-off. 
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Analysis of frequency characteristics 
1 Gain automatic adjustment window will open, when “Analysis” 

button of Frequency characteristics window is clicked. 
* This function cannot be used with the MINAS-A6 series. 
* Analysis can be done when communication with drive is connected, and 

after measurement is done at measurement mode “Torque Speed”. 
(Standard analysis cannot be done when communication is not 
connected) 

 

 
 
2 Configure number of notch filter that will be used at analysis 

option. 
3 Configure Inertia ratio. If inertia ratio is to be automatically 

assumed from the result of frequency characteristics 
measurement, then put the check on the automatic adjustment 
checkbox. 
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4 After “Execute” button is clicked, recommended control parameter 

will appear on the analysis result, and resonance & anti - 
resonance frequency and it’s opposite will appear on the bode 
plot frequency characteristics. (Yellow : Resonance, Green : Anti - 
resonance) 

 

 
 
5 Close “Cancel” to close the Gain automatic adjustment window 

from the frequency characteristics. 



Rev 3.25 
－ 118 － 

 
Save or reading frequency characteristics data 

 
Measurement condition, result and parameter values at the time of 
measurement can be saved as file, and used again to measure with 
same condition, or read for reference. 
 

Frequency characteristics measurement result file     : ***.fcd5 
Frequency characteristics measurement condition file    : ***.fcc5 
Frequency characteristics measurement result & parameter file : ***.fcp5 

 
Saving frequency characteristics data 
1 Click “Save” in toolbar. 
2 Saving frequency characteristics data window will appear. 
 

 
 
3 Select items to save, and click “OK”. 
4 Comment window will appear. Below graphic shows the window 

when selecting “measurement condition”. 
 

 
 
5 Click “OK”, and file dialogue will appear. 
6 Input the file name to save, in this file dialogue 
7 Click “Save”. 



Rev 3.25 
－ 119 － 

 
Reading Frequency characteristics data 
1 Click “Read” on the toolbar. 
 

 
 
2 Select file name to read. 
3 Click “OK” 
4 Frequency characteristics read window will appear. 
 

 
 
5 Select the content to read, and click “OK” 

When check is put on “Read as reference data” you can read the 
saved measurement result as reference data. However, when the 
data is read as reference, the parameters will not be read. Also, 
data that are not once saved will not be read. 

6 Content with check put on will be read. 
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Notes 1) For caution please execute measurement with condition where 

Servo can be turned on immediately. 
Notes 2) Please measure the resonance of the machine, with the gain 

brought down to the minimum. (Lower the value of "position loop 
gain" and "velocity loop gain”. And raise the value of "velocity loop 
integration time constant") 

Notes 3) Gain will be fixed to “1” at Frequency characteristics measurement. 
Notes 4) The frequency characteristics screen cannot open during opening 

some screens. For more information please refer to page 272 
“Frequency characteristics screen behavior”. 

Notes 5) Result of frequency characteristics measurement can vary or show 
a mistaken value depending on characteristics of the equipment or 
measuring condition. Please take the analysis result of this feature 
as reference of gain adjustment. 
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Pin assign setting screen 
Assignment of input/output pin can be configured. 

 
Open the Pin assign setting window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Pin Assign” of the tool bar on the main screen. 
3 When not communicating with driver, the selection screen of a 

parameter is displayed. Please choose the parameter file to edit. 
4 The Pin assign setting window is opened. 
 
<When communication with driver> 

 
 

“Apply”  : Sends pin assign setting to the driver. 
“Close”  : Close the pin assign setting window. 
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<When not communication with driver> 

 
 

“Save”  : Writes pin assign setting to the parameter files (.prm5). 
“Close”  : Close the pin assign setting window. 
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Configurations of pin assign setting 
1 Double click the row of pin number to configure 
2 Function select windows will appear 

 
<Input Signal> 

 
 
<Output Signal> 
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3 Select the assigning function to pin for each control mode, and 

connection method (When only input function is selected). 
4 When “OK” is clicked at function selection window, window will go 

back to pin assign setting window. 
5 When communication with driver, click on to “Apply”, and a 

screen to confirm prior to writing the drive will appear. Click “OK”, 
and parameters will be written onto the EEPROM of Drive. If 
“Cancel” is clicked, then the parameter will not be written on the 
Drive’s EEPROM. 

 

 
 

Reboot the drive, and activate the new settings. 
 

 
 
6 When not communication with driver, click on to “Save”, and a 

comment screen will appear. 
 

 
 

A click of "OK" will display a file dialog. Please save to a file. 
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Notes 1) The pin assign setting screen can be operated when all other 
windows are closed. For more information please refer to page 273 
“Pin assign setting screen behavior”. 

Notes 2) Configuration of connection is needed for input signal. Please also 
unify a point of contact, when you assign the same signal to two or 
more control modes. For details of signal, please review the drive’s 
operation manual or technical reference. 

Notes 3) A single input signal cannot be assigned to multiple pins. Output 
signal can be set to multiple pins. Moreover, when you assign the 
same signal to two or more control modes, please assign to the 
same pin. 

Notes 4) New pin assign configuration will not be active unless the drive is 
rebooted. 

Notes 5) An error message is displayed when a setup which cannot be 
assigned is performed. Please change a setup according to 
directions of a screen. Please read the operation manual of driver 
or technical reference about the details of a setup which cannot be 
assigned. 
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Trouble shooting screen 
Elements causing motor not to rotate or drive’s lifetime can be 
indicated this screen. 

 
Note) Trouble shooting cannot be performed through RS232 communication. 
 
Open the Trouble shooting window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Trouble shooting” on the tool bar of the main 

screen. 
3 When not communicating with driver, the selection screen of a 

parameter is displayed. Please select the parameter file. 
4 The Trouble shooting window is opened. 
 
<When communication with driver> 

 



Rev 3.25 
－ 127 － 

 
<When not communication with driver> 

 
 
Close the Trouble shooting window 

Click        (Exit) on the tool bar. 
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Structure of trouble shooting window 

 
Turn error cause display 
This is displayed when communication with driver only. 

 
Life Assessment display 

 
Communication error 
This is displayed when communication with driver only. 

(1) Title bar  
(2) Tool bar 

(4) Content 
area 

(4) Content 
area 

(3) Tab 
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(4) Content 
area 
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(1) Title bar 
Window operation can be done 

(2) Tool bar 

/  
Stop/Restart Stop/Restart update of trouble shooting window. 

 
Exit Close trouble shooting window. 

 
Information The relevant page of the operating instructions for 

driver. (Only MINAS-A5 is supported) 

 
Screen Capture screen and save as file. 

(3) Tab 
Switch to “Turn error cause”, “Life Assessment”, or “Communication 
error”. 

(4) Content area 
“Turn error cause” 
Indicates element is being obstacle to rotation. 
* There will be cases where “0” (No element) is indicated even with the 

motor rotating. 
 
“Life Assessment” 
Indicates element is lifetime evaluation. 
The judged result will appear on the status as colored depending on 
the judged lifetime. 

Green : Drive to be within standard operation. 
Yellow : Drive is close to replacement 
Red  : Drive suggested for replacement 
White : Judged level is out of configured range 

 
* Accuracy of evaluated lifetime’s accuracy may be lowered when in 

application with control electricity being shutdown frequently, because the 
lifetime information is saved in 30 minute cycle. Drive may operate 
standardly even if the status is red. Please refer to this result as reference. 

 
“Communication error” 
Indicates element is RTEX communication error counter information. 
* Communication error tab is displayed during communicating with network 

type driver (MINAS-A6NF etc.) corresponding the RTEX communication 
error counter monitoring function.  
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Notes 1) The trouble shooting screen cannot open during opening some 

screens. For more information please refer to page 273 “Trouble 
shooting screen behavior”. 
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Analogue input adjustment screen 
Offset of analogue input signal can be automatically adjusted. 
Settings of filter or over voltage can be manually adjusted. 

 
Note) Analogue input adjustment cannot be performed through RS232 

communication. 
 
Open the Analogue Input Adjustment window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Analogue input” of the tool bar on the main 

screen. 
3 The Analog Input Adjustment window is opened. 
 

 
 
Close the Analogue Input Adjustment window 

Click        (Exit) on the tool bar. 
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Structure of Analog input adjustment 

 

 
 
(1) Title bar 
Windows can be operated. 

(2) Tool bar 

 
Exit Close analogue input adjustment window 

 
Screen Capture window, and save as file. 

(3) Tab 
Switch Analogue input signal 

(4) Analog input adjustment area 
“Automatic adjust” 
Automatic measurement of offset and setting of analogue input 
can be done by clicking. 
“Parameter” 
Configured parameter will be indicated. Setting value can be 
directly changed. 
* Parameter change will be cancelled when tab is switched without 

“Trans” button is clicked being pressed. 

“Trans” 
Write the indicated parameter into the drive’s EEPROM. 

(1) Title bar 
(2) Toolbar 

(3) 
 

(4) Analog input 
adjustment 
area 
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Notes 1) The analog input adjustment screen cannot open during opening 

some screens. For more information please refer to page 274 
“Analogue input adjustment screen behavior”. 
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Z phase search screen 
Will turn the Servo On automatically without input, and rotate 
motor to reach the point where Z phase output will turn on. 

 
Note) Please make sure that the notification and implementation area written 

on the drive’s operation manual or technical reference before using 
this feature. 
It is very dangerous when connecting the motor to load with Servo 
being ON after Z phase search, because of the drastic change of 
inertia ratio may occur making the motor to have resonance. Please 
make sure that the Servo is turned OFF. Also, have the main power 
turned off, or have motor wire pulled off, to disable the motor’s ability 
to rotate, and then conduct the operation.  
Z phase search cannot be performed through RS232 communication. 

 
Open the Z phase search window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Z phase search” of the tool bar on the main 

screen. 
3 The Z phase search window is opened. 

* Z phase search window cannot be used when Trial run window is opened, 
front panel is used, or Servo is turned ON by input from outside. Close 
the trial run function and front panel is free before using the Z phase 
search window. 
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Close the Z phase search window 

Click “Close” on the Z phase search window. 
 
Procedure for Z phase search 
1 Click “Servo ON”. 
2 Click “Z phase search”. 
3 Motor will rotate in CCW direction towards Z phase at 60 r/min 

speed. 
 

 
 
Notes 1) For caution, please have the motor ready for power shutdown 

when conducting the above. 
Notes 2) The Z phase search screen cannot open during opening some 

screens. For more information please refer to page 275 “Z phase 
search screen behavior”. 

Notes 3) When drive is not in ready status (Alarm or Main power source is 
cut off), front panel is used except for monitor mode, or Servo ON 
is input from outside, then the Z phase search window will not be 
able to open or error will be on screen during execution. Please re - 
execute after these status is eliminated, and the Z phase search 
window is closed. 



Rev 3.25 
－ 137 － 

 
Setup Wizard 
Please follow the instruction of the screen.  
So a minimum parameter necessary for driver’s operation can be 
set.  

 
Note) The setup wizard cannot be performed through RS232 communication. 
 
Open the Setup Wizard window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Setup Wizard” of the toolbar on the main screen. 
3 The Setup Wizard window is opened. 

* The Setup Wizard window cannot be used when Servo is turned ON by 
input from outside. 

 

 
 
Close Setup Wizard window 

Click       of upright on the window. 
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Structure of Setup Wizard Screen 

 

 
 
(1) Title bar 

The origins of reference of parameters reference are displayed. 
Present control mode is displayed when communication with the 
driver. 
And you can operate Window. 

(2) Step list 
The position seen from the whole of a present step is displayed.  

(3) Message 
An easy explanation of the content set in a present step is 
displayed. 

(4) Function setting area 
Each function is set.  

(5) Step move 
Switch to present step.  

“Back” The previous step is displayed. 
“Next” The next step is displayed.  
“Interrupt” Drive reset is interrupted, and close the setup wizard. 
“Finish” Close the setup wizard.  

(1) Title bar 
(2) Step 
list (3) Message 

(4) Function 
setting area 

(5) Step move 
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Setting method of Setup Wizard 
1 Select the origins of reference of parameters, and click “Next” 

button. 
* When read from the default setting, the setting result is cleared.  

When start from present parameter, please select “Read from the 
driver” or “Read from the file”.  

2 You set the functions according to usage. And please click “Next” 
button.  
The setting method has the following pattern. 

 

 

1.  Select 2 – 4 panel:  
You can select a radio 
button or image click.  

 

2.  Combo box:  
You can choose only 
one of the items.  

1. 

2. 
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3.  Check box:  
You can switch the 
setting to check it. 

 

4.  Input value (cell):  
Please move to the 
next cell after input. 
The setting will be 
saved. 

 

5.  Input value (single):  
For keyboard input, 
please press [Enter] 
key to determine the 
setting value. If in the 
“Select 2-4 panel”, 
please enter after 
selecting the panel. 

3. 

4. 

5. 
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6.  Check:  
This is the check item 
of setting contents. 
Please reference 
configuration. 
 

7.  Online check:  
This is the check item 
of setting contents. 
This is displayed when 
communication with 
the driver. 
Please reference 
configuration. 

 
* Step of the setup wizard displays the results change depending on the 

previous setting steps. 
* When you change a parameter is valid after, may be inserted “Drive 

reset” into the step list. Please follow the instructions on the screen. 
 

 

7. 6. 
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3 Please save your settings before you exit the setup. 

If you do not communicate with the driver writes to a parameter 
file. (The extension is “.prm5”). 
If you communicate with the driver writes to EEPROM in the 
driver. 

 

 
 
4 Please select a gain tuning method and click “Finish” button. 
 

 
 
5 Setup wizard screen is closed, according to the result of the 

selection screen is displayed. 
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Notes 1) Your first step “Read from the driver” or “Read from the file” if you 

select, you may not work according to the configured of the wizard 
by the other parameters. 

(Example) 
· Selection input of internal command speed was changed to a 

different function by the pin assign setting 
· Electronic gear switching function is valid and 1st numerator of 

electronic gear 
· Etc. 

Notes 2) The changes in the setup wizard will be reflected in the parameters 
at any time. To return to the state before starting the setup wizard, 
the driver without writing to EEPROM in the driver please does the 
power reset. 

Notes 3) The online check item in the function setting area is displayed when 
communication with the driver. 

Notes 4) Parameter set on this screen is inputted into the driver. PANATERM 
does not maintain this value, please perform the recording it to 
EEPROM of driver after completion of setting. 

Notes 5) The setup wizard screen cannot open during opening some 
screens. For more information please refer to page 275 “Setup 
wizard behavior”. 
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Fit gain screen (Standard) 
Explore the best gain settings automatically by repeating the 
positioning between two points. 

 
Note) The fit gain function is rigidity and mode at real-time auto-gain tuning 

may oscillate for a short time in the course of raising the load. May be 
suppressed by the adaptive filter and auto-oscillation detection, just in 
case, on ensuring the safety of the operating range, please execute in 
the condition that servo-off can be made anytime as a precaution. 
Please refer to application scope and remarks specified in the driver 
manual or technical reference. 
The fit gain cannot be performed through RS232 communication.  
In addition, the fit gain function is disabled for some special motors. 
For details, please contact the consultation desk. 

 
Open the Fit gain window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Fit gain” of the tool bar on the main screen. 
3 The Fit gain window is opened. (The figure of the next page) 
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* If the log on of fit gain window is opened, please select “Standard 
position control”. 

* The fit gain window cannot be used when velocity control mode and 
torque control mode. 

 
Close the Fit gain window 

Click       of upright on the window. 
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Structure of Fit gain Screen 

 

 
 
(1) Title bar 

You can operate window. 

(2) Step list 
The position seen from the whole of a present step is displayed.  

(3) Message 
An easy explanation of the content set in a present step is 
displayed. 

(4) Fit gain setting area 
You can set from step 1 to step 4. 

(5) Search map 
A combination of rigidity and mode is displayed. 
Each cell is displayed in a number of actual trials. 
In addition, background color changes the meaning. 

White: Explore Silver: Unexplored Gray: Excluded 
Lime: Completion Red: Vibration detection Fuchsia: Failed 

(6) Step move 
Switch to present step.  

“Back” The previous step is displayed. 
“Next” The next step is displayed.  
“Finish” Close the fit gain window.  

(1) Title bar 
(2) Step list 
(3) Message 

(4) Fit gain 
setting area 

(5) Search map 

(6) Step move 
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Applicable condition of fit gain 

The fit gain must satisfy following conditions in order to execute. 
· Real-time auto-tuning can be applied to the load and driving pattern. 

(The velocity more than 100[r/min], the acceleration more than 
2000[r/min/s], the time more than 50[ms], and so on. For more 
information please refer to the driver manual or technical reference.) 

· When you move the load, easy monitor on the gain tuning screen will 
must be updated correctly. 
(Command interval must be at least 1.5 seconds, Stabilization time can 
measure, and so on.) 

· Adaptive filter can be applied the load and driving pattern. 
(Nonlinear effect is small, the acceleration less than 30000[r/min/s], and 
so on. For more information please refer to the driver manual or technical 
reference.) 

· In addition, must work correctly in a state of motor control. 
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Method of performance of fit gain 
1 Please set the positioning accuracy (Range of in-position, Target 

value of stabilization time) that aims. 
 

 
 

1. Setting item: Set the positioning accuracy that aims. 
“Range of in-position” 

Set the range of in-position. 
“Target value of stabilization time” 

Set the target value of stabilization time. 
“Option”: Specify the conditions of auto-search. 

INP clack is allowed:  
Adjustment index measure data for the shorter one either of the 
following time. That time from start of command to next start of 
command or measurement time. 

Overshoot is allowed:  
Adjustment index measure data for measurement time. 

“Trial frequency” 
Set the number of repeat to try for a combination of machine 
rigidity and mode. 

1. 2. 
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2. Information figure: Switched according to “Option”. 

    INP clack is allowed INP clack is allowed 

   Overshoot 
is allowed 

  
Overshoot 

is allowed 

  
 
2 If you change the permissible vibration level, initial rigidity and 

initial mode, click “Other setting” button and set its. 
 

 
 

“Permissible vibration level” 
Set the permissible vibration level. 

“Initial rigidity” 
Set the real-time auto tuning rigidity of first measurement. 

“Initial mode” 
Set the real-time auto tuning mode of first measurement. 

3 Please “Next” button click when you are finished setting, and go 
to Step 2. 
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4 Please drive the motor by an external command input or test 

drive function to confirm the driving pattern. 
 

 
 

1. Status: The current status and the value associated with it are 
displayed. 

2. Details: The current status and specific instructions to do next. 
Status Back 

color 
Instructions 

No operation Yellow Please input a positional instruction. 
Trying Yellow Please repeat the operation command. 
Search of initial 
rigidity 

Yellow Search of initial rigidity. Please repeat the operation 
command. 

Fit gain preparation 
completion 

Lime Please move to the fit gain execution screen of STEP3 
with a lower right button. 

Stabilization time 
measurement failed 

Fuchsia Stabilization time measurement failed. Please do the 
following measures. 
- Please lengthen waiting time from the disbursement 
completion of a positional instruction to the following 
instruction input. 
- Please return to STEP1, and lower the initial stiffness 
below a left, present rigidity. 
- Please return to STEP1, and widen the range of the 
positioning completion. 

1. 

2. 
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Status Back 
color 

Instructions 

Effective load factor 
excessive 

Fuchsia The effect load factor of one operation is 80[%] or 
more. 
Please lower a left, maximum load factor referring to 
the following measures. 
- The acceleration and deceleration is made gradual. 
(The addition and subtraction velocity time is 
lengthened, and maximum speed is lowered.) 
- The dormant period of a positional instruction is 
lengthened. 
- The load is reduced. 
- The turbulence power (friction and offset load) is 
reduced. 

Tack is short Fuchsia In the fit gain, time (tack) from a certain instruction 
input to the following instruction input is more 
necessary than that of short 1.5[s]. 
Please lengthen a left, minimum baton referring to the 
following measures. 
- The dormant period of a positional instruction is 
lengthened. 
- The instruction time is lengthened. 

Instructed time is 
short 

Fuchsia In the fit gain, time that the instruction is continuously 
input (instruction time) is necessary for 0.1[s] or more. 
Please lengthen the left, minimum instruction time 
referring to the following measures. 
- Moved distance is lengthened. 
- The addition and subtraction velocity time is 
lengthened.  
- Maximum speed is raised. 

Instructed speed is 
short 

Fuchsia In the fit gain, the instruction speed should be -
500[r/min] or less and 500[r/min] or more. 
Please enlarge the absolute value at a left maximum 
and the minimum instruction speed referring to the 
following measures.  
- Maximum speed is raised. 
- Moved distance is lengthened. 
- The addition and subtraction velocity time is 
shortened. 

Motor speed is short Fuchsia In the fit gain, the motor speed should be -500[r/min] or 
less and be 500[r/min] or more. 
Please enlarge the absolute value at a left maximum 
and the minimum motor speed referring to the 
following measures. 
- Maximum speed is raised. 
- Moved distance is lengthened. 
- The addition and subtraction velocity time is 
shortened. 
- Please return to STEP1, and lower the initial stiffness 
below a left, present rigidity. 
- Please return to STEP1, and an initial mode is 
assumed to be one. 
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Status Back 
color 

Instructions 

Torque is saturated Fuchsia The torque instruction is saturated. 
Please reduce the absolute value of the maximum and 
the minimum torque instruction in the left referring to 
the following measures. 
- The acceleration and deceleration is made gradual. 
(The addition and subtraction velocity time is 
lengthened, and maximum speed is lowered.) 
- The load is reduced. 
- The turbulence power (friction and offset load) is 
reduced. 
- The torque limit switch is assumed to be invalid (the 
first fixation), and it enlarges it within the range where 
the first torque limit can be allowed with the equipment. 

Real time estimation 
doesn't operate 

Fuchsia The load estimate of the real time auto tuning should 
operate standardly to execute the fit gain. 
Please meet the real time presumption operation 
requirement (*1) referring to the following measures.  
*1 The motor speed continues and the acceleration 
and deceleration continues 100[r/min] or more and the 
condition of 2000[r/min/s] or more continues and 
50[ms] or more continues. 
- Maximum speed is raised. 
- The addition and subtraction velocity time is 
shortened securing 50[ms] or more. 
- Moved distance is lengthened. 
- Please return to STEP1, and lower the initial stiffness 
below a left, present rigidity. 

 
5 Status is “Fit gain preparation completion” appears in, “Next” 

button click, and go to step 3. 
6 Click “Fit gain start” button, please wait the measurement is 

completed. 
* First of all, the fit gain function is performed search operation of rigidity. 

The search operation of rigidity repeats the same operation of the 
following. Setting of rigidity repeatedly measures a specified number of 
“Trial frequency”. And increase the setting of rigidity one. 
When stabilization time satisfied targets or oscillation of the motor 
detected, the fit gain function transition the search operation of mode. 
The search operation of mode could make the measurement while 
changing the mode in the range of measurement rigidity. 

* The Load may oscillate in short. Just in case, on ensuring the safety of 
the operating range, please execute in the condition that servo-off can 
be made anytime as a precaution. 
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1. Measurement button 
“Fit gain start” : Start to measure from “Initial rigidity” and “Initial 

mode” configuration. 
“Remeasuring start” : Measure the rigidity and mode settings 

selected on the search map. This button is 
available after the search operation of rigidity. 

“Start remainder” : Measure the rigidity and mode combination not 
measured. This button is available from end of 
the search operation of rigidity to end of the 
search operation of mode. 

2. Stabilization time 
Displays “Target value of stabilization time” set in Step 1.  

3. Select index 
Select index to display the chart. Index can be selected the 
same content of Monitoring Item (refer to page 81) of the Gain 
Tuning screen. 

4. Chart of index data for each setting of rigidity 
In the result of the search operation of rigidity, selected index by “3. 
Select index” is displayed. If measurement data is not, it is not 
displayed. 

1. 
2. 

4. 5. 

3. 
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5. Chart of index data for each setting of mode 

In the result of the search operation of mode, selected index by 
“3. Select index” is displayed. It is not displayed until the end of 
the search operation of rigidity. 

* Click on the “Search map” after measurement, measurement results 
can be displayed according to the rigidity it clicked. 

7 When measure is completed, measurement completed screen is 
displayed. Please click “OK”. 

 

 
 
8 When measurement completed screen is closed, please “Next” 

button click, and go to Step 4. 
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9 Please select rigidity and mode combination while referring to 

the recommendation data. 
 

 
 

1. Recommendation 
You can refine the measurement data by rigidity and mode 
combination in Step 3 to the specified conditions. You can also 
sort it. Recommendation data tab displays the top three results. 
“Best stabilization” 

It find stabilization time stable configuration without INP crack. 
“No overshoot” 

It find stabilization time stable configuration without overshoot. 
“Strong stabilization” 

It find stabilization time stable configuration without INP crack and 
overshoot. 

“Minimum stabilization” 
It finds the minimum stabilization time configuration. 

“Manual setting” 
Use what you specify in the Recommendation setting tab. 

2. Target value of stabilization time 
Displays the “Target value of stabilization time” set in Step 1. It 
can be changed at Step 4. 

1. 
2. 

3. 4. 5. 

6. 
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3. Transmit parameter 

Send to the driver to setting is checked. If the setting is sent, it 
will be disabled. 

4. Writing to EEPROM 
Write parameters to EEPROM of the driver. If you do not 
transmit parameter, it will be disabled. 

5. Save fit gain data 
Write parameters to fit gain measure result file (.fit5) to index 
data measured. 

6. Tab 
Switch to “Recommendation data” or “Recommendation 
setting”. 
<Recommendation data> 

 
 
1. Select 

Please select setting to send to the driver. 
2. Rank 

Displays rank of recommendation data. The rigidity and mode setting 
selected on the search map is displayed in line 4. 

3. Rigidity 
Rigidity of recommendation data is displayed. 

4. Mode 
Mode of recommendation data is displayed. 

5. Index data 
Index of recommendation data is displayed. For more information 
please refer to Recommendation setting. 

1. 2. 3. 4. 5. 



Rev 3.25 
－ 157 － 

 
<Recommendation setting> 

 
 
“Index” 

Specify the target index to refine and be sort. 
“Extraction” 

Specify the kind of value to use to sort and refine. 
You can select “Minimum”, “Maximum”, “Average”, “Dispersion (Max – 
Min)” and “Standard deviation”. 

“Sort” 
Use to determine the rank of the recommendation data. 
You can select “- (Not set)”, “Ascending” and “Descending”. 
In the following cases, the data on the larger rigidity and mode is 
given priority. It is if the same value or if you select “- (Not set)” on all. 

“Restriction” 
Use to refine recommendation data. 
You can select “- (Not set)”, “Greater” and “Less”. 

* Maximum of stabilization time is greater than target value of stabilization 
time is not displayed. 

* You should select “Manual setting” in Step 4 “Recommendation” to 
change the recommendation setting. 

10 Click “Transmit parameter” and “Writing to EEPROM”, save 
setting to driver. 
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11 Click “Finish”, the Exit of fit gain window is displayed. 
 

 
 

□“Exit of fit gain screen” 
Close the fit gain window. 

□“To initialization of fit gain screen” 
Start again from scratch. Current settings are cleared. 

 
Notes 1) Please refer to application scope and remarks specified in the 

driver manual or technical reference. 
Notes 2) Parameter set on this screen is inputted into Driver. As PANATERM 

does not maintain this value, please perform the recording it to 
EEPROM of driver after completion of adjustment.  

Notes 3) Parameter settings will be needed even at the fit gain. Please read 
the operation manual or technical reference to understand the 
manual content prior to this operation. 

Notes 4) The fit gain screen cannot open during opening some screens. For 
more information please refer to page 276 “Fit gain screen 
(Standard) behavior”. 
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Fit gain screen (2 degrees of freedom control) 
Explore the best gain settings automatically by repeating the 
positioning between two points. The fit gain function 
corresponding to 2 degree of freedom control generates a pattern 
of operation automatically by a test run function, and carries out 
full automatic adjustment of the load-characteristics and rigid 
setup / instruction response setup. 

 
Note) The fit gain function is rigidity and mode at real-time auto-gain tuning 

may oscillate for a short time in the course of raising the load. May be 
suppressed by the adaptive filter and auto-oscillation detection, just in 
case, on ensuring the safety of the operating range, please execute in 
the condition that servo-off can be made anytime as a precaution. 
Please refer to application scope and remarks specified in the driver 
manual or technical reference. 
The fit gain cannot be performed through RS232 communication. 
In addition, the fit gain function is disabled for some special motors. 
For details, please contact the consultation desk. 

Open the Fit gain window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Fit gain” of the tool bar on the main screen. 
3 The Log on of fit gain window is opened. 

Please select “2-DOF position control” and “Next” button click. 
(The figure of the next page) 
 
* If the motor type connected to driver and Fit gain function setting 

(Standard / Linear) do not match then, the following dialog is displayed 
and the fit gain function cannot be executed. 
In that case, please use the after changing the combination of driver 
and selected series is correct. 
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* When you select “Standard position control”, a standard fit gain window 
is opened. 

* The log on of fit gain window cannot be used when velocity control 
mode and torque control mode. When full closed control mode, a 
standard fit gain window is opened. 
If the driver is Linear and DD Control Drive, the fit gain function cannot 
be used except for position control. 

* When not communicating with driver, the selection screen of the fit gain 
measure result file is displayed. Please select the measure result, and 
the fit gain data window is opened. 

* If the driver is Linear and DD Control Drive, Standard position control is 
not displayed.  
Only 2-DOF position control is displayed. 
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* “Drive reset” is inserted when selection changes into “2-DOF position 

control” from “Standard position control”. Please follow the instructions 
on the screen. 

 
 
4 Please select fit gain with 2 degrees of freedom control, and 

“Finish” button click. 
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5 If you select “Start fit gain”, the fit gain (2-DOF control) window is 

opened. 
If you select “Read result from file”, selection screen of the fit gain 
measure result file is displayed. Please select the measure result, 
and the fit gain data window is opened. 

 
<When select “Start fit gain”> 

 
 
<When select “Read result from file”> 

 
 
Close the Fit gain window 

Click       of upright on the window. 
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Structure of Fit gain Screen 

 

 
 
(1) Title bar 

You can operate window. 

(2) Step list 
The position seen from the whole of a present step is displayed.  

(3) Message 
An easy explanation of the content set in a present step is 
displayed. 

(4) Fit gain operation area 
Steps 1-5 can be operated. 

(5) Step move 
Switch to present step.  

“Back” The previous step is displayed. 
“Next” The next step is displayed.  
“Finish” Close the fit gain window.  

(1) Title bar 
(2) Step list 
(3) Message 

(4) Fit gain 
operation area 

(5) Step move 
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Method of performance of fit gain 

 
Step 1: Select objective 
Select objective of servo adjustment. 

 
 
1. Search system selection 

Select search system. 
“Full search” 

Measure Index by combining of rigidity setting and command response 
setting, and optimum setting is selected according to the search 
conditions. 

2. Mode 
Select “Response preferentially”, “Balanced” and “Stability 
preferentially”. 

“Response preferentially” 
Adjusting servo which set much store on the response is performed. 
Resonance and friction characteristic are positively compensated 
using the adaptive filter and friction compensation. 

“Balanced” 
Adjusting servo which was able to balance a response and stability is 
performed. Using the adaptive filter, resonance characteristic is 
controlled positively. 

“Stability preferentially” 
Adjusting servo which set much store on the stability is performed. 
Fundamental adjustment which does not use the adaptive filter and 
friction compensation is performed. 

1. 

2. 

3. 

4. 
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3. Machine 

Rigidity is selected from “High”, “Middle” and “Low”. 
“High rigidity” 

Servo adjustment is performed by setup of equipment with high rigidity, 
such as coupling direct connection. Initial rigidity is made high and 
adjustment which raises rigidity as much as possible is performed. 

“Middle rigidity” 
Servo adjustment is performed by setup of equipment with medium 
degrees rigidity, such as a ball screw. Initial rigidity is made into a 
medium degree and it searches in the moderate rigidity range. 

“Low rigidity” 
Servo adjustment is performed by setting of equipment with low rigidity, 
such as belt driving. Initial rigidity is made low and adjustment which 
raises rigidity as much as possible is performed. 

4. Width of positioning completion 
Set the accuracy of positioning in command unit. 
If don't need the index of positioning like a CP control then please 
set initial value.  
(In MINAS-A6 series, you can set the option control.) 

 
1 Please set the objective (Search system, Mode, Machine) and 

width positioning completion. 
2 Please “Next” button click when you are finished setting, and go 

to Step 2. 
 
Step 2: Measure load 
Measure the load character. 
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1 Click on “SRV ON” button, and the caution window will appear. 

Confirm the window message carefully, and click “OK”. 
 

 
 

2 Please move load by  (Positive) and  (Negative), and set 
up a working range. 

3 Please set direction, movement and trial frequency and click  
button. 

4 When measure is completed, measurement completed screen is 
displayed. Please click “OK”. 

 

 
 
5 When measurement completed screen is close, please “Next” 

button click, and go to Step 3. 
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Step 3: Measure rigidity 
The operation for each rigidity setting is measured. 

 
 

1 Click  button, please wait the measurement is completed. 
* The Load may oscillate in short. Just in case, on ensuring the safety of 

the operating range, please execute in the condition that servo-off can 
be made anytime as a precaution. 

2 When measure is completed, measurement completed screen is 
displayed. Please click “OK”. 

 

 
 
3 When measurement completed screen is close, please “Next” 

button click, and go to Step 4. 
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Step 4: Measure response 
Measure the command response. 

 
 
1 Please select internal command or external command if needed. 

In internal command, please set waiting time, speed, acceleration 
and deceleration time, direction and distance. 
* Initial setting is an operation pattern of the internal command in Step 3. 
* When external command is selected, select command cannot return to 

internal command. Please be careful. 

2 Please click  button after setting trial frequency, and wait the 
measurement is completed. 

3 When measure is completed, measurement completed screen is 
displayed. Please click “OK”. 

 

 
 
4 When measurement completed screen is closed, please “Next” 

button click, and go to Step 5. 



Rev 3.25 
－ 169 － 

 
Step 5: Check result 
Check the result. 

 
 
1 Please check a measurement result and put a check into 

recommendation conditions suitable for use. 

2 Click  button, perform test run and check a measurement 
result if needed. 

3 Click “Save fit gain data”, and please save the measurement 
result of all the steps. 
* The saved file can perform check of a recommendation setting, and 

send to driver by selecting "Read result from file" as the start-up of fit 
gain. 

4 Click “Finish”, the exit of fit gain screen is displayed. Please click 
“Yes”. 
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5 When exit of fit gain screen is closed, and writing to EEPROM 

window will appear. Please click “OK”. 
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Recommendation setting 

 

 
 
(1) Tab 

Switch to “Recommendation setting” or “Manual setting”. 
<Recommendation setting> 

 
1. Select 

Please select setting to send to the driver. 
2. Recommendation 

The name of recommendation conditions is displayed. 
3. Rigidity 

Rigidity of recommendation data is displayed. 
4. Command response 

Command response of recommendation data is displayed. 
5. Index data 

Index of recommendation data is displayed. 

(1) 
 

(2) Test runs 
area 

(3) Save fit gain 
data button 

1. 2. 3. 

4. 5. 

1. 2. 3. 4. 5. 
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<Manual setting> 

 
1. Index 

Specify the target index to. 
2. Extraction 

Specify the kind of value to use to. You can select “Minimum”, 
“Maximum”, “Average”, “Dispersion (Max – Min)” and “Standard 
deviation”. 

3. Index data 
Index data corresponding to the combination of rigidity and command 
response is displayed. 

4. Transfer 
The contents of the cell selected by “3.” are sending to the driver. 

(2) Test runs area 
Test run is performed. 

1. Test run 
Test run is performed using the same operation pattern as Step 4. 
* When having selected external command, please drive a motor 

by external command after button is clicked. 
2. Emergency stop 

Do emergency stop by cut off electricity to a motor. 
* This becomes invalid when an external command is selected. 

Please use an external servo-on input etc. and enable it to 
perform an emergency stop. 

3. Fine adjustment 
Can do fine adjustment from recommendation conditions. 

4. Trial frequency 
Specifies the trial frequency when test run. 

5. Measurement result 
Measurement result of test run is displayed. 

1. 2. 

3. 

4. 
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(3) Save fit gain data button 

The measurement result of all the steps is saved. The saved file can 
perform check of a recommendation setting, and send to driver by selecting 
"Read result from file" as the start-up of fit gain. 

 
Fine adjustment 
According to change of a preset value, a parameter is sent to driver. 

 
 

“Close”   : Activate the change, and exit the screen. 
“Cancel”  : Inactivate the change, and exit the screen. 
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Structure of Fit gain data Screen 

 

 
 
(1) Title bar 

You can operate window. 

(2) Tool bar 

 (Read) 
Reads fit gain measure result from files (.fit5). 
When this button is effective, a fit gain measure 
result file can be specified by drag and drop. 

 (Transmit) Sends parameters to the drivers. 

 (EEPROM) Write parameters to EEPROM of the driver. 

 (Exit) Closes fit gain data screen. 

 (Screen) Captures the screen and save into a file. 

(1) Title bar 
(2) Tool bar 

(3) Target value 
setting 

(5) Measurement 
information 
area 

(4) Tab 
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(3) Target value setting 

“Target value of stabilization time” 
Set the target value of stabilization time. 

“Overshoot” 
Set the target value of overshoot. 

(4) Tab 
Switch to “Recommendation setting” or “Manual setting”. 

<Recommendation setting> 

 
1. Select 

Please select setting to send to the driver. 
2. Recommendation 

The name of recommendation conditions is displayed. 
3. Rigidity 

Rigidity of recommendation data is displayed. 
4. Command response 

Command response of recommendation data is displayed. 
5. Index data 

Index of recommendation data is displayed. 

3. 4. 5. 2. 1. 
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<Manual setting> 

 
1. Index 

Specify the target index to. 
2. Extraction 

Specify the kind of value to use to. You can select “Minimum”, 
“Maximum”, “Average”, “Dispersion (Max – Min)” and “Standard 
deviation”. 

3. Index data 
Index data corresponding to the combination of rigidity and command 
response is displayed. 

 
(5) Measurement information area 

Objective of servo adjustment and operation pattern at the time of 
measurement are displayed. 

 
Notes 1) Please refer to application scope and remarks specified in the 

driver manual or technical reference. 
Notes 2) Parameter set on this screen is inputted into Driver. As PANATERM 

does not maintain this value, please perform the recording it to 
EEPROM of driver after completion of adjustment.  

Notes 3) Parameter settings will be needed even at the fit gain. Please read 
the operation manual or technical reference to understand the 
manual content prior to this operation. 

Notes 4) The fit gain screen cannot open during opening some screens. For 
more information please refer to page 277 “Fit gain screen (2 
degrees of freedom control) behavior”. 

1. 2. 

3. 
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Object Editor screen 
Realize easier troubleshooting without connecting to the host 
controller by displaying and editing the object list of the driver. 

 
Note) Please modify objects with enough care after reading the driver's 

instruction manual or technical reference carefully, as some objects 
give large effect to operations of drivers or motors.  
Object editor cannot be performed through RS232 communication. 

 
Open the Object Editor window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Object Editor” of the tool bar on the main screen. 
3 Selection of object to be read window is displayed. 
 
<When communication with driver> 

 
 
<When not communication with driver> 
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4 Select the origin of objects, and click. 

□“Read - out from the driver” 
The objects set in the driver are read communicating the driver 
connected. If this mode is selected, modifications of the object values are 
reflected to the driver immediately. 

□“Read from the file” 
Object Data files already edited (.obj5) are read. Object modifications are 
not reflected to the driver connected unless “Transmit the object to the 
driver” is executed when they are “Read from the file”. 

□“Read the default” 
Default set values saved at the time of installation is read. The object 
modifications are not reflected unless “Transmit the object to the driver” 
is executed as the case of “Read from the file”. 

 
5 Click “OK”. The Object Editor window is opened. 

 
 
Close the Object Editor window 
Click        (Exit) on the tool bar. 
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Structure of Object Editor screen 

 

 
 
 
 
 
(1) Title bar 
The origins of reference of objects reference are displayed. 
Following buttons are used to operate windows. 

  Display the window in full screen 

  Close the window 

(2) Tool bar 
Saving, reading, some other basic operation commands on objects 
are listed. 

 (Read) 
Reads objects from files (.obj5). 
When this button is effective, an object file can be 
specified by drag and drop. 

 (Save) Writes objects to files (.obj5). 

 (Comment) Makes comments attached to objects files. 

 (Receive) Receives objects from the driver. 

 (Transmit) Sends objects to the driver. 

(1)Title bar 
(2)Tool bar 

(3) Condition 
monitor 

(4)Object Tree 

(5)Object 
setting 
field 

1. 2. 
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 (Compare) Compares objects on editing with other objects. 

 (EEPROM) Write objects to EEPROM of the driver. 

 (Exit) Closes object editor screen. 

 (Screen) Captures the screen and save into a file. 

 

(Disp Select) Change the numerical display of objects being 
displayed. 
Hex : Displayed in hexadecimal, add "h" to the end 

of the number. 
Dec : Displayed in decimal number, and sign is set. 
Bin : Displayed in binary number, add "b" to the 

end of the number. Min-Max columns are 
displayed in hexadecimal. 

 
(Set Home) Run Set Home. Write the calculation result of 

"607Ch-00h minus 6064h-00h" to "607 Ch-00h". 

(3) Condition monitor 
(PDS Condition) Show the PDS Condition of the Driver.  

The condition is changed depending on the value of the 
object of 6041h-00h. 

(ESM Condition) It shows condition whether rewriting objects in the driver is 
possible or not. 

 <When communication with driver> 

 INIT In this condition, you can rewrite the driver 
object.  

 is displayed next to , and 
becomes possible to edit and send the 
object setting value. 

 other than 
INIT 

In this condition, you cannot rewrite the 
driver object. 

 is not displayed next to , and 
becomes impossible to edit and send the 
object setting value. 

 <When not communication with driver> 
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 -  is displayed next to , and 
becomes possible to edit and send the 
object setting value. 
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(4) Object Tree 
If you select a node from the object 
tree, related objects are displayed at 
object setting field. 
If you click “Close TreeView” / “Disp 
TreeView” button, switch the Hide / 
Show of Object tree. 
If you select “All object”, all objects 
are displayed. 
If you select a parent node, objects of 
all the child nodes are displayed 
which following selected parent node. 
If you select a child node, objects of 
the selected node are displayed. 
If you select “Extraction”, the 
extracted objects are displayed . 
The objects selected in the  
object setting field are displayed. 
Refer to the instruction manual of the driver or technical reference 
for more information about each object. 
Note) If you receive or transmit the object during the extraction 

display, targets are only extracted objects. 
If the object is read during the extraction display, “All object” is 
selected and extraction display will be canceled. 

(5) Object setting field 
1. Extraction selection check box 

It is possible to extract the object by checking ON.  
Extraction selection is saved at the end of object editor, and 
read automatically when the object editor startup.  

All object 
Parent node 

Child node 
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2. You can edit and set the object. 

“Parameter” Show the parameter classification and number 
corresponding to the object. 
Not displayed if you select “All object” or if the 
corresponding parameter does not exist. 

“Main Index” Show the Main Index of the object. 

“Sub Index” Show the Sub Index of the object. 

“Object Name” Show the Object Name. 

“Data Type” Show the Data Type of the object. 
I8 : Integer 8 
I16 : Integer 16 
I32 : Integer 32 
U8 : Unsigned 8 
U16 : Unsigned 16 
U32 : Unsigned 32 
Bool : Boolean 
OS : Octet String 
VS : Visible String 

“Attrib” Show the attribute of the object. 
RO : Read-Only attribute 
RW : Read-Write attribute 

“MIN-MAX” Show the setting range of the object. 
If “Data Type” is OS or VS, setting range is not displayed. 

“Setting Value” Show the setting value of the object. 
If “Attrib” is RW and “Setting Value” is number, you can 
change the setting value of the object. 
Depending on the choice of “Disp Select”, there is an input 
limit. 
Hex  : 0 to 9, “A” to “F”  
(after editing, “h” is automatically added to the end.) 
Dec : 0 to 9, “-”sign 
Bin  : 0 to 1 
(after editing, “b” is automatically added to the end.) 
After changing the setting value, the change is reflected by 

pressing the [ENTER] key or clicking the   
(Change of set value). 
Press the [ESC] key to return to the original value. 

“Units” Show the unit of the setting value of the object. 
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Comment 

On saving set objects in a file, comments can be saved together. 
These comments do not effect operations of the driver. 
 
Making Comment 
1 Click       (Comment) on the tool bar, and open the comment 

window. 
 

 
 
2 Click comment box and input comments. 
3 After completing comment input, click “OK”. 
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Comparison 
Objects being edited can be compared with other objects. 
 
Comparison of objects 
1 Click       (Comparison) on the toolbar, please select the file 

(.obj5) to be compared. 
 

2 Comparison result of the objects is displayed. 
 

 
 
3 Click “Save”, comparison result of the objects can be saved at a file. 
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Notes 1) Please refer to the manual of the driver or technical reference for 

details of each object’s function and so on. 
Notes 2) Even if objects are sent to the driver, objects are turned to the 

original value before modification if the power supply of the driver is 
turned off without writing to EEPROM of the driver. Object 
modifications list are displayed on EEPROM writing. Please check 
the modification carefully. 

Notes 3) Do not turn off the power supply of the PC during writing to 
EEPROM of the driver. Data context cannot be guaranteed if the 
power supply is turned off during writing. 

Notes 4) Some objects become valid after modifications to the new data, 
writing EEPROM, and power supply reset. (On inputting, that issue 
is displayed. Please refer to the manual of the driver or technical 
reference and confirm on the objects) 

Notes 5) Object editor screen indication may be different from the actual 
object value of the driver in case PANATERM function windows 
which change the objects (ex. Trial Run, Pin Assign, Analog Input) 
is opened. In such case, press the reception button and update the 
object of the driver to the latest one. 

Notes 6) If you cannot edit object value during the communication with 
driver, the driver may be in condition which is not rewritable. 
In this case, please check “ESM Condition” is “INIT” and also the 
driver is in condition which is rewritable. 

Notes 7) The object editor screen cannot open during opening some 
screens. For more information please refer to page 278 “Object 
editor screen behavior”. 
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Battery Refresh screen 

Will perform a battery forced discharge of the encoder. 
 
Note) Battery refresh can be executed only by the corresponding encoder. 

Please note that there is a possibility that the battery alarm occurs 
during the refresh operation.  
Battery refresh cannot be performed through RS232 communication. 

 
Open the Battery refresh window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Battery Refresh” of the tool bar on the main 

screen. 
3 The Battery Refresh window is opened. 
 

 
 
Close the Battery refresh window 

Click       of upright on the window 
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Procedure for Battery refresh 
1 Click “Execute”. 
2 Confirmation dialog is displayed.  

Click “OK” then Battery refresh is executed. 
 

 
 
3 The remaining time is displayed as "05:00". 

Will be gradually countdown. 
 

 
 
4 When the remaining time reaches "00:00", the battery refresh is 

complete. 
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Interruption of Battery refresh 

Click “Forced Exit” then exit forcibly battery refresh. 
 
Notes 1) Remaining time of the countdown after the battery refresh 

execution, please note that after the end of the battery refresh 
screen is also continuing. 

Notes 2) The battery refresh screen cannot open during opening some 
screens. For more information please refer to page 279 “Battery 
refresh screen behavior”. 
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Block operation Editor screen 
Realize easier block operation by displaying and editing the block 
operation and block parameter of the driver. 

 
Note) Please modify parameters with enough care after reading the driver's 

instruction manual or technical reference carefully, as some 
parameters give large effect to operations of drivers or motors.  
Block operation cannot be performed through RS232 communication. 

 
Open the Block operation Editor window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Block operation Editor” of the tool bar on the main 

screen. 
3 Selection of parameter to be read window is displayed. 
 
<When communication with driver> 

 
 
<When not communication with driver> 
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4 Select the origin of parameters, and click. 

□“Read - out from the driver” 
The parameters set in the driver are read communicating the driver 
connected. If this mode is selected, modifications of the parameter 
values are reflected to the driver immediately. 

□“Read from the file” 
Parameter files already edited (.obj5) are read. Parameter modifications 
are not reflected to the driver connected unless “Transmit the parameter 
to the driver” is executed when they are “Read from the file”. 

□“Read the default” 
Default set values saved at the time of installation is read. The parameter 
modifications are not reflected unless “Transmit the parameter to the 
driver” is executed as the case of “Read from the file”. 

 
5 Click “OK”. The Block operation Editor window is opened. 
 

 
 
Close the Block operation Editor window 

Click        (Exit) on the tool bar. 
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Structure of Block operation editor screen 

 

 
 
(1) Title bar 
The origins of reference of parameters reference are displayed. 
Following buttons are used to operate windows. 

  Display the window in full screen. 

  Close the window. 

(2) Tool bar 
Saving, reading, some other basic operation commands on 
parameters are listed. 

 (Read) 
Read parameters from files (.obj5). 
When this button is effective, a parameter file can 
be specified by drag and drop. 

 (Save) Write parameters to files (.obj5). 

 (Comment) Make comments attached to parameters files. 

 (Receive) Receive parameters from the driver. 

 (Transmit) Send parameters to the driver. 

 (EEPROM) Write parameters to EEPROM of the driver. 

(1)Title bar 
(2)Tool bar 

(4)Block 
operation 
setting field 

(3)Tab 
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 (Exit) Close Block operation editor screen. 

 (Screen) Capture the screen and save into a file. 

(3) Tab  
Switch Block operation setting field display to “Block operation edit”, 
“Block parameter edit”. 
 

(4) Block operation setting 
Editing and setting of block operation command parameters and 
block operation parameter are available. 
 
Setting method of Block operation command 
1 Select the tab of “Block operation edit”. 
* The settings row is displayed current block operation command.  

When block operation command is not set then, it is displayed 
“Not set”.  
When the command cannot convert to block operation command 
then, it is displayed “Not defined command” or “Unusual 
command settings”. 
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2 Double-click the block command row to want be set. 
3 Block operation command argument Edit window is displayed. 
 

 
 
4 Select the block operation command from the combo box, and 

please set each argument. 
5 Click “OK”. Set the block operation command with the current 

settings. 
Click “Reset”. Set the “Not set” and close this screen. 
Click “Cancel”. Inactivate the change, and exit the screen. 
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Setting method of Block parameter  
1 Select the tab of “Block parameter edit”. 
 

 
 
2 Block parameter edit screen is displayed. 
“Class” Parameter classifications are indicated. 

“No.” Parameter numbers are indicated. 

“Parameter name” Parameter names are indicated. 

“Setup range” Maximum & minimum value of parameter setting is 
indicated. 

“Set value” Parameter value. Its value can be modified. 
Parameters with on the set values are set with the 
combo boxes. After selecting the values from the combo 
boxes, input the [ENTER] key. 
Parameters without  on the set values, are inputted with 
the number keys directly, or modified clicking  and 
changing the values. To set the values, input the [ENTER] 
key  
If the [ESC] key is inputted, the value is return to the 
original one. 

“Unit” Units of the parameter set values are indicated. 
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Comment 

On saving set parameters in a file, comments can be saved 
together. These comments do not effect operations of the driver. 
 
Making Comment 
1 Click       (Comment) on the tool bar, and open the comment 

window. 
 

 
 
2 Click comment box and input comments. 
3 After completing comment input, click “OK”. 
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Notes 1) Please refer to the manual of the driver or technical reference for 

details of each parameter’s function and so on. 
Notes 2) Even if parameters are sent to the driver, parameters are turned to 

the original value before modification if the power supply of the 
driver is turned off without writing to EEPROM of the driver. 
Parameter modifications list are displayed on EEPROM writing. 
Please check the modification carefully. 

Notes 3) Do not turn off the power supply of the PC during writing to 
EEPROM of the driver. Data context cannot be guaranteed if the 
power supply is turned off during writing. 

Notes 4) Some parameters become valid after modifications to the new 
data, writing EEPROM, and power supply reset. (On inputting, that 
issue is displayed. Please refer to the manual of the driver or 
technical reference and confirm on the objective parameters) 

Notes 5) The block operation editor screen cannot open during opening 
some screens. For more information please refer to page 279 
“Block operation editor screen behavior”. 
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Block operation Monitor screen 
You can display and check the execution status of the block 
operation. 

 
Note) Block operation monitor cannot be performed through RS232 

communication. 
 
Open the Block operation Monitor window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Block operation Monitor” of the tool bar on the 

main screen. 
3 The Block operation Monitor window is opened. 
 

 
 
Close the Block operation Monitor window 

Click       of upright on the window 
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Structure of Block operation monitor screen 

 

 
 
(1) Title bar 
You can operate window.  
 
(2) Monitor contents displayed area 
Display monitoring information. 

1. Input signal conditions monitoring 
Display signal condition of input. 
  Red : Active 
  Pink : Inactive 

2. Output signal condition monitoring 
Display Signal condition of output 
  Red : Active 
  Pink : Inactive 

 
(3) Block operation displayed area 
Display the number of the block operation running. 

(1)Title bar 

(3)Block 
operation 
displayed area 

(2) Monitor 
contents 
displayed area 

1. 2. 
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Notes 1) Using USB communication as data receipt between Driver and PC, 

there are accidental errors, delay of display value on the screen 
and actual driver value and recoded time. 

Notes 2) If polarity is (+), (+) signal is not displayed. 
Notes 3) Block operation monitoring function is not precious measurement 

instrument. Block operation monitoring display shall be used as 
rough estimate. 

Notes 4) The block operation monitor screen cannot open during opening 
some screens. For more information please refer to page 280 
“Block operation monitor screen behavior”. 



Rev 3.25 
－ 201 － 

 
Block operation Editor v2 screen 
Realize easier block operation by displaying and editing the block 
operation and block parameter of the driver. 

 
Note) Please modify parameters with enough care after reading the driver's 

instruction manual or technical reference carefully, as some 
parameters give large effect to operations of drivers or motors. 

Note) Block operation Editor v2 cannot be performed through RS232 
communication. 

 
Open the Block operation Editor v2 window 
 
1  Start “PANATERM”.  

(Please refer to Article 5. Start up and Close down in details) 
2  Click “Other” > “Block operation Editor v2” of the tool bar on the 

main screen.   
3  Selection of parameter to be read window is displayed.  
 
<When communication with driver> 

 
  
<When not communication with driver> 
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4  Select the origin of parameters, and click.  

□ “Read - out from the driver”  
The parameters set in the driver are read communicating the driver 
connected. If this mode is selected, modifications of the parameter 
values are reflected to the driver immediately.  

□ “Read from the file”  
Parameter files already edited (.obj5) are read. Parameter modifications 
are not reflected to the driver connected unless “Transmit the parameter 
to the driver” is executed when they are “Read from the file”. 

□ “Read the default”  
Default set values saved at the time of installation is read. The 
parameter modifications are not reflected unless “Transmit the 
parameter to the driver” is executed as the case of “Read from the file”.  
 

5  Click “OK”. The Block operation Editor v2 window is opened. 
 

 
 
Close the Block operation Editor v2 window 

Click       (Exit) on the tool bar. 
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Structure of Block operation editor v2 screen 
 

 
 

 
(1) Title bar 
You can operate window. 
Following buttons are used to operate windows. 

  Minimize the window. 

  Display the window in full screen. 

  Close the window. 

(2) Tool bar 
Saving, reading, some other basic operation commands on 
parameters are listed. 

 (Undo) Revert to the previous operation once. 
(Ctrl + Z) 

 (Redo) Proceed to the previous operation once. 
(Ctrl + Y) 

 
(Read) Read parameters from files (.obj5).  

When this button is enabled, parameters files can 
be specified by drag & drop. 

  
(Save) Write parameters to files (.obj5). 

 (Cmnt) Make comments attached to parameters files. 

 (Rcv) Receive parameters from the driver. 

    (Trans) Send parameters to the driver. 

(1)Title bar 
(2)Tool bar 

(3)Block list (4)Block settings 

(5)Parameter list 

(6)Monitor 
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(EEP) Write parameters to EEPROM of the driver. 

 
(Exit) Close Block operation editor v2 screen. 

(3) Block list 
Display the currently configured Block list. When you select the 
block you want to edit, you can edit it in the block settings. 
 
* Right click menu 
Copy Copy the selected block. 
Paste Paste the copied block. 
Insert Insert an unset block above the selected block. 
Inserting 
Copied 
Block 

Insert the copied block above the selected block. 

Delete Delete the selected block. 

(4) Block settings 
Edit the selected block in the block list. 

 

(5) Parameter list 
Set the parameters related to block operation. 

 

(6) Monitor 
Monitor the currently executing block and the logic input/output 
signals required for block operation. 
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Keyboard shortcut 
 
Key 
operation 

Operation target Operation details 

F1  Block operation 
Editor v2 screen 

View the manual. 

Alt + F4 Each dialog Exit the current dialog. 
Ctrl + C Block list Copy selected block. 
Ctrl + V Block list Paste copy block. 
Del Block list Unset the selected block. 
ESC Block list Release the copy state. 
Click Block list Select a block. 
Arrow keys Block list Move the selected block in the direction of the 

arrow key. 
Home/End Block list Move the selected block to the beginning/end. 
PgUp/PgDn Block list Move the selected block forward/back one page. 
Shift + 
Arrow keys 

Block list Select multiple blocks in the direction of the arrow 
keys. 

Shift + 
Home/End 

Block list Multi-select blocks to the beginning/end. 

Shift + 
PgUp/PgDn 

Block list Multi-select blocks one page ahead/previous. 

Shift + 
Click 

Block list Multi-select up to the block you clicked. 

Ctrl + A Block list Select all blocks. 
Ctrl + Arrow 
keys 

Block list Move the focus in the direction of the arrow key 
while keeping the selection block. 

Ctrl + 
Space 

Block list Select focused block. Deselect if already selected. 

Ctrl + Click Block list Selects the clicked block. Deselect if already 
selected. 
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Setting method of Block operation command 
  

 Select the block you want to change from the block list. 
 

 
 
The block command selected in the block list is displayed. Change 
to any settings. 
 

 
 

Move selected block 

 

“Return” Move to the previous selected block. 

 

“Move on” Move to the next selected block. 

 

“Transition to 
referrer” 

List referencing blocks. 
Move to the selected block in the list. 
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*  Not set is selected 

 
 
A list of configurable block command buttons is displayed. Select 
the block you want to use. 
 

 
 
* Unsupported command is selected 

 
 
If an unsupported command is selected, you can only delete it. 

 
 
* If no block is selected 
If you have not selected a block, please select a block. 
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Setting method of Block parameter  
 
From the parameter list, you can change the setting value of the 
parameter you want to set. If you check "Related parameters", only 
the parameters related to the selected block will be displayed. 
 

 
 
“Class” Parameter classifications are indicated. 
“No.” Parameter numbers are indicated. 
“Name” Parameter names are indicated. 
“Value” Parameter value. You can enter a value or select it 

from a combo box. Placing the mouse pointer over 
an item displays the effective range of that item. 

 
Using method of Monitor  
 
When the monitor mode is ON, the running block is highlighted in 
the operation block list. It can also monitor the current logic input 
and output signals. 
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* The status is shown below: 

 ON 

 OFF 
 
* The monitor mode can be turned on only when communicating 

with the driver. 
* When the monitor mode is ON, block commands, setting block 

parameters, and some toolbar operations, etc. cannot be 
executed. 

the running block 

Monitor 
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Comment 
On saving set parameters in a file, comments can be saved 
together. These comments do not effect operations of the driver. 
 
Making Comment 
 

1 Click   (Comment) on the tool bar, and open the comment 
window. 
 

 
 

2 Click comment box and input comments.  
3 After completing comment input, click “OK”. 
 

Notes 1) Please refer to the manual of the driver or technical reference for 
details of each parameter’s function and so on. 

Notes 2) Even if parameters are sent to the driver, parameters are turned to 
the original value before modification if the power supply of the 
driver is turned off without writing to EEPROM of the driver. 

Notes 3) Do not turn off the power supply of the PC during writing to 
EEPROM of the driver. Data context cannot be guaranteed if the 
power supply is turned off during writing. 

Notes 4) Some parameters become valid after modifications to the new 
data, writing EEPROM, and power supply reset. 

Notes 5) The block operation editor v2 screen cannot open during opening 
some screens. For more information please refer to page 280 
“Block operation editor v2 screen behavior”. 
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Deterioration diagnosis screen 
You can display and check the deterioration and aging state of 
the equipment from the detection apparatus capable of 
information by the motor. 

 
Note) Deterioration diagnosis cannot be performed through RS232 

communication. 
 
Open the Deterioration diagnosis window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Deterioration diagnosis” of the tool bar on the 

main screen. 
3 The Deterioration diagnosis window is opened. 
 

 
 
Close the Deterioration diagnosis window 

Click        (Exit) on the tool bar. 
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Structure of Deterioration diagnosis screen 

 
 

 
 
 
 
(1) Title bar 
You can operate window. 

(2) Tool bar 
Receiving, transmitting, some other basic operation commands on 
parameters are listed. 

 (Receive) Receives parameters from the driver. 

 (Transmit) Sends parameters to the driver. 

 (Exit) Closes parameter screen. 

 (EEPROM) Write parameters to EEPROM of the driver. 

 (Screen) Captures the screen and save into a file. 

(1)Title bar 

(3)Diagnosis 
function 
setting 
field 

(2)Tool bar 

(4)Load factor estimated area (5)Torque command estimated area 
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(3) Diagnosis function setting field  
To enable / disable the deterioration diagnosis function. 
When the screen is displayed, it is set to the current state of the 
driver. 

 
Enabled  : Deterioration diagnosis function is enabled. 
Disabled : Deterioration diagnosis function is disabled.  
 

(4) Load factor estimated area 
It displays the estimated information about the load characteristics.  

 
1. Estimated information setting 

Set the estimated condition of the load factor estimation. 
“Convergence judgment time” 

Sets time for deemed convergence of real-time auto tuning load 
characteristics estimate. 

2. Diagnosis information Monitor 
Display the diagnostic status of the load characteristics estimation. 

“Load factor estimated”  
Display the load factor estimated of real time auto tuning indicates 
whether valid. 

 
 

1. 

2. 

3. 
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“Load factor estimated completion”  

If load factor estimate is valid and it was possible that the data 
necessary to estimate is to get more than convergence determination 
time, will be completed. 

3. Diagnostic slider 
Display the slider that indicates the diagnostic state of 
deterioration diagnostic information related to the load factor. 

“Inertia ratio presume” 
Display the diagnostic state of inertia ratio. 

“Unbalanced load presume” 
Display the diagnostic state of unbalanced load. 

“Dynamic friction presume” 
Display the diagnostic state of dynamic friction. 

“Viscous friction presume” 
Display the diagnostic state of viscous friction. 

 

(5) Torque command estimated area 
It displays the estimated information about the torque command. 
 
 

1. 

2. 

3. 
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1. Estimated information setting 
Set the estimated condition of the torque command estimation. 

“Torque average time” 
Sets time required to compute the torque command average (weighted 
frequency). 

“Velocity setting” 
Sets deterioration diagnosis velocity output (V-DIAG). 

2. Diagnosis information Monitor 
Display the diagnostic status of the torque command estimation. 

“Velocity output” 
It turned on when the motor speed matches the velocity setting. 

“Torque average time”  
It will be completed when the velocity output is on and has passed 
more than the torque average time. 

3. Diagnostic slider 
Display the slider that indicates the diagnostic state of 
deterioration diagnostic information related to the torque 
command. 

“Torque command (Average)”  
Display the diagnostic state of torque command (average). 
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Structure of Diagnostic slider 

 
Diagnostic slider is composed of the following elements. 
Warning during the occurrence of the deterioration diagnostic 
information of interest, background color as a warning display is 
displayed in red. 
 

<Normal>                      <Warning> 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(Diagnosis  
information) 

Display the name of diagnosis information. 

(Upper  
value display) 

Set upper limit and lower limit of diagnosis information. 
Upper values and Lower values, are inputted with the 
number keys directly, or modified clicking  and changing 
the values from each setting area. To set the values, input 
the [ENTER] key or click  (Transmit) on Toolbar. 

(Lower 
value display) 

(Unit display) Display the unit of diagnosis information. 
(Current 
 value display) 

Display the current value of diagnostic information acquired 
from the driver. 

(Warning 
display) 

Display the occurrence of deterioration diagnosis warning. 

(Slider display) Display estimation result of diagnosis information with slider. 
The drawing range of the slider changes according to the 
setting of the upper limit value and lower limit value. 

Upper 
value 
display 

Diagnosis 
informatio
n 

Unit display 

Current 
value 
display 

Warning display 

Slider display 

Lower 
value 
display Limite

d 
range 

Curren
t value 

Uppe
r 
value 

Lower 
value 

Origin 
position 
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 Current 

value 
Display the current value of diagnostic 
information with      . 
In the limit range  :Displayed as 
Out the limit range  :Displayed as 
Out the drawing range  :Displayed as 

 Upper 
value 

Display the upper limit value of diagnostic 
information. If lower limit value ≧ upper limit 
value then, it not displayed. 

 Lower 
value 

Display the lower limit value of diagnostic 
information. If lower limit value ≧ upper limit 
value then, it not displayed. 

 Limited 
range 

Display the limit range by the upper limit value 
and lower limit value. If deterioration diagnosis 
function is enabled and the current value exceeds 
the limit range, diagnosis warning will be 
generated. If lower limit value ≧ upper limit value 
then, it not displayed. 

 Origin 
position 

Display the position of the current value = 0. 
It is not displayed when there is no 0 position 
within the drawing area. 

 
Notes 1) Please refer to the manual of the driver or technical reference for 

details of each parameter’s function and so on. 
Notes 2) Even if parameters are sent to the driver, parameters are turned to 

the original value before modification if the power supply of the 
driver is turned off without writing to EEPROM of the driver. 
Parameter modifications list are displayed on EEPROM writing. 
Please check the modification carefully. 

Notes 3) Do not turn off the power supply of the PC during writing to 
EEPROM of the driver. Data context cannot be guaranteed if the 
power supply is turned off during writing. 

Notes 4) The deterioration diagnosis screen cannot open during opening 
some screens. For more information please refer to page 281 
“Deterioration diagnosis screen behavior”. 
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RTEX Setup screen 
Set the RTEX communication between the driver and the host 
device. 

 
Note) RTEX Setup cannot be performed through RS232 communication. 
 
Open the RTEX Communication Setting window 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “RTEX Setup” of the tool bar on the main screen. 
3 When not communicating with driver, the selection screen of a 

parameter is displayed. Please choose the parameter file to edit. 
4 The RTEX Setup window is opened. 
 
<When communication with driver> 
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<When not communication with driver> 

 
 
Close the RTEX Communication Setting window 

Click        (Exit) on the tool bar. 
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Structure of RTEX Setup screen 

 
RTEX Communication Setting 

 
 
Communication Cycle Monitor 
This is displayed when communication with driver only. 

 
 
(1) Title bar You can operate this window. 

(2) Tool bar 

 (Save) Moves to the parameter screen. 

 (Receive) Receives parameters from the driver. 

(1) Title bar 
(2) Tool bar 
(3) Tab 

(4) Parameter 
setting field 

(5) Text 
indication 
box 

(6) Monitoring 
Contents 
display area 
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 (Transmit) Sends parameters to the driver. 

 (Exit) Closes RTEX Setup screen. 

 (EEPROM) Write parameters to EEPROM of the driver. 

 (Screen) Capture the screen and record the file 

/  (Measurement) Starts the communication cycle 
measurement/re-measurement. 

 (Stop) Stops the communication cycle measurement. 

(3) Tab 
Switch the display of “RTEX Communication Setting” and 
“Communication Cycle Monitor” 

 (4) Parameter setting field 
Editing and setting of parameters are available. 

“Communication cycle / 
Command update cycle” 

This parameter sets the communication cycle and the 
command update cycle of the driver. 
You can set the communication cycle and the command 
update cycle by changing this parameter. 

“Parameter name” Parameter names are indicated. 
“Set value” Parameter value. Its value can be modified. 

For a parameter value represented by a button, press 
the button to set the parameter. 
Parameters with on the set values are set with 
the combo boxes. After selecting the values from 
the combo boxes, input the [ENTER] key or click 

(modification of set value). 
Parameters without  on the set values, are 
inputted with the number keys directly, or modified 
clicking  and changing the values. To set the 
values, input the [ENTER] key or click 

(modification of set value). 
If the [ESC] key is inputted, the value is return to the 
original one. 

“Class” Parameter classifications are indicated. 
“No.” Parameter numbers are indicated. 
“Bit" Displays the relevant bit. 
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* When you are editing parameters, if there are parameter settings invalid for 

the current communication setting, the following dialog box appears with 
the reasons for restriction and the list of parameters. 

 

 
 

(5) Text indication box 
Explanations regarding selected parameters. 

 
(6) Monitoring Contents display area 

This area displays the real-cycle representation of the 
measurement results of the RTEX communication data that the 
driver received from the host device. 

* Use the values to check the communication intervals just for reference 
because they include internal clock errors of the driver. 

 
How to monitor the communication status 
1 Select a tab of “Communication Cycle Monitor”. 
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2 Click       (Measure) of the tool bar. 

The content of the communication cycle monitoring area is 
updated when measurement starts. 
The communication timing fluctuation monitor lights up in blue 
when the average communication cycle is within the valid range. 
The communication timing fluctuation monitor lights up in red 
when it is not within the valid range. 

 

 
* If you want the communication monitoring to be automatically stopped 

in case of a communication error, select “Measurement is automatically 
stopped when a communication error occurs.” 

 
Selecting “Including Maximum and Minimum” includes the 
maximum communication cycle and the minimum 
communication cycle as the decision criteria of the 
communication timing fluctuation monitor. 
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Notes 1) Please refer to the manual of the driver or technical reference for 

details of each parameter’s function and so on. 
Notes 2) Even if parameters are sent to the driver, parameters are turned to 

the original value before modification if the power supply of the 
driver is turned off without writing to EEPROM of the driver. 
Parameter modifications list are displayed on EEPROM writing. 
Please check the modification carefully. 

Notes 3) Do not turn off the power supply of the PC during writing to 
EEPROM of the driver. Data context cannot be guaranteed if the 
power supply is turned off during writing.  

Notes 4) Some parameters become valid after modifications to the new 
data, writing EEPROM, and power supply reset. (On inputting, that 
issue is displayed. Please refer to the manual of the driver or 
technical reference and confirm on the objective parameters)  

Notes 5) The RTEX Setup screen cannot open during opening some 
screens. For more information please refer to page 281 “RTEX 
Setup screen behavior”.  



Rev 3.25 
－ 225 － 

 
Magnetic pole position estimation results copying 
screen 
Set the magnetic pole position estimation results based on the 
parameter file. 

 
Note) Magnetic pole position estimation results copying function is assumed 

to exchange only driver without changing the combination of linear 
motor and feedback scale. 
Make sure that the copy source and copy destination driver are the 
same device. 
Otherwise the magnetic pole position will be shifted, motor cannot be 
controlled normally. 
Magnetic pole position estimation results copying cannot be performed 
through RS232 communication. 

 
Open the Magnetic pole position estimation results copying 
window 
 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Magnetic pole position estimation results 

copying” of the tool bar on the main screen. 
3 The Magnetic pole position estimation results copying window is 

opened. 
 

 
 
Close the Magnetic pole position estimation results copying 
window 

Click       of upright on the window 
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Magnetic pole position estimation results copying is executed 
1 Click “Read” button. 
2 Select the copy source parameter file. 
3 Click “Execute” button. 
4 Caution windows will appear. Confirm the window message 

carefully, and click “Execute”. 
 

 
 
Notes 1) The Magnetic pole position estimation results copying screen 

cannot open during opening some screens. For more information 
please refer to page 281 “Magnetic pole position estimation results 
copying screen”. 
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Twisted table compensation screen 
Set the compensation value for the misalignment between the 
two axes that occurs in the 2-axis gantry mechanism of the driver. 

 
Note) Parameter settings and Driver’s gain tuning will be needed even at the 

Twisted table compensation adjustment. Please read the operation 
manual or technical reference to understand the manual content prior 
to this operation. 
When setting the correction value, make sure the drivers is in INIT 
state. Correction values cannot be set in any state other than INIT. 
When using the torsion correction table function - torque interference 
reduction, please use the electronic gear at a ratio of 1:1. When using 
the torsion correction table function - Absolute position accuracy 
improvement, do not change the parameters after measurement. Also, 
set PositionOffset to 0. Conversion cannot be performed correctly. 
Twisted table compensation cannot be performed through RS232 
communication. 

 
Open the Twisted table compensation 
1 Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2 Click “Other” > “Twisted table compensation” of the tool bar on 

the main screen. 
3 Twisted table compensation function start window is displayed. 
 
<When communication with driver> 
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<When not communication with driver> 

 
 
4 Select the read source of the Twisted table compensation 

adjustment data and click. 
□ “Start adjusting” 

The Twisted table compensation adjustment data set in the driver are 
read communicating the driver connected. If this mode is selected, the 
compensation value setting is reflected in the driver by executing the 
adjustment. 

□ “Browse file” 
Twisted table compensation adjustment data files already edited (.gnt5) 
are read. Adjustment value is not reflected to the driver connected unless 
“Transmit the parameter to the driver” is executed when they are “Blowse 
file”. 

□ “Browse default” 
Default set values saved at the time of installation is read. Adjustment 
value is not reflected to the driver connected unless “Transmit the 
parameter to the driver” is executed when they are “Blowse default”. 

 
5 Click “OK”. The Twisted table compensation window is opened. 
 

 
 

□ “Twisted table compensation-Reduction of torque interference” 
The twisting caused by assembly errors and functional differences in the 
gantry system is adjusted. 
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□ “Twisted table compensation-Absolute precision improving” 

Adjust the error based on the results observed with the measuring 
instrument. Observation data from measuring instruments is required. If 
you select "Refer to file" or "Refer to standard factory settings" on the 
twist correction table function startup menu screen, it cannot be selected. 

 
6 Click “OK” to open the window for the selected screen. 

<If twisted table compensation-Reduction of torque interference 
> 
 

 
 

<If twisted table compensation-Absolute precision improving > 
 

 
 
Close the Twisted table compensation window 
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Click        (Exit) on the tool bar. 
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Structure of Twisted table compensation start screen 

 

 
 

 
(1) Title bar 
Following buttons are used to operate windows. 

(2) Read-only selection area 
Selects the source from which Twisted table compensation 
adjustment data is read in. 

  The Twisted table compensation adjustment data set in 
the driver are read communicating the driver connected. 
If this mode is selected, the compensation value setting 
is reflected in the driver by executing the adjustment. 

  Select the driver to be set for the Y1Axis (Base axis). 
When click the Confirmation button, 7 segment led 
blinks. 
Note) If the connection with the drivers is disconnected, 
the confirmation button will be disabled. 

 Select the driver to be set for the Y2Axis (Compensation 
axis). 
When click the Confirmation button, 7 segment led 
blinks. 
Note) If online, the driver selected in the Select 

connection with drivers screen is selected. 
If you want to make changes, please select the 
driver to connect in the “Select connection with 
drivers”.  

Note) If the connection with the drivers is disconnected, 
the confirmation button will be disabled. 

(1) Title bar 

(2) Read source selection area 

(3) Control button 
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Twisted table compensation adjustment data files 
already edited (.gnt5) are read. Adjustment value is not 
reflected to the driver connected unless “Transmit the 
parameter to the driver” is executed when they are 
“Blowse file”. 

 Default set values saved at the time of installation is 
read. Adjustment value is not reflected to the driver 
connected unless “Transmit the parameter to the driver” 
is executed when they are “Blowse default”. 

(3) Control button 

 

Activate the Twisted table compensation adjustment using the 
method selected in (2). 
Note) If you select "Start adjustment" the differences between the two 
axes' parameters and objects will be compared. As a result of the 
comparison, if there are any differences, they will be displayed in the 
difference list dialog. 

 Close window. 

 Load the driver being connected again. 

 
Structure of the difference list dialog screen 
 

 
 
 
(1) Title bar Allows you to operate windows. 
(2) Tab switching button 

 
When you press a parameter, the difference 
between the parameters will be displayed in the 
difference display area. When you press an object, 
the difference between the objects will be displayed 
in the difference display area. 

(3) Difference display area 
Displays a list of parameter or object differences. 
 

(1) Title bar 

(2) Tab switching button 

(4) Operation button 

(3) Difference display area 
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<Parameter tab> 

 
“Class” Parameter classifications are indicated. 
“No.” Parameter numbers are indicated. 
“Parameter name” Parameter names are indicated. 
“Unit” Units of the parameter set values are indicated. 
“Y1 Axis” Displays the Y1 Axis parameter setting values. 
“Y2 Axis” Displays the Y2 Axis parameter setting values. 
 
<Object tab> 

 
“Main Index” Show the Main Index of the object. 
“Sub Index” Show the Sub Index of the object. 
“Object Name” Show the Object Name. 
“Unit” Units of the parameter set values are indicated. 
“Y1 Axis” Displays the Y1 Axis object settings. 
“Y2 Axis” Displays the Y2 Axis object settings. 
 
(4) Operation button 

 Starts the twist correction table function. 

 Return to the twist correction table function startup menu. 
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Structure of function selection screen 
 

  
 
 
(1) Title bar Allows you to operate windows. 
(2) Function selection area  Select the function you want to launch. 

 Select Twisted table compensation-Reduction of 
torque interference. 

 Select Twisted table compensation-Absolute 
precision improving. 
If you select "Refer to file" or "Refer to standard 
factory settings" on the twist correction table 
function startup menu screen, it cannot be 
selected. 

 
 
(3) Operation button 

 Starts the twist correction table function. 

 Return to the twist correction table function startup menu. 

 

(1) Title bar 

(2) Function selection area 

(3) Operation button 
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Structure of Twisted table compensation-Reduction 

of torque interference 
 

 
 

 
(1) Title bar 
Following buttons are used to operate windows. 

(2) Tool bar 
Saving, reading, some other basic operation commands on 
parameters are listed. 

 
(Read) Read Twisted table compensation adjustment data 

from files (.gnt5).  

 
(Save) Write Twisted table compensation adjustment data 

to files (.gnt5). 

 (Comment) Make comments attached to Twisted table 
compensation adjustment data files. 

 (Rcv) Receive Twisted table compensation adjustment 
data from the driver. 

 (Trans) Send Twisted table compensation adjustment data 
to the driver. 

 
(EEP) Write Twisted table compensation adjustment data 

to EEPROM of the driver. 
Note) After writing to the EEPROM, the return to 
origin status of the Y2 axis (correction axis) will not 
be completed. 

 
(Exit) Closes parameter screen. 

 

(1) Title bar 
(2) Tool bar 

(4) Monitor 

(3) Tab 

(5) Page 
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(3) Tab 
Displays the settings tab for page switching. 

 
Displays the Adjustment page. 

 Displays the Axis operation page. 

 
Displays the Homing operation page. 

 
(4) Monitor 
Real-time display of the connection status of each axis and various 
information. 

 
Clear current alarms. 
Some alarms cannot be cleared unless the cause is removed, 
and the power is reconnected. 

 
Displays the current position of the motor. 

 Displays the thrust value. 
 Displays the servo status. 

Changes to the following background colors depending on 
the status. 

SRV-ON : Green 
SRV-OFF : Grey 

 Displays the alarm status. 
Changes to the following background colors depending on 
the status. 

Normal : Green 
Warning : Yellow 
Error : Red 

 
Displays the homing status. 

 Displays the magnetic pole position estimation status. 
 Displays polarity reversal. 

 
Displays the offset value. 
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(5) Page 
Displays the function selected in each tab (Adjustment, Axis 
operation, homing operation). 

<Adjustment tab> 

 

1. “Table operation” 
Create Table : Displays the Create Table dialog and sets the 

conditions for creation. 
Export : Save the Twisted table compensation adjustment result 

in CSV format. 

2. “Compensation point list” 
Lists the positions to be adjusted and the results of the 
compensation after adjustment in a table. 

Status Displays the adjustment status. 
Compensation 
position 

Displays the compensation position. 

Compensation 
value 

Displays the compensation values calculated by the 
correction algorithm. 

Thrust difference Displays the Thrust difference. 
Search trial 
frequency 

Displays the search trial frequency. 

3. “Adjustment execution condition setting” 
Sets the execution conditions for the adjustment. 

4. “Adjusting operation” 
Adjustment start : Start adjustment. 
Adjustment stop : Stop adjustment. 

1. 

2. 3. 

4. 
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<Axis operation tab> 
(Homing tab select) 

 

(Absolute positioning tab select) 

  

1. “Axis state” 
Selects and displays the axis target. Switches the servo ON/OFF 
of the selected axis. 

2. Limit setting 
3512h-00h Overload level : Set the overload level. 
3513h-00h Over-speed level : Set the over-speed level. 
3514h-00h Motor working range : Set the motor working range. 
3504h-00h Over-travel inhibit input setup : 

Set the Drive prohibition input setting. 

3. Operation setting 
Tab switching :  

Switches between “Homing” and “Absolute positioning”. 
(Homing tab select) 
6098h-00h Homing method : Select the homing method. 
5350h-00h Homing torque limit value : Set the homing torque 

limit value. 
5351h-00h Homing detection time : Set the homing detection 

time. 
5352h-00h Homing detection velocity value：Set the homing 

detection Value. 
6099h-01h Speed during search for switch ：Set the Speed 

(High speed). 
6099h-02h Speed during search for zero：Set the Speed (Low 

speed). 

1. 

2. 

3. 

4. 
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609Ah-00h Homing acceleration：Set the 
acceleration/deceleration. 

607Ch-00h Home offset ：Set the offset. 
 
(Absolute positioning tab select) 
607Ah-00h Target position：Set the target position.  
6081h-00h Profile velocity： Set the Speed. 
6083h-00h Profile acceleration： Set the acceleration. 
6084h-00h Profile deceleration： Set the deceleration. 

4. Axis operation 
(Start) : Start axis operation. 
(Stop) : Stop axis operation. 

 
<Home operation tab> 

  
 

1. Operation setting (Y1 axis)： 
Sets the operating conditions for the homing operation of the Y1 
axis. 

2. Operation setting (Y2 axis)： 
Displays the homing method for the Y2 axis. 
The homing method for the Y2 axis cannot be changed. 

3.  (Start) : Start homing. 
(Stop) : Stop homing. 

1. 

2. 

3. 
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Twisted table compensation-Reduction of torque interference 
procedure 
1 Select the “Adjustments” tab. 

 
2 Click “Create table”. 

 
3 After setting the creation conditions, click “OK”. 
4 After the update of the compensation point list is completed, set 

the adjustment execution conditions. 
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5 Select the “Axis operation” tab or the “Homing operation” tab. 

Complete homing of Y1 and Y2 axes in the “Axis operation” tab 
or complete homing of both axes in the “Homing operation” tab. 

 
6 Select the “Adjustment” tab and click “Adjustment start”. 

* If you want to stop the adjustment midway, click “Adjustment stop”. 
7 After the adjustment is complete, “Export” to a CSV file and 

check the results. 



Rev 3.25 
－ 242 － 

 
Comment 

On saving set Twisted table compensation in a file, comments can 
be saved together. These comments do not affect operations of the 
driver. 
 
Making Comment 
1 Click       (Comment) on the tool bar, and open the comment 

window. 
 

 
 
2 Click comment box and input comments. 
3 After completing comment input, click “OK”. 
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Structure of Twisted table compensation-Absolute 
precision improving 
 

  
 
 
(1) Title bar 
Following buttons are used to operate windows. 

(2) Tool bar 

There is a command to close the screen. 
 (Exit) Closes the twisted table compensation 

function screen. 
 
(3) Tab  
Displays the settings tab for page switching. 

 Display the Y1 axis page. 

 Display the Y2 axis page. 
 
(4) Monitor 
Real-time display of the connection status of each axis and various 
information. 

 
Clear current alarms. 
Some alarms cannot be cleared unless the cause is removed, 
and the power is reconnected. 

 
Displays the current position of the motor. 

 Displays the servo status. 

(1) Title bar 
(2) Tool bar 

(4) Monitor 

(3) Tab 

(5) Page 
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Changes to the following background colors depending on the 
status. 

SRV-ON : Green 
SRV-OFF : Grey 

 
Displays the alarm status. 
Changes to the following background colors depending on the 
status. 

Normal : Green 
Warning : Yellow 
Error : Red 

 
(5) Page 
Displays the axis selected in each tab (Y1 axis, Y2 axis). 
Operations on the page operate on the selected axis. 

   
①  “File reading area” 

Read file: Reads the torsion correction table function measuring 
instrument data file. 

Save format: Save the format file for creating the torsion 
correction table function measuring instrument data file. 

② “List of compensation points” 
Displays a list of reading results of the measuring instrument 
data file, driver correction values, and converted values in a 
table. Below are the items from left. 

No. Displays the table number. 
File compensation 
position [mm] 

Displays the value of the compensation position [mm] 
read from the measuring instrument data file. 

File compensation 
amount [μm] 

Displays the value of the compensation amount [μm] 
read from the measuring instrument data file. 

① 

② 
③ 

④ 
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Driver 
compensation 
position 
[Command unit] 

Displays the compensation value [command unit] 
received from the driver. 

Driver 
compensation 
value [pulse] 

Displays the compensation value [pulse] received 
from the driver. 

Conversion result 
compensation 
position 
[Command unit] 

Displays the converted compensation value 
[command unit] value. Depending on the parameters 
used for conversion, the spacing may not be equal. 

Conversion result 
compensation 
value [pulse] 

Displays the converted correction value [pulse] value. 

 
③ “Conversion conditions” 

Set the parameters used for conversion. Items corresponding to 
the connected driver will be displayed. 

④ “Conversion operation” 
Rcv      : Receives correction values from the driver. 
Conversion   : Converts values based on the measuring 
instrument data file. If a correction value is set for the driver, add 
the converted value to the previous correction value. After 
conversion, send the correction value to the driver. 
Send, EEP write : Send the converted value to the driver. 
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Twisted table compensation-Absolute precision improving 
procedure 
< When performing the first correction > 
1. Prepare the data from the measuring device. 
2. Click "Save format" to save the format file in any location. 
3. Create a measuring instrument data file based on the measuring 

instrument data from the format file. 
4. Click "Read file" to load the created measuring instrument data 

file. 

 
5. After updating the correction point list, set the "Conversion 

conditions", and Click “Conversion”. 

 
6. The conversion is performed and the converted value is sent to 

the driver. 
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< When performing repeated corrections > 
1. Click "Read File" to load the second instrument data file. If the 

correction value has not been received from the driver, click " 
Rcv ". 

 
2. Click “Conversion”. 
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3. The conversion is performed and the converted value plus the 
previous correction value is sent to the driver. 
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Procedure for creating a measuring instrument data file 
1. Edit the format file. 

 
 
2. Insert a line between #--- and #--- and enter the instrument data. 

 
 

No. Please enter numbers in order starting from 1. If the 
numbers are not entered in order, the file cannot be 
read. 

Correction 
position (mm) 

Please enter the measuring instrument data target 
position. Please use mm as the unit. If you enter a value 
with a different unit, it will not be converted correctly. 

Correction 
amount (μm) 

Please enter the measurement instrument data 
correction amount. Please use μm as the unit. If you 
enter a value with a different unit, it will not be converted 
correctly. 

3. Save the file. 

Header,, 
#FILE VERSION,, 
FILE VERSION,1.0.0, 
,, 
#,, 
#,, 
Body,, 
#No,Correction position(mm),Correction amount(um) 
#----------------------------------------------,, 
1,0.0000,0 
2,10.0000,-1 
3,20.0000,0 
4,30.0000,-1 
5,40.0000,-2 
6,50.0000,-2 
7,60.0000,-2 
8,70.0000,-3 
9,80.0000,-2 
10,90.0000,-3 
#----------------------------------------------,, 

Header,, 
#FILE VERSION,, 
FILE VERSION,1.0.0, 
,, 
#,, 
#,, 
Body,, 
#No,Correction position(mm),Correction amount(um) 
#----------------------------------------------,, 
#----------------------------------------------,, 
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Notes 1) Please refer to the manual of the driver or technical reference for 

details of each Twisted table compensation adjustment data’s 
function and so on. 

Notes 2) Even if Twisted table compensation adjustment data are sent to the 
driver, Twisted table compensation adjustment data are turned to 
the original value before modification if the power supply of the 
driver is turned off without writing to EEPROM of the driver. 

Notes 3) Do not turn off the power supply of the PC during writing to 
EEPROM of the driver. Data context cannot be guaranteed if the 
power supply is turned off during writing. 

Notes 4) Do not insert anything other than output results into the measuring 
instrument data file. The file will no longer be readable. 

Notes 5) If the instrument data file is opened with another tool, it may not be 
possible to read the file. Please close the tool before reading the file. 

Notes 6) The Twisted table compensation screen can be operated when all 
other windows are closed. For more information please refer to 
page 282 “Twisted table compensation screen behavior”. 
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Linear motor initial adjustment screen 
The related parameters of the linear motor can be configured. 

 
Note) Please modify parameters with enough care after reading the driver's 

instruction manual or technical reference carefully, as some 
parameters give large effect to operations of drivers or motors. 

Note) Linear motor initial adjustment cannot be performed through RS232 
communication. 

 
Open the Linear motor initial adjustment window 
1  Start “PANATERM”. 

(Please refer to Article 5. Start up and Close down in details) 
2  Click “Other” > “Linear motor initial adjustment” of the tool bar on 

the main screen. 
3  The Linear motor initial adjustment window is opened. 

 
 
Close the Linear motor initial adjustment window 

Click  of upright on the window 
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Structure of Linear motor initial adjustment screen 
 

 
 

 
(1) Title bar 
You can operate this window. 

(2) Tool bar 
Open file Load data from a file (.lms). 
Save file Write data to a file (.lms). 
Copy Copy the loaded data to the connected driver. 
Load Receive parameters from the driver. 
Write Send parameters to the driver. 

(3) Tab 
Parameter List Display the parameter list page. 
Basic Settings Display the basic settings page. 
Current Gain 
Settings 

Display the current gain settings page. 

Direction 
Settings 

Display the direction settings page. 

 
(4) Page 
Display the function selected by the tab. 

(4) 
 

(3) 
 

(2) 
 

(1) 
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＜Parameter List＞ 
 

 
 
1.  Add/Delete columns Add and delete data displayed in the parameter area. 
2.  Compare: Display 

parameters different 
from other columns 

When checked parameter rows with discrepancies will 
be highlighted in orange. 

3.  Display with decimal 
point 

When checked values with decimal points will be 
displayed. 

4.  Graph selection Select data to be displayed in the graph area. 
5.  Graph color selection Select the color of the graph to be displayed in the 

graph area. 
6.  Zoom reset Reset the zoom of the graph. 
7.  Parameter area Display parameter settings for each data. 
8.  Graph area Display the graph of the data selected in the 

parameter area. 
 

 

8.  

6.  

7.  

5.  3.  4.  1.  2.  
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＜Basic Settings＞ 
 

 
 
1.  Basic parameter 

settings 
Set the basic parameters of the linear motor. 

2.  Display with decimal 
point 

When checked values with decimal points will be 
displayed. 

 

 

 

 

 

 

2.  

1.  
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＜Current Gain Settings＞ 
 

 

 
 

 
1.  Adjustment 

method 
selection 

Select the adjustment method. 
Switch the display content of item ② according to the selected 
adjustment method. 

2.  Display with 
decimal point 

When checked values with decimal points will be displayed. 

3.  Parameter 
settings area 

Display related parameters according to the selected 
adjustment method. 

4.  Start 
measurement 

Start measuring the current command response. 

5.  Stop 
measurement 

Stop measuring the current command response. 

6.  Zoom reset Reset the zoom of the graph. 
7.  Graph area Display the graph of the measured current command 

response. 
8.  Overshoot 

amount 
Display the overshoot amount of the measured current 
command response. 

9.  Measurement 
conditions 

Set the measurement conditions for the current command 
response. 

 

 

4.  5.  6.  

3.  

7.  

8.  
9.  

1.  2.  
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＜Current Gain Settings (Manual adjustment)＞ 
 

 
1.  Current gain 

parameter 
settings 

Manually set parameters related to current gain. 

 

 

＜Current Gain Settings (Auto adjustment)＞ 
 

 
 
1.  Start 

adjustment 
Start automatic adjustment of the current gain. 

2.  Stop 
adjustment 

Stop automatic adjustment of the current gain. 

3.  Current gain 
parameter 
settings 

Display parameters related to the automatically adjusted 
current gain. 

4.  Operation 
settings 

Set the operating conditions during automatic adjustment. 

1.  2.  

4.  

3.  

1.  
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＜Direction Settings＞ 
 

 
 
1.  Adjustment 

method 
selection 

Select the adjustment method. 
Switch the display content of item 2. according to the selected 
adjustment method. 

2.  Parameter 
settings area 

Display related parameters according to the selected 
adjustment method. 

 

2.  

1.  
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＜Direction Settings (Manual adjustment)＞ 
 

 

 
1.  Direction 

parameter 
settings 

Manually set parameters related to direction. 

 

 

＜Direction Settings (Auto adjustment)＞ 
 

 
 
1.  Start 

adjustment 
Start automatic adjustment of the direction settings. 

2.  Stop 
adjustment 

Stop automatic adjustment of the direction settings. 

3.  Direction 
parameter 
settings 

Display parameters related to the automatically adjusted 
direction settings. 

4.  Operation 
settings 

Set the operating conditions during automatic adjustment. 

 

3.  

4.  

1.  2.  

1.  
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Error list 
 

 
 
Convert the value of Error Code (2.) from decimal to binary, and 
compare it with the corresponding bits in the table below to check 
the details of the error.  

* Error Code is 255, check the table below with the decimal 
value. 

 
Error 
Code 

Cause Treatment 

bit0 Another function was running. Ensure the front panel is not in use. 
Ensure FFT is not running. 
Ensure trial operation is not running. 
Ensure the network is not being established. 

bit1 Servo ready was OFF. Ensure the main circuit power is established, 
and no alarms are present. 

bit2 Servo was already ON. 
The thrust limit was exceeded during 
frequency response measurement. 

Ensure the servo is OFF. 
Check the setting value of the applied 
command current value and Pr0.13 “1st thrust 
limit”. 

bit5 The setting value of Pr9.20 “Magnet pole 
detection scheme selection” was 0 (Not 
selected) or 3 (Magnetic poles position 
restoration). 

Check the setting value of Pr9.20 “Magnet 
pole detection scheme selection”. 

bit7 An error occurred in any of bits 0 to 6. Check the cause of bits 0 to 6. 

255 Disconnected during communication. 
Failed to calculate gain estimation. 

Check the communication status. 
Check the setting value of the applied 
command current value. 

 

 

 

 

 

 

1.  2.  3.  
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Compare the values of Mode (1.) and Information (3.) with the 
combination table below to check the details of the error. 
 
Mode Information Cause Treatment 

1, 5 1 Detected an abnormality in the current 
feedback value during the application of 
the current command. 
Detected a disconnection in the motor 
line during the application of the current 
command. 

Check the setting value of Pr9.11 
“Carrier frequency selection”. 
If the electrical time constant is too 
small, use a reactor. 
Ensure the motor line is not 
disconnected. 

2, 4 1, 3, 6, 9 Detected excessive motor movement 
during the execution of two-phase 
energization lock. 

Check the setting values of Pr9.01 
“Feedback scale resolution / Number of 
scale pulses per rotation”, Pr9.02 
“Magnet pole pitch”, and Pr9.03 “Pole 
logarithm per rotation”. 
Increase the setting value of the thrust 
command change time. 

2, 4 2, 4, 8, 10 The motor did not stop where it should 
have during the execution of two-phase 
energization lock. 

Increase the setting value of the thrust 
command change time. 

2, 4 5, 7 Detected insufficient motor movement 
during the execution of two-phase 
energization lock. 

Increase the setting value of the applied 
command current value. 
Decrease the setting value of the CS 
direction change speed. 

2 11 Could not detect a change in the CS 
signal during direction setting or detected 
an abnormal change in the CS signal. 

Ensure the output of the CS signal is 
correct. 

2 12 Failed to save to EEPROM during 
direction setting. 

Ensure no alarms are present. 

2 16 An alarm occurred during direction 
setting. 

Clear the alarm causes. 

 
Notes 1)  The Linear motor initial adjustment screen cannot open 

during opening some screens. For more information please refer 
to page 283 “Linear motor initial adjustment screen behavior”. 
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7 Trouble shooting 
 
 

Set up 
 
Stop setup 
→Please review the system requirements, and make sure that the computer 

fulfils the required condition. Please especially note the Operation system’s 
service package. 

→If Microsoft .NET Framework 4.8 is not installed, please install .NET 
Framework 4.8 from the Microsoft website. Also, if you are asked to restart 
your computer after installation, please do so. 

→As a result of download failure, there is a possibility that the installer has 
broken. Please download again after clearing cash of a browser. 

 
Failed to install [PANATERM USB Driver] 
 
Failed to install [PANATERM USB Driver] 
→After uninstalling PANATERM, please refer to the following procedure to 

disable the driver signature and then re-install PANATERM. 
 

1. Press "Windows" + "r" key to open [Run] dialog. 
2. Enter "cmd" in the [Run] dialog, and then click the [OK] button. 
3. After starting the Command Prompt, enter "Shutdown /r /o /t 0", press 

"enter" key, and restart the computer. 
4. On the "Choose an option" screen, select [Troubleshoot]→ [Advanced 

options]→ [Startup Settings]→ [Restart]. 
5. On the "Startup Settings" screen, press "F7" key (Disable driver 

signature enforcement). 
6. After starting the computer, execute the installation. 
 
* When you restart the computer, the driver signature returns to the valid 
state. 
* The procedure may vary depending on the operating system. 
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Communication 
 
Drive name does not appear on the USB connection window after starting up 
PANATERM. 
→Control electricity of the Drive may not be activated. 
→Connection of USB communication cable may be loose, the cable itself 

may be damaged, or the correct cable may not be used. 
→USB port of PC may not be functioning standardly. Please confirm this by 

the operating manual of the PC. 
→Confirm that the network setting of your computer is correct and functioning 

normally. (Refer to the operation manual of your computer.) 
→USB driver may not be installed correctly. 
→A drive name is not displayed when using RS232 communication. 
 
“Cannot detect the communication port or the drive.” is displayed and it 
cannot communicate. 
→Control electricity of the Drive may not be activated. 
→Connection of cable may be loose, the cable itself may be damaged, or the 

correct cable may not be used. 
→Communication port (USB or COM port) of PC may not be functioning 

standardly. Please confirm this by the operating manual of the PC. 
→Confirm that the network setting of your computer is correct and functioning 

normally. (Refer to the operation manual of your computer.) 
→Driver may not be installed correctly. 
→RS232 communication cannot be used at the same time as the block 

operation function. Make sure that the block operation function is disabled. 
→RS232 communication is only available with the MINAS standard protocol. 
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Printing 
 
Cannot print. 
→Printer may not be connected properly, or printer driver may not be 

functioning properly. `This can be confirmed by printing the test page. 
→Document size may not be configured correctly. PANATERM can be printed 

only to the size of A4 or Letter size. Please confirm the printer property of 
PC. 

→Letter per row may be too much. If this is the case, then please separate 
the row into multiple rows to decrease down the letter per row down to the 
level where the entire row will appear when printed. 

 
Uninstall 
 
Unable to uninstall PANATERM 
→File created not by PANATERM may be included in the same folder where 

PANATERM data file is included, In this case, the files will be protected, 
and uninstall cannot be completed. 

 
Axis address 
 
The number of the connected driver and the number of the driver checked by 
search are not in agreement. 
→Please check that the axis address (ID) of the driver linked to a PC is 0. 

Moreover, please check whether the axis address (ID) of other driver 
overlaps in 1 to 31. 

→Connection of cable may be loose, the cable itself may be damaged, or the 
correct cable may not be used. 
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PANATERM behavior 
 
Response of PANATERM is slow. Operation is slow. 
→Close window that are not in use. All windows that are hiding behind active 

windows are still active and are communicating with the Drive periodically. 
→Other equipment may be connected to USB. If so, then please lighten the 

load for USB connection by e.g. stop the other equipment’s operation. 
→When RS232 communication is used, please raise the transmission speed 

of a COM port. 
 
Window is out of the screen, and is hard to see. 
→Size of screen may not be configured properly. Please configure the screen 

size larger than 1,024 x 768. 
 
Cannot open window. Display of the icon is strange. 
→Memory may be lacking. Please close down PANATERM, other 

applications that are not in use, and/or reboot the PC, and then start up the 
PANATERM again. 

 
PANATERM is not reacting anymore 
→Close down PANATERM by pressing [CTRL]+[ALT]+[DEL] keys 
→The error dialog may be displayed on the back of the PANATERM screen. 

Press the [ALT]+[TAB] keys and select the error dialog. 
 
PANATERM had closed down suddenly 
→Start up the PANATERM again. 
 
Cannot start PANATERM 
→Microsoft .NET Framework 4.8 may not be installed. Please install .NET 

Framework 4.8 from the Microsoft homepage. Also, if you are asked to 
restart your computer after installation, please do so. After that, execute the 
PANATERM installer again. 

→When installing to the Program Files folder, it has failed series definition 
setting. Please re - install PANATERM after remove of the following folder. 
[System Drive]:Users\[User Name]\AppData\Local\VirtualStore\Program 
Files\Panasonic Industry\MINAS\PANATERM\ini\def 

→If Windows update for November 2017 has not been executed, it may 
become impossible to start up the system. Refer to Microsoft website and 
execute Windows Update, then restart PANATERM. 
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Parameter screen behavior 
 
Cannot open the parameter screen 
→The parameter screen cannot be opened simultaneously with the gain 

tuning screen, the pin assign setting screen, the setup wizard, the fit gain 
screen (Standard), the fit gain screen (2 degrees of freedom control), the 
object editor screen, the block operation editor screen, the block operation 
editor v2 screen, the deterioration diagnosis screen, the RTEX setup 
screen, the magnetic pole position estimation results copying screen, and 
the Twisted table compensation screen. Please close these screens first. 

 
Parameter value returns back to the original 
→Procedure to change parameter may not have been completed. This may 

happen if you select other parameter or switch windows without pressing 
[ENTER] key or “Change of set value” button.  
Please make sure of your operations. 

→If the parameter value is read from the file, changed parameters are not 
sent to the driver. If you want to send then please click the “Trans” button. 

 
Changed parameter after EEPROM over write does not match to the change 
→Parameter may be changed by other windows that will change parameter. 

Please click “Rcv” button to update the parameter value. 
 
The explanation of parameter is unkind. Cannot you display it in detail?  
→Please double-click the item with underline on the left sub-themes tree. 

Related to the page of the operation manual of driver is displayed. 
→Please check on “Display - Set value description” on the lower right of the 

screen. Information according to each value is displayed.  
Or else value with decimal point is displayed. 
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Monitor screen behavior 
 
Cannot open the monitor screen 
→The monitor screen cannot be opened simultaneously with the pin assign 

setting screen, the setup wizard, the RTEX setup screen, and Twisted table 
compensation screen. Please close these screens first. 

 
Monitor screen does not change 
→Stop button may be clicked. If condition indicated on upper left corner 

states “Monitor stopped” then click the “Start” button on toolbar. 
→Communication with the drive may be severed and may be off line. Please 

confirm if the unconnected mark is on the left side of status bar at the 
lowest portion of PANATERM screen. 

 
Log cannot be saved 
→Log cannot be saved if the drive is in Input / Output confirm mode. Please 

retry after turning the drive back to standard condition e.g. reset drive, 
reboot drive. 

 
In a digital input / output signal monitor, although a count does not change, a 
waveform changes 
→When the processing speed of PC is slow, High data may be drawn with 

Low data. Please lengthen the communication interval of driver and PC. 
 
Cannot display a digital input / output signal monitor 
→When you use RS232 communication with the communication speed of 

less than 4800 bps, please do not make a monitor cycle into 1 second. 
→A background may become white, without drawing meeting the deadline 

when the processing speed of PC is slow. Please lengthen the 
communication interval of driver and PC. 

 
Cannot do Forced Output and Drive reset. 
→In the case of network type (MINAS-A5N, MINAS-A5NL, etc.), if a network 

is established, it cannot do Forced Output and Drive reset.  
Please retry after making the network unestablished. 
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Alarm screen behavior 
 
Cannot open the alarm screen 
→The alarm screen cannot be opened simultaneously with the pin assign 

setting screen, the setup wizard, the RTEX setup screen, and the Twisted 
table compensation screen. Please close these screens first. 

 
Error log does not appear 
→When error has never occurred or if the log has been cleared once, the 

error log will not appear. 
→Additional information that appears on lower left portion only contains error 

that occurred 1 time to 3 times before. If additional information for older 
error is needed, then please select error log number at the upper left 
portion of window. 

→Errors that were not presumed will not leave log even the error occurred. In 
this case, the log will not be kept, and therefore will not appear. 

 
Gain tuning screen behavior 
 
Cannot open the gain tuning screen 
→The gain tuning screen cannot be opened simultaneously with the 

parameter screen, the pin assign setting screen, the setup wizard, the fit 
gain screen (Standard), the fit gain screen (2 degrees of freedom control), 
the object editor screen, the block operation editor screen, the block 
operation editor v2 screen, the deterioration diagnosis screen the RTEX 
setup screen, the magnetic pole position estimation results copying screen 
and the Twisted table compensation screen. Please close these screens 
first. 

→The gain tuning screen cannot be displayed communication with the driver 
is severed. Please confirm if the unconnected mark is on the left side of 
status bar at the lowest portion of PANATERM screen. 

 
Automatic resonance suppression function does not activate effectively 
→When mode 1 to 4 is selected for Real time auto tuning; automatic 

resonance suppression function will be active. Please configure the 
resonance detection level with reviewing the peak value of vibration by the 
monitor measurement, and put check on the checkbox. 

 
Assumes value of load characteristics does not change 
→Mode of real time auto tuning is “0”, or least - squares estimation of 

customize setting is invalid. Please select mode between 1 and 5, or valid 
the least - squares estimation at customize setting. 

→If characteristics variation is set as “0: No Change” then the load 
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characteristics estimation is stopped. Please set a value from 1 to 3. 
 
Resonance frequency appears as default value 5,000Hz 
→When resonance level is small, or does not continue for long time, and then 

the resonance frequency may not change from 5,000Hz. Please use the 
graphic wave function to read resonance frequency directly from motor 
speed or torque command wave, and set notch filter. 

 
Resonance frequency appears as default value 0.0Hz 
→When resonance level is small or does not continue for long time, 

resonance frequency may not appear changed. Please use wave graphic 
function to set resonance suppression control setting by measuring position 
deviation to read resonance frequency directly. 

 
Cannot use clear button of resonance suppression setting 
→Please click “edit” button of the applicable window. When setting/clear 

button is clocked, the changed setting value will be transmitted to the drive 
automatically. 

 
Simplified monitor does not update 
→When drive Servo is OFF, measurement will stop also. Please turn ON the 

Servo and click “Start measurement” button again. 
→Simplified monitor will stop when test run No. reaches the measurement 

number. When you need to continue the measurement, then please click on 
the “Start measurement” button again. 

 
Parameter cannot be set manually 
→Please click on the “edit” button to enable editing. Also, please click on the 

“Send” button to write the parameter to drive value when after the 
parameter was changed. 
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Wave form graphic screen behavior 
 
Cannot open the wave form graphic screen 
→The wave form graphic screen cannot be opened simultaneously with the 

pin assign setting screen, the setup wizard, the RTEX setup screen, and 
the Twisted table compensation screen. Please close these screens first. 

 
Wave data does not appear 
→Trigger condition may not be satisfied. Please confirm trigger condition, or 

click on measure button with no trigger condition. However, if measurement 
is done without trigger condition is done, and then portion of measurement 
condition will be cleared. Also, please be noted that trigger will not be 
active if both sub condition is not satisfied when trigger condition is “A and 
B”. 

 
Reference wave does not appear 
→Referential wave will not appear even when the “Copy” button is clicked. 

Please put a check in the checkbox to the referential wave you would like to 
see on screen at the “Format” tab on lower portion. 

→When copied referential wave data exceeds 10 data, then the newly copied 
wave data will be over written to the referenced previous 20 data. Please 
delete the unnecessary reference wave data to make the data number 
within 10 data. 

 
Wave graphic data cannot be selected 
→Please select one of the measurement items inside the measurement item 

tab’s measurement condition, and open the measurement item selection 
window. 

 
Digital data cannot be triggered 
→When digital data is selected at applicable trigger, then use at either trigger 

slope being “Matched” or “Unmatched”. 
 
The P-N voltage is not triggered. Or an unintended trigger is triggered. 
→In the case of the M-frame driver, the trigger may not be activated as 

expected because the PN voltage is handled as a decimal number inside 
the driver. In that case, do not use the trigger slope match or mismatch, and 
adjust the trigger level by 1V. 

 
Wave data does not appear even “W-get” button is clicked 
→Trigger condition of drive may not be satisfied or configured. Please 

reconfirm trigger condition by clicking the “T-Get” button, with confirming 
that the actual operation is satisfying the trigger condition. 
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A trigger position shifts 
→In the case of network type (MINAS-A5N, MINAS-A5NL, etc.), if a network 

is established in the state of trigger standby, the detected trigger position 
may shift. 

 
The waveform graphic cannot be loaded. 
→Data for expanded sampling cycles (extension: wgd6, wgc6, and wgp6) 

cannot be loaded if the connected device or the selected series does not 
support the expanded function. Try loading it again after connecting a 
device or selecting a series that supports the expanded function. 

 
Trial run screen behavior 
 
Cannot open the trial run screen 
→The trial run screen cannot be opened simultaneously with the pin assign 

setting screen, the Z phase search screen, the setup wizard, the fit gain 
screen (2 degrees of freedom control) the RTEX setup screen, the 
magnetic pole position estimation results copying screen, and the Twisted 
table compensation screen. Please close these screens first. 

→Drive is not in ready status (Alarm or Main power source is cut off), front 
panel is used except for monitor mode, network is established, or Servo ON 
is input from outside. Please re - execute after these status is eliminated, 
and the trial run screen is closed. 

→The trial run screen cannot be displayed communication with the driver is 
severed. Please confirm if the unconnected mark is on the left side of 
status bar at the lowest portion of PANATERM screen. 

→When the block operation function is enabled then, the trial run screen 
cannot be opened. Please, disable the function by your parameter setting. 

 
Error happens frequently 
→At the operation area setting window, the drive will automatically set the 

safety function to default setting; Over speed level 600r/min, Over load 
level 50%, Software limit setting 1 revolution. Please try with tuning the 
gain, changing operation command, and/or changing protection function on 
operation area setting window. 

→The setting of the speed exceeds the maximum speed of the motor. Please 
set the speed below maximum speed of the motor. 
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Operation will stop shortly 
→The JOG or STEP button at operation area setting window, or JOG button 

(un - continuous) at Test operation window will operate the motor when only 
during the button is clicked. 

→If motion at step operation is smaller than expected and then please 
understand that this setting is set by command times, and therefore the 
motor rotation operation will vary by electrical gear ratio. Please change the 
setting. 

→If limitation of operation area at test operation window is the issue, then 
please moves to test operation window by skip button if operation limit is 
not needed, or return to the operation area setting window to reconfigure 
the operation area. 

→A working range cannot be set up more than the range of -1,073,741,823 to 
1,073,741,823. 

 
Operation doesn’t reach at the speed 
→The acceleration is limited 10,000 to 327,670,000. Please set it within the 

range, referring to the following equations. 
[Position Control] 

Acceleration [command unit/s2] = Speed [r/min] / 60 x encoder resolution 
                                                                   / Electronic gear ratio / Acceleration time [s] 

[Full close control] 
Acceleration [command unit/s2] = Speed [r/min] / 60 x encoder resolution 
    / External scale frequency division ratio / Electronic gear ratio / Acceleration time [s] 

[Linear motor] 
Acceleration [command unit/s2] = (Speed [mm/s] x scale resolution) x 106 
                                                                   / Electronic gear ratio / Acceleration time [s] 
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Frequency characteristics screen behavior 
 
Cannot open the frequency characteristics screen 
→The frequency characteristics screen cannot be opened simultaneously 

with the pin assign setting screen, the setup wizard, the fit gain screen 
(Standard), the fit gain screen (2 degrees of freedom control), the RTEX 
setup screen, and the Twisted table compensation screen. Please close 
these screens first. 

 
Cannot measure frequency response. The result of measurement is wrong. 
→The servo on input is necessary. Please confirm the motor is in the state of 

servo on. 
→No condition that the motor works standard it, it is not likely to be able to 

measure it well. Please confirm a torque limitation and driving prohibition 
the functions etc. 

→The frequency response measurement result changes greatly depending 
on the measurement condition. Please measure it when you measure the 
speed closed-loop characteristic on the condition that the motor doesn't 
stop as amplitude = offset absolute value though range of motion is noted. 
Moreover, please measure the amplitude setting from a small value as 
much as possible for the first time within the range where the torque 
saturation is not generated, and affects the equipment negatively by a big 
setting. 

→When a nonlinear characteristic like the backlash and the dead-band, etc. 
exists in the equipment, it is likely not to become a value that changes the 
resonance frequency, and is correct by the amplitude setting and the offset 
setting. 

→In the case of network type (MINAS-A5N, MINAS-A5NL, etc.), if a network 
is established, it cannot measure frequency response.  
Please retry after making the network unestablished. 

→When the block operation function is enabled then, it cannot measure 
frequency response. 

 
Frequency response cannot analyze. 
→Analysis can be used when driver and a communication state are being 

continued after measurement by "Torque speed" mode. 
→This cannot analyze, when using RS232 communication. 
→Analysis after frequency characteristic measurement cannot be used with 

the MINAS-A6 series. 
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Pin assign setting screen behavior 
 
Cannot open the pin assign setting screen 
→The pin assign setting screen cannot be opened simultaneously with all 

other screens. Please close all other screens first. 
 
The setting change of the pin assign screen is not reflected in the driver 
operation. 
→It is necessary to reset the driver. Please turn it on again after turning off 

the control source of the driver once. 
→In the case of network type (MINAS-A5N, MINAS-A5NL, etc.), if a network 

is established, the change of the pin assign setting is not reflected.  
Please retry after making the network unestablished. 

 
Trouble shooting screen behavior 
 
Cannot open the trouble shooting screen 
→The trouble shooting screen cannot be opened simultaneously with the pin 

assign setting screen, the setup wizard, the RTEX setup screen, and the 
Twisted table compensation screen. Please close these screens first. 

 
The factor that doesn't rotate doesn't occasionally disappear. 
→Please execute it in order with young number when you do measures 

because another factor might be generated by a certain factor. 
 
The content of the longevity diagnosis might return to the origin. 
→Longevity information is recorded only every 30 minutes. Please confirm 

time that the control source of the driver is energized. 
 
The Communication error tab is not displayed. 
→The Communication error tab is displayed only when the connected driver 

is of a network type that supports the monitoring of the RTEX 
communication error counter (MINAS-A6NF, etc.). 
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Analogue input adjustment screen behavior 
 
Cannot open the analogue input adjustment screen 
→The analogue input adjustment screen cannot be opened simultaneously 

with the pin assign setting screen, the setup wizard the RTEX setup screen, 
the magnetic pole position estimation results copying screen, and the 
Twisted table compensation screen. Please close these screens first. 

→The analogue input adjustment screen cannot be displayed communication 
with the driver is severed. Please confirm if the unconnected mark is on the 
left side of status bar at the lowest portion of PANATERM screen. 

 
The offset self-adjustment function is not effective. 
→There is a possibility for the input voltage to have exceeded the range of 

the offset adjustment. Please confirm the analog input voltage display of a 
monitor screen and a driver front panel. Whether the input voltage is in 
about 0V or actually measures it. 

 
After the function the offset self-adjustment, the parameter is written in 
EEPROM 
→After the offset self-adjustment function is executed thoroughly to a front 

panel of the driver, the offset parameter is automatically written in 
EEPROM. 
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Z phase search screen behavior 
 
Cannot open the Z phase search screen 
→The Z phase search screen cannot be opened simultaneously with the trial 

run screen, the pin assign setting screen, the setup wizard, the fit gain 
screen (2 degrees of freedom control) the RTEX setup screen, the 
magnetic pole position estimation results copying screen, and the Twisted 
table compensation screen. Please close these screens first. 

→Drive is not in ready status (Alarm or Main power source is cut off), front 
panel is used except for monitor mode, network is established, or Servo ON 
is input from outside. Please re - execute after these status is eliminated, 
and the Z phase search screen is closed. 

→The Z phase search screen cannot be displayed communication with the 
driver is severed. Please confirm if the unconnected mark is on the left side 
of status bar at the lowest portion of PANATERM screen. 

→When the block operation function is enabled then, the Z phase search 
screen cannot be opened. Please, disable the function by your parameter 
setting. 

 
When the power supply of the driver is turned on, the numerical value at the 
center is not changed as -1. 
→Because single-turn data is not decided until the first Z phase is detected 

when the motor equipped with the encoder of an incremental type is used, 
the display becomes -1. The numerical value at the center comes to take a 
value nonnegative from 0 to single-turn data maximum value by executing 
Z phase search. 

 
Setup wizard behavior 
 
Cannot open the setup wizard 
→The Setup Wizard window cannot be used when Servo is turned ON by 

input from outside. Please confirm the motor is in the state of servo off. 
→The setup wizard cannot be opened simultaneously with all other screens. 

Please close all other screens first. 
 
The setting change of the setup wizard is not reflected in the driver operation. 
→It is necessary to reset the driver. Writing to EEPROM after, please turn it 

on again after turning off the control source of the driver once. 
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Fit gain screen (Standard) behavior 
 
Cannot open the fit gain screen 
→The fit gain screen (Standard) cannot be opened simultaneously with the 

parameter screen, the gain tuning screen, the frequency characteristics 
screen, the pin assign setting screen, the setup wizard, the object editor 
screen, the block operation editor screen, the block operation editor v2 
screen, the deterioration diagnosis screen, the RTEX setup screen, the 
magnetic pole position estimation results copying screen, and the Twisted 
table compensation screen. Please close these screens first.  

→The fit gain screen (Standard) cannot be used velocity control mode and 
torque control mode. 

→The fit gain screen (Standard) cannot be displayed except the case of 
communication with the driver. Please confirm if the unconnected mark is 
on the left side of status bar at the lowest portion of PANATERM screen. 

 
Proceed to Step 3 
→Please change the driving pattern according to the instructions. 
→Please check behavior of real-time auto-tuning on the gain tuning screen. 
→Please check behavior of easy monitor on the gain tuning screen.  
→Try increasing Initial rigidity on the Other setting of Step 1. Or else try 

decreasing it. 
→Try increasing Permissible vibration level on the Other setting of Step 1. Or 

else try decreasing it. 
 
Ranking is not displayed in Step 4 
→There is no data that satisfies the restrictions determined by the 

“Recommendation”. Please review the “Recommendation” and 
Recommendation setting. 

→There is no data below the Target value of stabilization time. Please 
increase the Target value of stabilization time. 

→It may exist in the Recommendation data below Initial rigidity. After 
returning to Step 1, please decrease Initial rigidity on the Other setting to 
measure again. 
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Fit gain screen (2 degrees of freedom control) 
behavior 
 
Cannot open the fit gain screen (2 degrees of freedom control) 
→The fit gain screen (2 degree of freedom control compatible) cannot be 

opened simultaneously with the parameter screen, the gain tuning screen, 
the trial run screen, the frequency characteristics screen, the pin assign 
setting screen, the Z phase search screen, the setup wizard, the object 
editor screen, the block operation editor screen, the block operation editor 
v2 screen, the deterioration diagnosis screen the RTEX setup screen, the 
magnetic pole position estimation results copying screen, and the Twisted 
table compensation screen. Please close these screens first. 

→The fit gain screen (2 degrees of freedom control) cannot be used velocity 
control mode, torque control mode and full close control mode. 

→The fit gain screen (2 degrees of freedom control) can be displayed only 
when the combination of driver and selected series is correct. 

→The fit gain screen (2 degrees of freedom control) is supported only linear 
type (LINEAR) when the driver is Linear and DD Control Drive (MINAS-
A6BL etc.). Rotary type (DD) is not supported. 

→When the block operation function is enabled then, the fit gain screen (2 
degrees of freedom control) cannot be opened. Please, disable the function 
by your parameter setting. 

 
Cannot open the log on of fit gain screen 
→The log on of fit gain screen cannot be displayed except the case of 

communication with the driver. Please confirm if the unconnected mark is 
on the left side of status bar at the lowest portion of PANATERM screen. 

→The log on of fit gain screen can be displayed only when driver have 2 
degrees of freedom control (MINAS-A5II, MINAS-A6 etc.). 

 
Proceed to Step 3 
→Please check the load condition. 
→If the driver is Linear and DD Control Drive, please review the parameter 

settings of motor inertia (Mass of motor's movable section), Rated motor 
torque (Rated motor thrust). 

→Try increasing Initial rigidity on the Machine setting of Step 1. Or else try 
decreasing it. 

→Please change the Mode setting of Step 1 to Balanced or Stability 
preferentially. Or else try decreasing it. 



Rev 3.25 
－ 278 － 

 
Object editor screen behavior 
 
Cannot open the object editor screen 
→The object editor screen cannot be opened simultaneously with the 

parameter screen, the gain tuning screen, the pin assign setting screen, the 
setup wizard, the fit gain screen (Standard) and the fit gain screen (2 
degrees of freedom control), the block operation monitor screen, the block 
operation editor screen, the block operation editor v2 screen, the 
deterioration diagnosis screen the RTEX setup screen, the magnetic pole 
position estimation results copying screen, and the Twisted table 
compensation screen. Please close these screens first. 

→Object editor screen can be displayed only if the series with uses the 
EtherCAT Communication is selected. 
(Example)MINAS-A5B 

 
Cannot transmit and edit object value 

→Please check that “ESM Condition” is “INIT” and  is displayed at the 
next to the “Change of set value” button. 

→Please check object attribute is RW at column of “Attrib”. 
 
Object value returns back to original 
→Procedure to change object may not have been completed. This may 

happen if you select other object or switch windows without pressing 
[ENTER] key or “Change of set value” button.  
Please make sure of your operations. 

→If the object value is read from the file, changed objects are not sent to the 
driver. If you want to send then please click the “Trans” button. 

 
Changed object after EEPROM over write does not match to the change 
→The object may be changed by other windows that will change parameter. 

Please click “Rcv” button to update the object value. 
→The some of the objects may not displayed in the Writing to EEPROM 

screen if you change. 
→The some of the objects may be changed in conjunction.  

These objects will be applied last changes. 
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Battery refresh screen behavior 
 
Cannot open the battery refresh screen 
→The battery refresh screen cannot be opened simultaneously with the pin 

assign setting screen, the setup wizard screen, the RTEX setup screen, 
and the Twisted table compensation screen. Please close these screens 
first. 

→The battery refresh screen cannot be displayed communication with the 
driver is severed. Please confirm if the unconnected mark is on the left side 
of status bar at the lowest portion of PANATERM screen. 

 
Cannot execute the battery refresh. 
→Battery refresh can be executed in the case of a combination of control 

mode and the encoder that support. 
→When the block operation function is enabled then, battery refresh cannot 

execute. 
 
Block operation editor screen behavior 
 
Cannot open the block operation editor screen 
→The block operation editor screen cannot be opened simultaneously with 

the parameter screen, the gain tuning screen, the pin assign setting screen, 
the setup wizard, the fit gain screen (Standard), the fit gain screen (2 
degrees of freedom control), the object editor screen, the block operation 
editor v2 screen, the deterioration diagnosis screen the RTEX setup 
screen, the magnetic pole position estimation results copying screen, and 
the Twisted table compensation screen. Please close these screens first. 

→When the block operation function is disabled then, the block operation 
editor screen cannot be opened.  
Please check of your parameter setting. 

 
Parameter value returns back to the original 
→Procedure to change parameter may not have been completed. This may 

happen if you select other parameter or switch windows without pressing 
[ENTER] key.  
Please make sure of your operations. 

→If the parameter value is read from the file, changed parameters are not 
sent to the driver. If you want to send then please click the “Trans” button. 

 
Changed parameter after EEPROM over write does not match to the change 
→Parameter may be changed by other windows that will change parameter. 

Please click “Rcv” button to update the parameter value. 
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Block operation monitor screen behavior 
 
Cannot open the block operation monitor screen 
→The block operation monitor screen cannot be opened simultaneously with 

the pin assign setting screen, the setup wizard screen, the object editor 
screen, the block operation editor v2 screen, the RTEX setup screen, and 
the Twisted table compensation screen. Please close these screens first. 

→The block operation monitor screen cannot be displayed communication 
with the driver is severed. Please confirm if the unconnected mark is on the 
left side of status bar at the lowest portion of PANATERM screen. 

 
Block operation editor v2 screen behavior 
 
Cannot open the block operation editor v2 screen 
→The block operation editor v2 screen cannot be opened simultaneously with 

the parameter screen, the gain tuning screen, the pin assign setting screen, 
the setup wizard, the fit gain screen (Standard), the fit gain screen (2 
degrees of freedom control), the object editor screen, the block operation 
editor screen, the deterioration diagnosis screen, the RTEX setup screen, 
the magnetic pole position estimation results copying screen, and the 
Twisted table compensation screen. Please close these screens first. 

→When the block operation function is disabled then, the block operation 
editor screen cannot be opened.  
Please check of your parameter setting. 

 
Parameter value returns back to the original 
→If the parameter value is read from the file, changed parameters are not 

sent to the driver. If you want to send then please click the “Trans” button. 
 
Changed parameter after EEPROM over write does not match to the change 
→Parameter may be changed by other windows that will change parameter. 

Please click “Rcv” button to update the parameter value. 



Rev 3.25 
－ 281 － 

 
Deterioration diagnosis screen behavior 
 
Cannot open the deterioration diagnosis screen 
→The deterioration diagnosis screen cannot be opened simultaneously with 

the parameter screen, the gain tuning screen, the pin assign setting screen, 
the setup wizard screen, the fit gain screen (Standard), the fit gain screen 
(2 degrees of freedom control), the object editor screen, the block operation 
editor screen, the block operation editor v2 screen, the RTEX setup screen, 
the magnetic pole position estimation results copying screen, and the 
Twisted table compensation screen. Please close these screens first. 

→The deterioration diagnosis screen cannot be displayed communication 
with the driver is severed. Please confirm if the unconnected mark is on the 
left side of status bar at the lowest portion of PANATERM screen. 

 
RTEX Setup screen behavior 
 
Cannot open the RTEX setup screen 
→The RTEX setup screen cannot be opened simultaneously with all other 

screens. Please close all other screens first. 
 
Magnetic pole position estimation results copying 
screen behavior 
 
Cannot open the Magnetic pole position estimation results copying screen. 
→The magnetic pole position estimation results copying screen cannot be 

opened simultaneously with the parameter screen, the gain tuning screen, 
the trial run screen, the pin assign setting screen, the analogue input 
adjustment screen, the Z phase search screen, the setup wizard, the fit 
gain screen (Standard), the fit gain screen (2 degrees of freedom control), 
the object editor screen, the block operation editor screen, the block 
operation editor v2 screen, the deterioration diagnosis screen, the RTEX 
setup screen, and the Twisted table compensation screen. Please close 
these screens first. 

→The magnetic pole position estimation results copying screen cannot be 
displayed communication with the driver is severed. Please confirm if the 
unconnected mark is on the left side of status bar at the lowest portion of 
PANATERM screen. 
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Twisted table compensation screen behavior 
 
Cannot open the Twisted table compensation screen. 
→The Twisted table compensation screen cannot be opened simultaneously 

with all other screens. Please close all other screens first. 
 
Twisted table compensation-Reduction of torque interference cannot be 
performed. 
→This can only be performed if both drivers of the Y1 axis and Y2 axis are 

online. Check the status of the connection to the drivers. 
→Cannot be executed if there is an alarm on either the Y1 axis or Y2 axis 

drivers. Check the alarm status on the monitor. 
→Cannot be executed unless both drivers of the Y1 axis and Y2 axis are 

homing completed. Check the homing status on the monitor. 
→Cannot be performed if a compensation point list does not exist. Please 

create a compensation point list in create table. 
→Cannot be performed during adjustment. Please wait for the adjustment to 

be completed. 
→The polarity (Polarity) of the Y1 and Y2 axes must be supported. Check the 

polarity (Polarity). 
→If repetitive compensation is on, check that the list of compensation points 

on the tool matches the compensation table on the driver. 
→When the Two-axis coordinated operation expansion function is enabled, it 

cannot be executed. Please check the Two-axis coordinated operation 
expansion function. 

 
Twisted table compensation-Absolute precision improving cannot be 
performed. 
→This can only be performed if either the Y1 axis or the Y2 axis is online. 

Please check the status of the connection to the drivers. 
→If the electronic gear ratio is displayed as "Too small" or "Too large", it 

cannot be executed. Please check the settings of the electronic gear ratio. 
→Cannot be executed without loading the measurement data file. Please 

click "Read file" and load the measurement data file. 
→Cannot be executed unless the reception from the driver is completed. 

Please click "Rcv" to complete the reception of the correction values. 
→For linear type drivers, the feedback scale resolution needs to be 1 or 

higher. Please check the setting value of the feedback scale resolution. 
→Polarity support is required for this operation. Please check the polarity 

setting. 
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Linear motor initial adjustment screen behavior 
 
Cannot open the Linear motor initial adjustment screen. 
→The Linear motor initial adjustment screen cannot be opened 

simultaneously with the parameter screen, the gain tuning screen, the wave 
form graphic screen, the trial run screen, the frequency characteristics 
screen, the fit gain screen (Standard), the fit gain screen (2 degrees of 
freedom control), the pin assign setting screen, the analogue input 
adjustment screen, the Z phase search screen, the setup wizard, the object 
editor screen, the block operation editor screen, the block operation editor 
v2 screen, block operation monitor screen, the deterioration diagnosis 
screen, the RTEX setup screen, the magnetic pole position estimation 
results copying screen, and the Twisted table compensation screen. Please 
close these screens first. 

→The Linear motor initial adjustment screen can only be displayed when 
communicating with the driver. Please check that there is no disconnected 
mark on the left side of the status bar at the bottom of the PANATERM 
screen. 

 
Cannot execute the adjustments or measurements. 
→When the block operation function is enabled, adjustments or 

measurements cannot be executed. Please check of your parameter 
setting. 
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After-Sale Service 
 

Technical information 
 
Technical information of this product (Operating Instructions, CAD data) can 
be downloaded and consulting questions from the following web site. 

https://industrial.panasonic.com/ac/e/ 
 
Industrial Device Business Division, Panasonic Industry Co., Ltd. 
7-1-1 Morofuku, Daito, Osaka, 574-0044, Japan 
ⓒ Panasonic Industry Co., Ltd. 2009-2025 

https://industrial.panasonic.com/ac/e/
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